INFORMATION TO USERS

This manuscript has been reproduced from the microfilm master. UMI films the text directly from the original or copy submitted. Thus, some thesis and dissertation copies are in typewriter face, while others may be from any type of computer printer.

The quality of this reproduction is dependent upon the quality of the copy submitted. Broken or indistinct print, colored or poor quality illustrations and photographs, print bleedthrough, substandard margins, and improper alignment can adversely affect reproduction.

In the unlikely event that the author did not send UMI a complete manuscript and there are missing pages, these will be noted. Also, if unauthorized copyright material had to be removed, a note will indicate the deletion.

Oversize materials (e.g., maps, drawings, charts) are reproduced by sectioning the original, beginning at the upper left-hand corner and continuing from left to right in equal sections with small overlaps. Each original is also photographed in one exposure and is included in reduced form at the back of the book.

Photographs included in the original manuscript have been reproduced xerographically in this copy. Higher quality 6" x 9" black and white photographic prints are available for any photographs or illustrations appearing in this copy for an additional charge. Contact UMI directly to order.

UMI
A Bell & Howell Information Company
300 North Zeeb Road, Ann Arbor MI 48106-1346 USA
313/761-4700  800/521-0600
Permutations of Standard Piano Works: A Curriculum for the
Development of Student Musicianship

by

Myrna Capp

A dissertation submitted in partial fulfillment
of the requirements for the degree of

Doctor of Musical Arts

University of Washington

1995

Approved by

[Signature]

(Chairperson of Supervisory Committee)

Program Authorized
to Offer Degree

Music

Date

December 13, 1995
Doctoral Dissertation

In presenting this dissertation in partial fulfillment of the requirements for the Doctoral degree at the University of Washington, I agree that the Library shall make its copies freely available for inspection. I further agree that extensive copying of this dissertation is allowable only for scholarly purposes, consistent with “fair use” as prescribed in the U.S. Copyright Law. Requests for copying or reproduction of this dissertation may be referred to University Microfilms, 1490 Eisenhower Place, P.O. Box 975, Ann Arbor, MI 48106, to whom the author has granted “the right to reproduce and sell (a) copies of the manuscript in microform and/or (b) printed copies of the manuscript made from microform.”

Signature  Myrna Capps
Date  December 13, 1995
University of Washington

Abstract

Permutations of Standard Piano Works: A Curriculum for the
Development of Student Musicianship

by Myrna Capp

Chair of the Supervisory Committee:

Professor Patricia Shehan Campbell
School of Music

Traditional piano instruction rarely includes improvisation, or even playful permutations of studied works, but there are sound musical reasons for the inclusion of some level of piano improvisation in the training of all musicians at the collegiate level. When defined as a creative process through which an individual creates music within the framework of a specific musical style, improvisation allows the student musician to explore, examine, and extend the musicianship that is initially developed through more traditional studio and class piano activities. Permutation, a more limited transformation of musical components which still retains the character of a work, aids the student's comprehension of the musical style and structure of a work.

This dissertation chronicles the development of a curriculum for the development of student musicianship through creating permutations of standard piano works. It is launched from Elizabeth Vallance's curriculum theory, which suggests that through various ways of experiencing subject matter (in this case, a musical work), a more thorough understanding of the work will result. Thus, new constructions can be designed through the manipulation of the elements of a musical work, leading to the development of student musicianship.

Comprehensive Musicianship provides a second impetus for this curriculum, in that it emphasizes the development of musical skills and understanding through balanced instruction in listening, performing, and creating.
Permutations of Standard Piano Works: A Curriculum for the Development of Student Musicianship is in essence an aurally-based curriculum. Its emphasis is the strengthening of listening skills through aurally presented music for which notation is not present. At a computer work station with MIDI keyboard, students follow an instructional manual, and listen to 12 standard piano works and excerpts (generated by a computer with sequencer). As students hear the original works and also new phrases created in the style of the model composition, they respond by initiating vocalizations and then playing. These phrases are intended to stimulate students’ own new constructions of the work, while yet maintaining the stylistic features. This curriculum leads students to their own permutations, which they record, and then evaluate according to a set of ten musical criteria. The curriculum is intended to fill a void in piano pedagogy, as a means of teaching a more complete musical understanding of standard piano works through directed listening and the invention of musical permutations.
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>List of Figures</td>
<td>v</td>
</tr>
<tr>
<td>List of Tables</td>
<td>vi</td>
</tr>
<tr>
<td>Chapter I: Introduction</td>
<td>1</td>
</tr>
<tr>
<td>Purpose</td>
<td>1</td>
</tr>
<tr>
<td>Improvisation in the Comprehensive Musicanship of Students</td>
<td>2</td>
</tr>
<tr>
<td>Comprehensive Musicanship, Improvisation and Performance Training</td>
<td>5</td>
</tr>
<tr>
<td>Definitions</td>
<td>7</td>
</tr>
<tr>
<td>The Development of Curriculum</td>
<td>8</td>
</tr>
<tr>
<td>Scope and Limitations</td>
<td>10</td>
</tr>
<tr>
<td>Overview</td>
<td>11</td>
</tr>
<tr>
<td>Chapter II: Improvisation, Musicanship, and Curriculum Theory</td>
<td>12</td>
</tr>
<tr>
<td>Historical–Cultural Incidence of Keyboard Improvisation</td>
<td>12</td>
</tr>
<tr>
<td>Perspectives of Performing Pianists</td>
<td>15</td>
</tr>
<tr>
<td>Perspectives of Cognitive Psychologists</td>
<td>18</td>
</tr>
<tr>
<td>The Role of Aural Skills in Improvisation</td>
<td>21</td>
</tr>
<tr>
<td>Jazz Improvisation</td>
<td>23</td>
</tr>
<tr>
<td>Materials for Teaching Improvisation</td>
<td>26</td>
</tr>
<tr>
<td>Improvisation within the Comprehensive Musicanship Program</td>
<td>29</td>
</tr>
<tr>
<td>Curriculum Theory and Design</td>
<td>33</td>
</tr>
</tbody>
</table>
Curriculum Design in Musical Contexts .......................37

Summary .........................................................38

Chapter III: Six Relevant Dissertations on Piano Instruction, Musicianship, and Improvisation ........................................40

Rosfeld, 1989; The Development of a Series of Instructional Units for Teaching Improvisational Principles to Pianists ............40

Kular, 1975; A Guide to Elementary Keyboard Improvisation Using Selected Twentieth Century Compositional Techniques .43

Larsen, 1986; Teaching Basic Jazz Piano Skills to Classically-Trained Adult Pianists: A Mastery Learning Approach ...............45

Bash, 1983; The Effectiveness of Three Instructional Methods on the Acquisition of Jazz Improvisation Skills ...................48

Konowitz, 1971; Jazz Improvisation at the Piano -- a Textbook for Teachers .................................................................49

Brown, 1990; An Investigation of the Effectiveness of a Piano Course in Playing By Ear and Aural Skills Development for College Students ........................................51

Comparisons Among the Six Dissertations ......................54

Chapter IV: Development of Permutations of Standard Piano Works: A Curriculum for the Development of Student Musicianship .........60

Curricular Goals ..................................................60

Instructional Sequence of the Curriculum ..........................61

Selection of the Musical Examples ................................62

Equipment .........................................................62

The Curricular Plan ................................................64

The Context of the Curriculum ....................................70

Characteristics of the Musical Examples ............................71
Units ................................................................. 257

1) Beethoven; Sonatina in G Major, Romanze ............. 257
2) Bartók; Evening at the Village ............................ 265
3) Schumann; Soldiers’ March, Op. 68, No. 2 ............. 272
4) Mozart; Rondo .................................................. 279
5) Bartók; Allegro Robusto ...................................... 286
6) J.S. Bach; Menuet in G Major .............................. 293
7) Schumann; Melody, Op. 68, No. 1 ....................... 300
8) Haydn; Quadrille .............................................. 307
9) Attributed to J.S. Bach; Bourrée in D Minor .......... 314
10) Beethoven; German Dance ................................. 320
11) Chopin; Mazurka in F Major, Op. 68, No. 3 ........ 327
12) Kabalevsky; Toccatina ...................................... 334

Pocket Material: One disk containing all aural examples (in the pocket in the inside back cover of the dissertation)
List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Drawing of “work station”</td>
<td>.89</td>
</tr>
<tr>
<td>2. Drawing of computer recording controls</td>
<td>.92</td>
</tr>
</tbody>
</table>
# List of Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Steps in the Instructional Sequence</td>
<td>.65</td>
</tr>
<tr>
<td>2.</td>
<td>Sonatina in G Major, Romanze by Ludwig van Beethoven</td>
<td>.73</td>
</tr>
<tr>
<td>3.</td>
<td>Evening at the Village from Ten Easy Piano Pieces by Bela Bartok</td>
<td>.74</td>
</tr>
<tr>
<td>4.</td>
<td>Soldiers’ March, Op. 68, No. 2 by Robert Schumann</td>
<td>.75</td>
</tr>
<tr>
<td>5.</td>
<td>Rondo by Wolfgang Amadeus Mozart</td>
<td>.76</td>
</tr>
<tr>
<td>6.</td>
<td>Allegro Robusto from For Children, Vol. I by Bela Bartok</td>
<td>.77</td>
</tr>
<tr>
<td>7.</td>
<td>Menuet in G Major by J.S. Bach</td>
<td>.78</td>
</tr>
<tr>
<td>8.</td>
<td>Melody, Op. 68, No. 1 by Robert Schumann</td>
<td>.79</td>
</tr>
<tr>
<td>9.</td>
<td>Quadrille by Joseph Haydn</td>
<td>.80</td>
</tr>
<tr>
<td>10.</td>
<td>Bourree in D Minor Attributed to J.S. Bach</td>
<td>.81</td>
</tr>
<tr>
<td>11.</td>
<td>German Dance by Ludwig van Beethoven</td>
<td>.82</td>
</tr>
<tr>
<td>12.</td>
<td>Mazurka in F Major, Op. 68, No. 3 by Frederic Chopin</td>
<td>.83</td>
</tr>
<tr>
<td>13.</td>
<td>Toccata by Dmitri Kabalevsky</td>
<td>.84</td>
</tr>
</tbody>
</table>
ACKNOWLEDGEMENTS

I would like to express sincere appreciation to the supervisory committee members who have influenced and enriched me in the writing of this dissertation, especially Dr. Patricia Shehan Campbell, Chair, who has been an inspiring mentor, colleague and friend. Neal O'Doan has provided a valuable perspective in piano pedagogy and performance. I am grateful to Thomas Goolsby for his helpful suggestions. Thanks to Christopher Waterman, a member of my supervisory committee. Thanks also to my music technology assistant and colleague, Jerry Piger. Special thanks to Grayson, Teri, Brian, and Kristin for their support and encouragement.
Acknowledgements to Publishers

For permission to use the following music scores:

Consolidated Music Publishers, Inc.
“Copyright (c) 1956 (Renewed) by Consolidated Music Publishers, Inc.
Reprinted by Permission of Amsco Publications, a division of Music
Sales Corporation (ASCAP)”

“Rondo” by W.A. Mozart
   by Denes Agay

Frederick Harris Music Company

1) “Evening at the Village” from Ten Easy Piano Pieces by B. Bartok
   Celebration Series, 2nd ed., Piano Repertoire Album 8, 1994
   “With kindly permission of Editio Musica Budapest”

2) “Melody, Op. 68, No. 1,” by R. Schumann
   Celebration Series, Repertoire Album 2, 1988

3) “Bourree in D Minor,” attributed to J.S. Bach
   Celebration Series, 2nd ed. Repertoire Album 2, 1994

4) “Menuet in G Major,” by J.S. Bach
   Celebration Series, Repertoire Album 1, 1988


“Toccata, Op. 27, No. 7”
   Piano Literature Vol. 3 (GP20) by James Bastien
   (c) Copyright 1968 General Words and Music Company
   Used with Permission 1995

The Lorenz Corporation/Heritage Music Press

“Allegro Robusto” by B. Bartok
   Mainstreams in Literature A, The Classical Performer, by Walter
   and Carol Noona
Warner Bros. Publications Inc.

1) “Quadrille” by F.J. Haydn
   Frances Clark Library for Piano Students, Piano Literature of the 17th, 18th and 19th Centuries, Book 2; 1957 Summy-Birchard Co.

2) “Sonatina in G Major, Romanze” by L. Beethoven
   Frances Clark Library for Piano Students, Piano Literature Book 2, 1954; Summy Birchard

3) “Mazurka in F Major, Op. 68, No. 3” by F. Chopin
   Frances Clark Library for Piano Students, Piano Literature of the 17th, 18th, and 19th Centuries, Book 6b, 1956; Summy Birchard

West Publishing Company

1) “German Dance” by L. Beethoven
   Piano for Pleasure: A Basic Course for Adults by Martha Hilley & Lynn Freeman Olson

2) “Soldiers March” by R. Schumann
   same
Chapter 1
Introduction

Traditional approaches to piano instruction, and to the development of musicianship skills at the keyboard, rarely allow students opportunities to improvise, or even to employ variation techniques to enhance their understanding of a musical work. When viewed as the ability to generate a new musical work within the framework of a given musical style, improvisation at the piano is often relegated solely to the training of the jazz musician. Yet there are sound musical reasons for the inclusion of some level of improvisation at the piano for the training of all musicians at the collegiate level. These reasons—such as development of musicianship, especially aural skills, and development of creative exploration at the keyboard within a given style—are discussed in the dissertation. There is a need for the development of curriculum, along with specific descriptions of instructional strategies, that will allow student musicians an opportunity to extend their understanding of musical structure. The exploration and manipulation of the elements of a musical style and specific musical works are principal means of developing student musicianship.

Purpose

The purpose of this study is to develop a curriculum for teaching a more thorough understanding of selected piano works, through the study and invention of permutations on these works. The study is launched from curriculum theory espoused by Vallance (1982; 1985) on multiple “ways of knowing” subject matter. She suggested that teachers who are guided by curriculum consider not only traditional ways of knowing, which emphasize subject-matter or content—along with their traditional avenues of transmission and reception—but also acknowledge that human knowing takes many forms.
Her theory implies that students develop different perspectives of musical pieces through various ways of learning, including listening, singing, vocalizing, playing, and improvising. These multiple ways of knowledge construction can be extended to include the opportunity for students to study selected works by manipulating and varying the component parts. By listening to an original work, and permutations of it, and then by developing one's own permutation or variation of it, the student can grow in knowledge of its structure and style. Just as human knowing takes many forms, so can a musical work be varied, in order to understand it more fully.

Permutations of Standard Piano Works: A Curriculum for the Development of Student Musicianship is based upon the principles of Comprehensive Musicianship, is influenced by current resources in the pedagogy of improvisation at large, and is further informed by a review of literature relevant to piano instruction with improvisational emphases. The curriculum developed herein employs a sequence of instructional strategies that lead to the student's musical understanding of twelve piano works through the permutation of their melodic and accompaniment patterns.

Improvisation in the Comprehensive Musicianship of Students

The Comprehensive Musicianship approach is an important impetus for this curriculum because its goals resonate with those of this project. Improvisation is an important component of Comprehensive Musicianship, a prominent curricular approach to music training in collegiate and pre-collegiate settings (D’Arms, et al. 1973). Comprehensive Musicianship, or CM, is a framework for teaching music at any level of instruction. It emphasizes the development of musical understanding and skills through study of the common elements--melody, harmony, rhythm, timbre, form, expression--to help students gain an awareness and understanding of
the structural characteristics of music of any culture, tradition, or style.

A balance of experience in listening, performing and creating music is emphasized in a program of Comprehensive Musicianship. Two of the four basic premises which guide the program are relevant here: 1) music education should utilize to the greatest extent the creative capacities of the learner, and 2) music education at all levels should develop broad-based musicianship through listening, performing and creating music (Willoughby, 1971, pp. 71-77).

Collegiate faculty involved in a Comprehensive Musicianship curriculum have claimed that “CM students possessed clearer understandings of relationships among the various components of basic musicianship” (Bess, 1991, p. 103) than those given more traditional training, including the relationship between aural comprehension and performance. Traditionally educated students were those who tended to learn theory, history, sight-singing, composition, aural comprehension, and performance separately, without understanding the relationships among them.

Standifer (1990) noted the importance in Comprehensive Musicianship of context, content, and process in music teaching and learning. He recalled that CM projects were well-planned to develop the students’ thorough musicianship, including improvisation (p. 16). Standifer noted that Comprehensive Musicianship’s goal

...of aural and analytical training should be the achievement of more penetrating insight into musical structure while providing strong skills of improvisation and the use of the ear in making creative musical sounds...Music should be studied comprehensively and not with the narrowed (ear) of Western art-music criticism...CMP [Contemporary Music Project] experiments and procedure gave us students who were more musically sensitive... who had a wider perspective of music earlier in his or her education than those taught using traditional content and methods (p. 19).

In a discussion about the relationship of improvisation to Comprehensive
Musicianship at the College Level, Bradshaw (1980) suggested that improvisation
is
“instant musicianship”...because it creates a situation where a student
has to call forth all his or her resources and use them instantly. A
student who has mastered a concept well enough to improvise with it
must certainly understand the concept well...(p. 114).

He described improvisation as “a tool that enables a student to explore some
important concepts...” (p. 114). His explanation was that a student who is
improvising in this manner is undergoing some interesting thought processes and
experiences. Bradshaw suggested that through group improvisation, “the structure
emerges from the musical perception of the participants” (p. 114-115) and not
from some preconceived plan. He maintained that the energy and intensity, or
“excitement of good improvisation, can carry into performance studies...if
students become aware of the musical factors that cause the excitement” (p. 115).

For the training of the complete, comprehensive musician, Campbell (1991)
examined the importance of ear-training and the creative process of improvisation
in the history of European art music, in a sampling of world cultures, and in the
training of young musicians in contemporary music education settings. Her
Comprehensive Musicianship-oriented thesis made clear the need to a) recognize
improvisation as a key component of music performance, b) note the role of aural
training in developing one's creative capacity to improvise, and c) provide ways of
stimulating the creative musical expression of students.

In recent collegiate level instruction, improvisation has only occasionally
been part of a curriculum that ideally could be the foundation of a student's
comprehensive musicianship. According to Azzara (1991), in undergraduate music
theory classes, students who improvise demonstrate that they have “internalized
a music vocabulary” by expressing musical ideas spontaneously (p. 108). While
not citing Comprehensive Musicianship specifically, Azzara’s view was coincident
with the premises of the earlier established curricular approach. He explained “that students accumulate a vocabulary of musical ideas from which to draw when engaging in improvisatory activities, and that the internalization of various musical patterns crystallizes the difference between having to create something and having something to create. Azzara reasoned that “... developing improvisatory skills involving known melody and rhythm patterns yields improvisation that is natural and interactive, as in stimulating conversation” (1991, p. 109). He explained further that a goal of music educators should be “to facilitate the development of independent music makers and active listeners. Aural understanding--audiation--and improvisatory experiences are at the root of accomplishing this goal” (1991, p. 109). Azzara suggested that future research should involve an examination of the role and definition of improvisation and creativity in the comprehensive education of all student musicians.

**Comprehensive Musicianship, Improvisation and Performance Training**

As critical as piano improvisation can be to the attainment of comprehensive musicianship for all music students, improvisation may play a special role in the education of intelligent pianist-performers. Thomson (1990) suggested that the Comprehensive Musicianship curriculum movement tended to neglect the impact which the performance teacher might likely make on a student’s musical development. He noted: “Hindsight forces us to observe that CMP [Contemporary Music Project] attention was focused more on composition, [including improvisation], theory, and history teaching than on performance teaching as such” (1990, p. 26). He called this “a serious error” and claimed that studio teachers have the potential to wield enormous power in their modeling of the perspective and values which young musicians might develop.

Many applied piano teachers have not been trained in the principles of
Comprehensive Musicianship. Their traditional training in piano emphasized music reading, memorization of the score, and performance skills, while relegating the aim of musicianship (including improvisation skills) to a remote or inconsequential role in the curriculum. In fact, music literacy is a highly valued skill of pianists, and is maintained by piano teachers as key to knowing the vast repertoire of piano music. At the same time, piano students, and even some piano teachers, are often unable to play by ear or improvise even the simplest folk song or familiar melody. They are often unable to transpose a simple melody to a different key. Improvisation skills are integral to a comprehensive musicianship, but they are seldom the focus of piano lessons. The inclusion of improvisation in the curriculum expands the more narrow and traditional role of classical pianists, and requires them to know how to invent new musical expressions. Uszler, Gordon, and Mach (1991) suggested that for classical pianists, the careful listening required to be a successful improviser sharpens the listening skills they used in performance.

In piano study, creativity (as expressed in improvisation) is often preempted by technique, repertoire, theory, ear training, and music history (Bashaw, 1980). Teachers may also avoid improvisation if they lack training in it. Bashaw noted that a small amount of improvisation at each lesson can open up a new world, through comprehensive musicianship and the resulting freedom to create, for the teacher and the students.

Yelen, Wing, and Barfield (1993) explained that "improvisation implies spontaneous musical expression..." as well as "...giving students an opportunity to make musical decisions and experiment with different styles and interpretive nuances" (p. 20). They claimed that this carries over to repertoire study by developing expressiveness and individual style.
The neglect of improvisation in current keyboard instruction was emphasized by Kolar (1975). She stressed its relevance as a part of basic musical learning or comprehensive musicianship. Blum (1983) suggested that through musical improvisation, piano students increase their aural and intellectual control of the music vocabulary available to them. Indeed, keyboard improvisation is especially valuable because it offers the performer possibilities to manipulate a complete web of musical sound - rhythm, melody, and harmony.

Definitions

The following are operational definitions of key terms and concepts employed herein.

**Improvisation:** The musical by-product of a creative process attributed to the individual who can generate a new sound within the framework of a given musical style. It requires that the performer know the rules of the musical tradition, genre, or even particular work. Improvisation has been variously defined, and encompasses a spectrum from expressive re-creation of the music to a reconfiguration of musical components--hence, a new musical work.

**Intermediate level:** To assume that the student has aural/listening skills, basic technical skills, and basic music reading skills, acquired through three to five years of piano instruction; to assume that the student can sightread with ease at a level below the regular repertoire performance level, and can perform literature musically within a given style, and can analyze and determine the form and structure of literature studied. Intermediate level competencies include the ability to: 1) Sight-read repertoire and accompaniments beyond the elementary level, 2) Transpose repertoire and simple accompaniments to closely related keys, 3) Play chord progressions using secondary chords and secondary dominants in major and minor keys, 4) Harmonize melodies with secondary chords and secondary
dominants using simple accompaniment style and, 5) Create second parts to solo piano repertoire based on analysis of theoretical concepts. All of the preceding should be related to the students’ study of theory, technique, and repertoire (Uszler et al., 1991).

**Mentally image:** To form a mental representation or picture of a musical idea (not necessarily a mental representation or picture of the score).

**Permutation:** Variation, or a limited transformation of the melody and accompaniment patterns of standard piano works, in which certain pitches or rhythms are changed while still retaining the “spirit” and character of the piece. In a spectrum of creative musical thinking, permutation is at a distant point from free improvisation, in that the principal musical components restrict the performer from developing beyond the structures provided. Permutation within the curriculum aids the student’s comprehension of the musical style and structure of a work. It is both an instructional strategy for understanding the work—an end in itself, and a personal expression and playful interpretation of the work.

**Play by ear:** To play the piano without reference to notation, using the ear as the guide; this is not the same as playing a piece by memory.

**Style:** The musical choices that a composer or performer makes from among the possibilities available (Randel, 1986). It may refer to features that characterize the works of an individual composer, or it may also distinguish an individual work from other works by the same composer.

### The Development of Curriculum

The study of curriculum in education at large, and in music education in particular, may be a critical guide to the development of a curriculum in improvisation. Curriculum is viewed as a vehicle through which education takes place (Wing, 1992). Four central questions define curriculum: 1) Why should
certain things be taught? 2) Who should get what knowledge? 3) What rules should govern the teaching of subjects (such as music improvisation)? and 4) How should the components of the curriculum be interrelated? The preceding questions suggest educational aims, objectives, materials, scope and sequence, articulation, teaching strategies, learner activities, and outcomes. An extensive array of books and articles have been written on the philosophical, historical, psychological, and social foundations of curriculum, the principles of curriculum (aims, goals, objectives; curriculum designs; curriculum development; curriculum implementation and curriculum evaluation), and curriculum theory and curriculum issues, trends, and future directions (Ornstein and Hunkins, 1988).

Doyle (1992) asserted that curriculum study and design must be grounded much more deeply than it has been in the events that students and teachers jointly construct in the classroom. This means that curriculum as a dynamic, changing system can evolve through what happens in the classroom. Wolf (1992) suggested that curriculum in the arts has undergone a major shift over the last century from an emphasis on exercise and skills, to the “long-term, restless, and thoughtful nature of mature production or perception in the arts” (p. 946).

Building on Tyler (1949), Jorgensen (1987) defined the curriculum process in music as an “open system or a dynamic process.” Jorgensen’s paradigm enables some useful distinctions, and provides an approach in the “dynamic movement from theoretic assumption to practical reality and back to theoretical assumption—where these are considered...to be interrelated and interdependent entities” (Jorgensen, 1987, p. 95). The philosophical questions—“why, what, when, where, and how”—are addressed first, leading to each element of the curriculum taking on additional meaning for the teacher, and empowering his/her teaching (p. 105). Jorgensen's approach leads to a curriculum which has a significant,
developmentally sequenced body of substantive content.

Permutations on Standard Piano Works: A Curriculum for the Development of Student Musicianship, is a problem-centered curriculum, in that it is planned in advance with the anticipation that adjustments will be necessary (and able to be made) to address the concerns and situations of specific learners (Ornstein and Hunkins, 1988). This curriculum project places emphasis on 1) content, 2) development of the learner or product, and 3) process. The curriculum is humanistic and consequently includes student-centered instructional strategies that encourage students to control their learning, and teachers who work as facilitators and catalysts. Extending Wolf's (1992) assertion, providing instructional strategies that enable piano students to improvise in the styles of master composers--or in any style--can take students into their own personal world of making music. Such an ability may be one of the most valuable a piano teacher can give to any student.

Scope and Limitations

There are many possible approaches to the development of student musicianship at the piano. The approach developed here will focus on the use of selected aural stimuli for students at intermediate levels of keyboard competence. Recorded examples have been developed to lead students to the motivation and skill to create new configurations of particular works. Sequential instructions assist the student in a progression from one instructional strategy to the next. Models for this approach exist in the form of “play-along”, aurally-based materials, such as recordings with instruction books produced by such jazz and blues musicians as Aebersold (1979), Coker (1964), Baker (1977, 1974, 1968-71, 1969, 1979, 1976), and Horan (1993). Few models exist in assisting piano students to improvise, or to create variations in the style of piano compositions by the master composers of
Western European art music.

The current curriculum project is limited to piano works and excerpts by eight composers of European “classical” piano music. The excerpts from each model piano work were limited to eight, ten, or twelve measures. The curriculum is limited to use at the piano; no other instruments are given attention here.

Overview

This curriculum project emanates from the philosophy and practices articulated by Comprehensive Musicianship, and in the curriculum theory of Vallance. It is informed by existing approaches to the development of musicianship and improvisation instruction, and by the findings of six dissertations (discussed in Chapter III). With its specific instructional strategies and musical responses, this curriculum is intended to fill a void in piano pedagogy, as a means of teaching a more complete musical understanding of piano literature through directed listening and the invention of musical permutations.

Chapter II presents a review of related literature in improvisation and improvisation instruction. Chapter III presents a review of literature relevant to piano instruction with improvisation emphases. Chapter IV consists of the goals, descriptions of the development, and the instructional sequence of the curriculum. Also included in the discussion are the selection of the music examples, the context, and the characteristics of the selected piano music. Chapter V presents the introduction and the instructional sequence of the curriculum, with the notated musical works, excerpts and exercises included (which the teacher sees). The computer disk containing the aural component of the curriculum accompanies this dissertation. Chapter VI consists of a summary and discussion.
Chapter II
Improvisation, Musicianship, and Curriculum Theory

A review of literature is necessary in order to provide a backdrop for the proposed curriculum for teaching the development of musicianship, including aural skills and the ability to study and then invent permutations of specific works, to piano students. Expanded discussion of various perspectives of improvisation is included here along with an examination of the historical-cultural incidence of improvisation, and the perspectives of performing pianists on the subject of creative musical expression. (It is important to consider that the invention of permutations, the focus of the curriculum in Chapter V, is viewed as one point on the spectrum of creative musical thinking. While somewhat distant from some styles of jazz improvisation, for example, permutation is nonetheless a creative departure from the original work). The development of aural skills as an important variable in improvisation, and musicianship at large, is reviewed. Briefly noted as well are cognitive processes of improvisation, and selected pedagogical approaches that included improvisation among their techniques: 1) instructional resources in improvisation at large, and 2) selected literature in jazz improvisation. The curricular movement known as Comprehensive Musicianship is reviewed, especially its compelling reasons as to why improvisation is key to the development of the collegiate student’s musicianship. Curriculum theory and design in general and in music education and piano pedagogy in particular conclude the chapter.

Historical-Cultural Incidence of Keyboard Improvisation

Keyboard players in the Baroque, Classical, and Romantic eras practiced improvisation, from melodic embellishment, including the use of ornaments such as the trill, turn, appoggiatura, mordent, slide, and snap, as well as the elaboration
of the fermata (the predecessor of the cadenza), to the highest form of improvisation, a complete piece of music. Buxtehude, Handel, Sweelinck, Frescobaldi, and J.S. Bach were renowned for their improvised works, as were classical composers such as Mozart, Clementi, and Beethoven. The practice of improvising cadenzas grew from a small amount of elaboration (in the eighteenth century) to extended display, where the cadenza was often a showcase of the performer's virtuosity (in the nineteenth century). Nineteenth century composer performers such as Chopin, Liszt, Czerny, Mendelssohn, and Hummel continued to improvise in public (Gerig, 1974; Horsley et al., 1980; Apel, 1979).

Czerny (1836/translated, 1983) underscored that natural aptitude was the first of the necessary attributes for learning to improvise. This consisted of "inventive power, lively imagination, ample musical memory, quick flow of thoughts, well formed fingers..." (p. 2). However, Czerny maintained that pianists could learn this art through diligence and study. Czerny's basic prerequisites necessary to improvising also included "thorough training in all branches of harmony" and finally, "a completely perfected technique of playing...dexterity of the fingers in all difficulties, in all keys, as well as in everything that pertains to beautiful, pleasing and graceful performance...for only in vain does imagination provide the best ideas if the fingers are incapable of executing them" (p. 2). Czerny's words presuppose a great deal of technical skill. Mitchell (1983), translator of Czerny's book, suggested that the rise of the musical specialist in the nineteenth century, whether composer, performer, or pedagogue, marked the simultaneous decline of the comprehensive musician of former eras. The need for virtuosity and originality as expressed in improvisation was clearly in decline in the nineteenth century. However, eighteenth century works which called for improvisation, such as Mozart concerto cadenzas, continued to be performed,
either with improvised cadenzas or notated cadenzas by a variety of composers. By the beginning of the twentieth century, the practice of public piano improvisation had declined significantly and has remained comparatively dormant throughout most of this century with the exception of jazz. In the late 1970s improvisational elements began to reappear in art music, usually in an ensemble setting (Horsley, et. al., 1980). Cope (1989) suggested that “‘contemporary’ improvisation sprang from the performers’ inability to realize accurately the complexities of recent music; the composer, perhaps out of frustration, perhaps because the result was the same (or better), chose to allow a certain freedom in performance” (p. 141). Recent non-jazz composers who allowed improvisation to emerge in their musical works include Erb, Foss, Cardew, Prevost, Duckworth, Foss, Chiari, Kagel, Berio, Erickson (for Dempster, Oliveros, and Subotnick), and Winsor (pp. 140-148).

Nettl (1974) explained improvisation as it exists in the works of Western historical composers and in the musical cultures of the world, and found that the suddenness of the creative impulse is specifically or implicitly accepted in all of them. A criticism leveled by Nettl on earlier literature on improvisation is that it tended to consider improvisation only as it existed in Western musical forms. He noted that the “customary picture of improvisation...should be greatly expanded by an understanding of non-Western cultures” (p. 4). Nettl considers improvisation one of the few universals of music in which all cultures share in one way or another (p. 4).

Nettl declared that composition and improvisation are “part of the same idea” (p. 6). He explained that the improviser always has a model to work from—certain things that he uses as a foundation on which he builds. There are diverse kinds of models used in the world of improvisation that are measured according to
their density (how close together or far apart the points of reference are) and audibility (how much they are actually performed as music) (p. 16). Each model consists of “a series of obligatory musical events which must be observed, either absolutely or with some sort of frequency, in order that the model remain intact” (p. 12). These points of reference are certain central tones, opening and closing motifs, melodic indications signalling the coming of closing sections, and so on.

Nettl (1974) suggested that improvised music is the embodiment of a system with its component units or building blocks. He explained building blocks as “tones selected from a tone system...melodic motifs...harmonic intervals and interval sequences...” (p. 13). Nettl proposed that in improvisation, as compared to composition, the “supply of building blocks in an improvised style is much less extensive than in ‘composed’ music...” (pp. 14-15). In each of the improvisatory styles Nettl described, the student must in some way learn the model before he can improvise upon it.

Nettl suggested three important trends for future scholars to watch. First, “performances by a given musician working with one model vary far less than those of different musicians” (p. 18). Second, most cultures have “a rather specific set of expectations of the performer” (p. 19). Nettl concluded that “what the pianist playing Bach and Beethoven does with his models--the scores and the accumulated tradition of performance practice--is only in degree, not in nature, different from what the Indian playing an ‘alap’ in ‘Rag Yaman’ and the Persian singing the ‘Dastgah’ or ‘Shur’ do with theirs” (p. 19).

**Perspectives of Performing Pianists**

Pianist Ursula Oppens suggested that improvisation is something classical pianists should know. When she first performed and recorded a work by F. Rzewski, she omitted the cadenza. Because she had never improvised before,
she talked to friends who were jazz musicians about how to practice things that were not written down. She maintained that “It made me feel that I had grown up in a misrepresented tradition, because improvisation was part of the classical tradition until about five minutes ago, really” (Kosman, 1993, p. 37).

Dick Hyman (Wodehouse, 1993), a virtuoso pianist who has particular facility as an improvisor, credited Andre Previn, a pianist known for his performances of classical art music, with crossing over from “the classics” to improvisation on classical themes and in classical styles. Hyman underscored Previn’s ability to improvise because he believed that to some people, “improvisation is regarded with suspicion as being somehow not correct to do...” (p. 28).

Frederic Rzewski (Kosman, 1993), a virtuoso pianist, improvises at the keyboard with fluency. He is credited with “blistering, eloquent piano music...drawing on the entire range of the late-20th-century musical vocabulary...to create a modern incarnation of the Lisztian model” (p. 30). For Rzewski, a composer who calls on performers to augment a written score with sections of free or guided improvisations, improvised cadenzas pose little problem. This aspect of Rzewski’s music “works to expand the narrow traditional role of the classical pianist” (p. 37).

Bailey (1992), an improvising performer and writer, defined and explored the processes involved in improvisation from the perspective of practicing musicians from various idioms. His description and background of all improvisation suggested that the significance of improvisation is best shown through the experience of those who use it. In his interviews with pianists who improvise, he found that improvisation was considered to be intuitive; they talked of its theory, but, in practice, were not bound by theory. In conversations with
improvising musicians, Bailey found endless speculation about the nature of improvisation. One of his interviewees mused:

How do I judge whether what I’ve played is...satisfactory, it is very difficult because what seems to happen is that one becomes unconscious of playing, you know, it becomes as if something else has taken over and you’re just an intermediary between whatever else and the instrument, and everything you try seems to come off, or at least, even if it doesn’t come off it doesn’t seem to matter very much, it’s still a certain kind of feeling that you’re aiming for— or unconsciously aiming for—and when this happens—inspiration—duende—whatever you like to call it—a happy conjunction of conditions and events and middle attitudes— it will feel good. It will feel that “I should be what I am” kind of thing (p. 52).

Bailey noted that the nature of improvisation had not changed noticeably in recent decades (between the mid-1970’s and early 1990’s), but is as prevalent and irrepressible as ever (p. xiii).

Dean (1989), a practicing musician and writer, suggested that classical musicians are rarely presented with opportunities to learn to improvise. In his discussion he posed some thought-provoking questions related to learning to improvise:

Why improvise anyway? ...for personal fulfillment, self-development, and the creation of originality in music ...Can you recognize individuality with any clarity by developing an analytical approach to your music?... What are you doing on the keyboard when your right hand is playing that complex and interesting atonal line? (p. 114).

In his approach to the training of classical pianists, Dean provided notated examples to be heard and analyzed or appreciated, and exercises to be used as the basis for controlled responses, without use of notation. He stressed using the notation first, then going back and using the taped examples. He cautioned that for classical pianists, the step of departing from the notation might be the most difficult and the most instructive. In his discussion, Dean included the basic
musical materials used in improvisation, interactions with other musicians in
improvisation, and improvisation within various contexts. Dean stressed the role
of personal character in improvising, and universal constraints which affect
improvisation. Dean mused that as performers, “the way we have learnt to play
our instruments very much conditions the kinds of things we play on them” (Dean,
1988, p. 116). The current curriculum study suggests that perhaps we can control
this aspect of our improvisation, at least to some degree, through instruction and
practice.

Sudnow (1978) studied jazz improvisation from his own perspective as a
beginning jazz pianist, and described the “looks of improvisatory hands”—his own
and those of others (p. 154). Sudnow, in his self-confessional approach to the
problem, described the long, slow process of watching and feeling his hands at
the piano as they gradually developed ways of doing and playing jazz:

As the hand did the things it was seeking to do ‘singly’, it had at
the same time been becoming a hand able to do all sorts of things
everywhere ...I would accomplish the beginning of a reiteration...and
then, for example, use up a remaining allotted chord-time by taking
on any notes that were thereabout to take (p. 56).

A key conclusion of his study and experiences was that anyone desiring to learn to
improvise should “SING WHILE YOU ARE PLAYING” (Sudnow, 1978, p. 149).

**Perspectives of Cognitive Psychology**

Although there is an abundance of literature on the ideation and cognitive
processing of improvisation, two sources have been selected for focus as
particularly relevant to the current study in order to present a comprehensive,
balanced view of the cognitive processes involved in improvisation. Sloboda
(1985) explained that in improvisation, there is no opportunity to mould and
perfect material: the initial idea is generated and developed. Sloboda distinguished
improvisation from composition by noting that the improviser requires the pre-
existence of a large set of formal constraints that comprise a “blueprint” or
“skeleton” for the music that will be created (p. 139) while the composer must be
continuously referring back to the detailed working out of earlier sections. The
improviser “uses a model which is, in most cases, externally supplied by the
culture, and which he embellishes and ‘fills in’ in various ways” (p. 139). He can
rely on the given constraints of the form, together with his own “style,” to give the
music unity (p. 139).

Sloboda compared musical improvisation with the recounting of a story by
a skilled story-teller. He borrowed the term “frame” from cognitive psychology’s
use of it in the study of language. This frame “specifies attributes appropriate to
the object or situation that can be specified, together with details of limits and
constraints on those specifications” (p. 140). In music, “frames” are characteristic
harmonic or melodic progressions that underlie many different types of music.
The improviser (and composer as well) achieves aesthetic impact by finding novel
or surprising ways of embellishing a frame without changing its basic character.
Sloboda equates story structure with “form” in music. He emphasizes that the
essence of jazz improvisation is the melodic line, so the frame for improvisation
might be the melodic progressions. In the current study, the frame is provided
by the harmonic structure of the selected excerpt of piano literature. The student
improvises in the style of the given excerpt, using the harmonic progression of the
piece as the frame.

To illuminate the process of musical improvisation, Pressing (1988)
examined modeling tools from a number of different disciplines. He proposed a
cognitive model for the process itself, and discussed its relation to improvisational
skill acquisition. The fundamental nature of the improvisation process is
considered to be the stringing together of a series of ‘event clusters’, during each of which a continuation is chosen, based upon either the continuing of some existing stream of musical development, or the interruption of that stream by the choosing of a new set of array entries that act as constraints in the generation of a new stream.

Pressing (1988) discussed issues relevant to improvisation such as skill classification, and feedback and error correction. He noted the importance of preparation, timing issues, motor memory, and skill development. In skill development literature in improvisation it was suggested that there is a change from controlled processing to automatic motor processing as a result of extensive skill rehearsal. There is a stage at which it becomes possible to dispense with conscious monitoring of the motor processes. The “hands appear to have a life of their own, driven by the musical constraints of the situation...in a sense, the performer is played by the music” (Pressing, 1988, p. 139). Pressing included the distribution and nature of practice in the development of improvisation skill in his discussion.

Relevant to the pedagogy of improvisation, Pressing grouped the various approaches in the literature of the teaching of improvisation as follows: a) Improvisation as real-time composition; “a nuts-and-bolts approach” with only basic ideas of variation, embellishment, and other traditional processes of musical development used (p. 142); b) Improvisation as patterns and processes; “patterns, models, and procedures specific to the improvisational situation” are given to the student, who, if s/he possesses a solid enough level of musicianship, will produce stylistically appropriate music (p. 142); c) Improvisation as problem-solving; the setting of a spectrum of improvisational problems or constraints, where the teacher poses problems intended to provoke personal responses; and d) Improvisation as
the delivery of versions and variations; the presentation by the teacher of “multiple versions of important musical entities [most commonly motives]...leaving the student to infer completely on his or her own the ways in which improvisation or variation may occur by an appreciation of the intrinsic ‘fuzziness’ of the musical concept” (Pressing, 1988, p. 143). In understanding and teaching improvisation, Pressing's versions of musical entities (motives), and Nettl's building blocks (melodic motifs, short musical phrases, or a theoretical metric pattern) converge as similar ways of describing the need for the student to learn the model before improvising on it.

**The Role of Aural Skills in Improvisation**

Because improvisation and its training are dependent on aural skills, such that playing by ear is a prerequisite to being able to improvise in a given style, the literature on aural skills development warrants examination.

According to Pratt (1990), “aural awareness” is sensitivity to all the sounds in one's musical environment, not just pitch and duration. The quality of aural awareness encompasses a sensibility to the range and tessitura of instruments and voices, the density and the distribution of sounds and the textures within which they are performed, the range of timbral colours, of dynamics, and the articulations and phrasing of which they are capable. Aural awareness is vital as a foundation for developing the capacity to improvise.

Pratt suggested that a comprehensive approach to developing the ability to hear inwardly, to sing and play music by ear, and to improvise, is needed in musicianship. Pratt focused on the neglected elements in music study--aural skills--in his statement: “...as for listeners, the greater need is to hear what a musical phenomenon ‘is’ rather than to know what it is ‘called’” (p. 3). Pratt's premise is that before anything is written down, it must first be experienced. He offered
exercises leading to playing by ear (pp. 96-101) and traced the need to focus on the sound through exercises and discussion related to improvisation (pp. 102-107).

Campbell (1991) suggested that the critical development of the listening ear and the creative mind are essential features of music education in many musical systems and cultures. She pointed out that, “if comprehensive musicianship and a thorough music literacy are to occur in formal educational settings,” the effort will require “the combination of aural, kinesthetic, and notational skills along with provisions for creative expression” (p. 21).

Campbell stressed the importance of aural skills development in private studio instruction. In studio teaching, she suggested that “a focus on devices such as demonstration, imitation...improvisation and its relationship to musical expression and interpretation...may contribute to more meaningful learning in the music lesson” (Campbell, 1991, p. 278). She developed practical strategies for developing aural skills and creative musical expression in studio lessons and rehearsals. An example suggested by Campbell was guiding students in finding a new style for a piece they have studied and performed (playing a Bach invention using a Brahmsian interpretation) (p. 304). She maintained that a keen listening ear complements music literacy, enhances performance ability, and stimulates improvisation and the interpretation of composed music. Visual, aural, and kinesthetic elements should work together to shape musicians who can perform musically, listen intelligently, and respond with feeling (p. 305-306).

According to Polk (1980), the ability to play even small phrases by ear is an asset to keyboard students. It can improve note reading, even as the ability to read notes can help playing by ear. She advocated that keyboard students should be taught both skills at every lesson. In piano instruction, ear training is intended to get the ear into the habit of directing the fingers to the proper keys. Polk advised
that repetition is the key to success (p.42). Beginning with rote learning, she gave specific steps for students to follow, leading eventually to complete improvisation.

In keyboard instruction, memorization, sight-reading, and keyboard facility are all enhanced by the ability to play by ear (Liggett, 1980). Liggett suggested a sequence of strategies for teaching students to play by ear (the following are included: use of familiar melodies, singing, finger numbers and fingering, direction, intervals, technique and notation). Liggett recommended that “not more than five minutes each week be devoted to playing by ear” in a private lesson (p. 49). She claimed that such a sequence, regularly practiced, will elicit gains in aural skill development.

**Jazz Improvisation**

The literature on jazz and jazz pedagogy relevant to improvisation is too vast to discuss here. However, a general sense of jazz improvisation is useful as a comparison to the process taken within the present curriculum. Schuller (1968) suggested that improvisation is the heart and soul of jazz as it is of much folk and popular musics (p. 58). According to Schuller, an African drummer’s skill as an improviser is judged by his ability to vary the essential motivic material of a given pattern, all within strict rules and traditions. One can say that within the loose framework of European tradition, the African-American jazz musician was able to preserve a significant nucleus of his African heritage--improvisation. It is that nucleus that has made jazz the uniquely captivating language that it is (Schuller, 1968, p. 62).

Dobbins (1978), a jazz musician and pedagogue, suggested that any musician may play a scale as a technical exercise thousands of times but he does not really understand that scale until he can create melodies with it and construct harmonies from it. According to Dobbins, “It is...extremely important that the
mind and ear must be developed equally” (Dobbins, 1978, p. 2). Improvisation provides the musician, not only the jazz musician, with a personal and vital experience of the laws of harmony, melody and rhythm. The ability to feel relatively at ease while improvising can only be acquired if the musical vocabulary has been learned so thoroughly that its proper use is natural and instinctive. Dobbins states that the level of development to work toward is one in which the relationship between the ear and the hands is direct, (seemingly) bypassing the mind altogether. The hands must be able to respond directly to sounds themselves.

According to Konowitz (1980), jazz improvisation is actually the rapid alteration, adaptation, and variation of a broad array of specific techniques over which a player has complete control. Improvisation can be taught through fundamental activities that are the same as those required for traditional piano study. Scale activities can be used with changing dynamics, rhythmic improvisation, directional improvisation, and harmonic expansion. Konowitz maintains that improvisation with chord tones alone tends to restrict creativity. A natural development in improvisation has been the imposition of scales on chord changes.

As a teacher of jazz, Grigson (1985) found that students from jazz and classical backgrounds could learn to improvise using the same approach. The approach is to teach practical harmony—the changes and how to improvise on them. Grigson starts with the blues since it is easy to extrapolate to the other non-blues forms used in jazz. He used a mix of listening, playing, and analysis. Grigson found that the best way to help people play better is “to get the harmony clear ...jazz is a good context in which to learn harmony. Harmony may be the key to musical creativity in many idioms” (Grigson, 1985, p. 193).
Baker (1980), a jazz musician and pedagogue, maintained that improvisation of all kinds is useful as a means of music learning because it requires total involvement of teacher and student. Although improvisation techniques, materials and approaches vary from era to era and style to style, Baker maintained that the task is similar for all kinds of improvisation. Rules are given, a code of behavior is prescribed, and a strategy emerges, depending upon the situation. Improvisation “can be the means to an end as well as an end in itself” (Baker, 1980 p. 42). He explained that embellishing a melody is an easy way to begin to improvise using folk songs, patriotic songs, and other easily remembered, essentially diatonic melodies. Another simple improvisation technique Baker described is to change the meaning of a work by altering its style; if students listen to and understand the imperatives of various styles, they can be taught to improvise in those styles (p. 45). Baker named tonal techniques (such as stretto, juxtaposition, and heterophony) and call-and-response activities to develop listening skills and good reaction responses as useful for beginning improvisers (p. 48).

In his thorough account on jazz improvisation, Berliner (1994) discussed not only initial preparations for jazz improvisation, but a variety of practical techniques and approaches to improvisation which might be useful in learning to improvise in the styles of master composers of classical piano music. For example, Berliner described a musician (who had relied heavily on a piece's melody when formulating solos) as discovering the value of knowing “the theoretical principles of harmony and their application to jazz” (p. 159). Knowledge of harmonic progressions may well be relevant to improvisation in other musical styles.
Materials for Teaching Improvisation

A host of published materials are available for teaching improvisation at the piano. Some of these materials are specifically designed for use with electronic as well as acoustic pianos. Traditional pedagogical materials are being replaced by materials for jazz-rock styles, pop tunes, and multiple piano ensemble materials, which are more interesting to students. Class piano materials for adults often include jazz harmony, realization of popular lead sheets, and jazz improvisation skills. In jazz, play-along approaches have been available since the fifties. Two types of improvisation materials which exist are 1) methods which conceptualize the theory and techniques of improvisation on an in-depth basis, and 2) supplementary materials which specialize in a limited area of improvisation instruction.

Since the 1970’s there has been a proliferation of improvisation materials in jazz. Included among these are Aebersold (1967-79) (21 volumes, play-along recordings with accompanying books). Aebersold’s emphasis is upon learning to listen and to hear music in new ways through use of recorded play-along material. Dobbins (1978) developed a text which is a comprehensive approach to keyboard improvisation which included analysis and musical exercises as well as playing, experimenting with other musicians, and listening to live and recorded performances of professional musicians. Mehegan (1964) wrote a text on swing and progressive piano styles of jazz improvisation which utilized stylistic characteristics of selected performers to teach improvisation. Gray, (1983) focused on learning to feel rhythm and syncopation, and performing beat exercises. Horan (1993), in a blues, play-along recording and book, presented simple explanations and suggestions for playing along with the recording on black keys (side 1) or white keys (side 2). The emphasis was on listening and feeling the beat, while
playing along. Most available play-along materials are intended for pianists at intermediate and advanced levels.


Baker’s (1980) “Improvisation: A Tool for Music Learning” began with observation of the harmonic, melodic, and rhythmic practices of the composer or style to be imitated. He then prescribed a code of behavior, and a strategy or matrix emerged depending upon the particulars of the situation. He stressed that “Each situation has its own rules and codes of behavior that prescribe the parameters within which an improviser...must operate” (p. 42).

Computers and MIDI hardware both may be useful in building improvisational skills (Boling, 1993). In jazz, classical, and other genres of music, the advantages of computer/MIDI assisted improvisation practice through use of a music technology lab could be helpful to beginning students, who may not have the resources to purchase their own MIDI studio or the expertise to program their own accompaniment tracks. MIDI controls instrument sounds called “patches,” instrumental balance, and even the swing feel. The ability to alter tempos, keys, mix, and electronic instrument timbres is a tremendous advantage for the student of improvisation, whether he or she be a classical or jazz musician. Educators’ reception to new uses of technology may enhance their students’ learning.
Improvisation teaching materials for class or individual piano improvisation at beginning levels include Walter and Carol Noona's (1975) books, *The Improviser*, and *Improviser Projects*. These materials, which consist of two separate books for each level (A, B, and C), were designed so that each lesson coordinates with the corresponding lesson in the accompanying book. The *Improviser Projects* furnishes opportunities for a student to expand upon what he has learned in *The Improviser*. For example, *The Improviser A* contains opportunities for reading chord symbols, reading color chords and filling in, improvising on a chord progression, using repetition and variation, and a vocal approach to melody. Then, in Improviser Projects, the above are reinforced through use of an arpeggiated chord study, a chord exercise which includes playing and writing chords, and application of the student's understanding of chords to a song, with only melody, roots, and the chord symbols given.

The material in each of Noona's books is presented in a series of ten lessons. Introductory solos are presented, as are reading chord symbols, the use of color chords and filling in, and improvising on a chord progression. Use of repetition and variation, and a vocal approach to melody are included. The books progress eventually to understanding the blues progression, melodic approaches, stylistic devices, and evolving blues melodies. Finally, boogie-woogie, the underlying pulse of rock, syncopation, chord progressions, modal progressions, and melodic improvisation with the mixolydian and dorian modes are covered. These books include thorough explanations and notated musical examples.

Olson and Hilley (1986) incorporated improvisation activities in their text, *Piano for Pleasure: A Basic Course for Adults*. Concepts addressed include use of black keys with teacher accompaniment, five given white keys on a designated rhythm with teacher accompaniment, intervals as answers to musical questions, a
three-part song on whole steps, filling in missing measures, improvising on triad tones, playing a blues pentascale with teacher accompaniment and so on. The student is instructed to improvise in the style of a Kabalevsky Scherzo, then to play two-handed accompaniments on a given progression along with the cassette tape. Finally, the student improvises a 16-bar piece in the style of Gurlitt (a Gurlitt piece is given to be used as a model) (p. 302). This assignment is given to the student as part of a unit near the end of the text, with no specific instructions given as to how to approach the task.

Adler (1977) used selected classical piano literature, such as a Bach Invention and Minuet, two Chopin Preludes, a Liszt Etude, a set of Beethoven variations, and a set of variations by Paisiello, to explore stylistic ideas for piano improvising in rock, jazz and sacred (hymn and spiritual) styles. Notated examples and written explanations were utilized in his instructional approach. For example, Adler presents the notation for a sixteen bar excerpt from J.S. Bach’s “Two Part Invention No. IV” in two forms, first as written by Bach, and second as an arranged version by Adler with different rhythm (changed from 3/8 to 4/4). Next, he gives practice and observation directions for the student to create an improvisation, followed by a notated model of an improvisation. Although Adler used selected classical piano literature as models, his focus was on learning to improvise in the styles of rock, jazz and sacred (hymn and spiritual) music.

**Improvisation within the Comprehensive Musicianship Program**

Comprehensive Musicianship (CM) may well be one of the most significant curricular movements in music to have emerged in the second half of the twentieth century (D’Arms et al., 1973). Its impact on music instruction at all levels and specializations has been considerable. The Comprehensive Musicianship program was rooted in the Contemporary Music Project of 1959. In
the Contemporary Music Project, six pilot projects were developed which focused on actual musical situations "...for emphasizing creativity through music improvisation" (p. 36). These projects were organized as curricular frameworks that emphasized creativity through music improvisation. A rare breed of musician subsequently developed through these projects—"one who is not only a specialist, but who is also widely competent throughout the range of music, and is concerned with the broadest aspects of the future of music" (p. 38).

The Comprehensive Musicianship approach to music instruction maintains that the source of all music study is the literature of music. The music itself, rather than pedagogical musical material provides the focus for an entire music curriculum so that students can synthesize material and see relationships in all that they do. Comprehensive Musicianship is based on principles in three broad categories—the common elements approach, musicianly functions, and educational strategies (D'Arms et al., 1973, pp. 39-40). Students develop broadly through a "balance of experiences in analysis...composition and improvisation..., and performance..." (p. 40). Teachers apply principles of Comprehensive Musicianship through their integration of musical concepts, through the breadth and depth of focus on various musical works, and through the engagement or involvement of students in the music. For example, a student is led to improvising a musical piece in order to demonstrate his or her understanding of a concept, and to demonstrate his or her musical independence. Students formulate and express their own judgments and values, evaluating their improvisations both technically and aesthetically (p. 40). D'Arms et. al. suggested that all music educators should be able to demonstrate improvisation in a variety of styles (p. 44). The use of improvisation is advocated as a means of learning music, and of developing comprehensive musicianship (p. 45).
Miller ("n.d.") emphasized the need for college and studio private teachers to be trained to meet the demands of a new role—to teach comprehensively, rather than "conservatorially" (p.2). Miller suggested that this may mean the inclusion of piano pedagogy in the curriculum for all piano students. She noted the need for broader materials which are experienced, discovered, created, and/or performed by the piano student, and which reinforce comprehensive musicianship. Miller emphasized the need for inclusion of aspects of Comprehensive Musicianship, particularly applied theory and functional keyboard (keyboard harmony), to be included in piano auditions and/or examinations in addition to performance requirements.

Gauldin (1970) outlined several approaches to teaching keyboard skills through Comprehensive Musicianship. He described the role of the teacher: a) to give keyboard assignments in a regular theory class, b) to hear keyboard skills outside of class, and c) to divide students in groups based on their piano ability, where assignments are given by grade levels, according to the person’s ability. Because Gauldin was working with secondary piano skills such as improvisation and harmonization, this correlated well with the performance/reertoire emphasis. He found that relating the theory to piano literature worked well. Gauldin identified four main keyboard areas which needed to be improved, including improvisation. The approach to improvisation instruction began with limiting students “to a kind of metric and structural framework” (p. 5). They began with little seven-note tunes in simple scale forms, then advanced scale forms, encouraging them to invent at the keyboard. Later, cadences and new phrase lengths (e.g., seven notes to four-bar phrases) were added, from a melodic standpoint. Next, accompaniment or background were added, and finally, students worked from accompaniment chord progressions to improvise the melody above
the progressions. These two approaches were worked back and forth. The keyboard was also used to reinforce other theoretical work. Gauldin noted the progress of his piano skills classes, from learning little composed pieces, to becoming musically knowledgeable in order to “get around on the piano” (p. 6). The overall goal was “for more comprehensive inclusion of keyboard skills” (p. 7).

Larimer (1972) outlined her keyboard skills curriculum for music majors whose principle instrument was not piano. Comprehensive Musicianship goals were evident in the outline; a) music reading and analysis; b) keyboard theory and technique, and c) creativity. Improvisation was included at all levels, using various concepts of basic musicianship in a variety of ways, with a wide variety of styles and keys (e.g., classic, ethnic, pop, and folk).

Mason described the use of group improvisation to reinforce the recognition of chord sequences in his theory classes (in Vinton, “n.d.,” p. 34-35). To diversify the experiences of students through Comprehensive Musicianship, Erlings (in Vinton, “n.d.,” p. 37) used improvisation in functional piano classes to link “a physical movement directly with the type of sound it produces so that later on, when staff notation is introduced, there is less looking back and forth from page to keyboard to align mind and fingers.” Erlings used improvisation to serve her ultimate goal, which was to “present the piano as a convenient sound source for the continuing study of music and musical processes” (p. 37). Hersh (in Vinton, “n.d.”) assigned his private piano students improvisations on the chord structure or melodic characteristics of a new piece. He found that this practice speeded learning and memorization, because it helped clarify the harmonic and formal structure of a new work, along with some of its stylistic conventions (p. 38).

Thomson (1990) discussed the enriching variety of musics which can be used as a point of departure in Comprehensive Musicianship, to include jazz,
Bach, Stravinsky, gagaku, raga, gamelan, Byzantine chant, and other genres. He advised that any of these musical genres might also provide a starting point for improvisation. Such a broad spectrum of music takes students and teachers beyond traditional definitions of melody and texture. Thomson recommended incorporating improvisation into the curriculum, so as to bring an immediacy and relevancy to tighten the hold on a student's musical experience. Because of its focus on the elements of music, its use of a variety of genres of music, and its emphasis upon integration of concepts in music theory, creation, and performance, Comprehensive Musicianship clearly provides an important framework for this curriculum in improvisation.

**Curriculum Theory and Design**

While Comprehensive Musicianship emerged as one of the most prominent music curriculum projects of all time, a discussion of curriculum theory in general offers a broader insight into the manner in which improvisation can be woven into piano instruction. As defined by Ornstein and Hunkins (1988), curriculum theory is a set of statements so worded that it can be used as a means of communication among teachers of a diversity of subjects, and as a directive to those who wish to study curriculum at large. Early turn-of-the-century curriculum theorists tended to be student-and child-centered, with emphasis given to content and its delivery at the pre-collegiate level, in elementary and secondary schools.

Curricular designs may be student-centered, subject-centered, or problem-centered. Each has a history, a philosophy associated with it, and a particular character (Ornstein and Hunkins, 1988). The current study focuses on the learner-centered design, especially in its emphasis on the human impulse to "experiment" and to "create artistically" (p. 178). Learner-centered designs are focused on the student (or child), and originate in the themes and practices of Jean-Jacques
Rousseau (1762), Heinrich Pestalozzi and Friedrich Froebel (in Parker, 1894), Francis Parker (1894), and John Dewey (1916) (Ornstein and Hunkins, 1988:177-178). In learner-centered designs the curriculum is “organized around human impulses...the impulse to...question, to experiment, and the impulse to express or to create artistically” (Ornstein and Hunkins, p. 178).

While educators in the distant past had little interest in formulating curriculum theory, by mid-century several major theories of curriculum had evolved. This was in part due to the influence of scientific theory, which was viewed by many to have the quality of objectivity, and which could describe and explain “what is. Curriculum specialists inspired by scientific principles thought that “theory of phenomena would allow educators to predict the consequences of putting certain phenomena into action” (Ornstein and Hunkins, 1988, p. 284). Theories of curriculum which emerged in the latter half of the twentieth century, included the theories of Carl Rogers, and Elizabeth Vallance, the latter of whose thinking is especially pertinent to the present project. Carl Rogers (1962) was a major force in the Humanistic design, an experience-centered curriculum design (Ornstein and Hunkins, 1988, p. 181). Rogers assumed that “people can enhance self-directed learning by drawing on their own resources to improve self-understanding, to learn self-concepts and basic attitudes, and to guide their own behavior.” An individual given such an environment will develop into a “fully functioning person” (p. 181). Rogers’ design is of particular relevance to the current study, in its emphasis upon drawing from a students’ musical resources to create new musical expressions.

Eisner (1972) has influenced curriculum theory related to arts education since the 1970's. A mentor of Vallance, he suggested that artistic or aesthetic knowledge is different from other kinds of knowing in fundamental ways: in
intention, in ways of making meaning, and in its method and view of truth or excellence. Eisner maintained that the arts are a distinct way of knowing characterized by specific tools, practices, and beliefs. Eisner's theorizing about arts education provided a basis upon which Vallance later developed her curriculum theory.

Vallance (1985) suggested that emphasis upon content limits our conception of what education can be. Vallance's rationale for her proposed curricular model can be best understood through first, briefly examining four systems of curricular thought, or models, which shaped discussions about curriculum from 1975-1985. The first was Tyler's (1950) series of sequenced steps in the curriculum development process which attempts to describe "how" to construct a curriculum. The second was Schwab's (1969) conception of the practical concerns of curriculum planners with an emphasis on where change can take place in a curriculum. The third model was the "conflicting conceptions of curriculum" proposed by Eisner and Vallance (1974). This model identified five sets of general "concerns" which were the differing and sometimes mutually exclusive themes underlying much discourse about the chief problems of curriculum work, such as the broad purposes of schooling. The conflicting conceptions of curriculum offer alternative and competing purposes of education from which to select. The fourth curricular model was Huebner's (1966) five rationales: 1) technical (concerned with the efficient mobilization of resources to meet desired ends) 2) the political (concerned with the power relationships developed within an educational system and community) 3) the scientific (concerned with understanding educational phenomena), 4) the aesthetic (concerned with the symbolic or aesthetic impact of educational phenomena on students), and 5) the ethical (the value of the educational activity for the child, and
the moral implications of the teacher’s responsibility for it) (Vallance, 1985, p. 205-206).

Vallance (1985) proposed that a fifth approach to curriculum thought and development be considered, based upon varieties of ways of knowing. Ways of knowing, as outlined by Vallance, include: 1) Aesthetic 2) Scientific 3) Interpersonal 4) Intuitive 5) Narrative and paradigmatic 6) Formal 7) Practical and 8) Spiritual (Eisner, p. xv and 23-173). The possibilities for reorienting our ways of thinking about curriculum problems are vastly expanded with this new perspective, Vallance suggested. Consideration of the various ways of knowing fundamentally alters the way curriculum problems are understood. For example, in teaching musical improvisation, teachers may need to consider new ways to teach improvisation to piano students who have been taught primarily through literate means (reading notation). Students may need to explore aural approaches to learning that are new and uncomfortable to them. Or, in teaching improvisation, the sequence of the curriculum may need to differ for those at different stages of musicianship. Another possibility might be to use the modes of knowing themselves as an appropriate basis on which to structure a curriculum in improvisation instruction. A consideration might be whether improvisation instruction, by definition, may demand more emphasis upon some modes of knowing, such as creating, rather than emphasis upon solving problems, or analysis (p. 214-215).

To Vallance (1982), curriculum theory and inquiry are practical and based on real situations. Curricularists are encouraged “to survey, analyze, synthesize, and test the knowledge available about curriculum problems” (Vallance, 1982, p. 9). In 1991 she suggested that coherent development of ideas about curriculum is the core of a strong curriculum and the hallmark of the process of curriculum
making. The ability to shape written argument to its tightest and most cogent form is also inherent in a strong curriculum in Vallance's view. She sees an effective curriculum as one which creates a product with a clear and compelling sequence from beginning to end. The strongest compliments Vallance gives to a work of curriculum discourse includes words such as “clear, cogent, tight, articulate, well-paced, and clearly demarcated” (Vallance, 1991, p. 234). In Vallance's view, based on her personal experience in the visual arts, a commitment to subject matter is crucial in curriculum work. Vallance's theorizing about curriculum provides a relevant basis upon which to develop a curriculum in improvisation instruction.

**Curriculum Design in Musical Contexts**

School music instruction has been informed by curricular theory at large, and also according to the practicality of music teaching and learning. Some of these curricular developments have influenced the development of programs and individual courses in music at the collegiate level. Abeles, Hoffer, and Klotman (1984) suggest five philosophical positions that describe curricular theory and practice in music. There is the “ideal curriculum,” which is instruction that should be offered, as opposed to a “clinical” view of what is actually offered (p. 266). A second view is “formal curriculum,” that which is described and preserved by state departments of education, school boards, and other policy makers. The “instructional curriculum” is a third perspective--“what they [teachers] think they should be teaching compared with what they actually teach” (p. 266). The “operational curriculum” is “what he or she [the student] actually experiences in the context of the class,” as opposed to what is theoretically expected to be experienced as a result of instruction. The experiential curriculum is a composite of the four perspectives, and is affected by variables such as goals and objectives,
materials, content, learning activities, teaching strategies, evaluation, grouping, time, and space (p. 267). The experiential curriculum is related to the current project in improvisation instruction, in that students synthesize each of the above variables (goals, objectives, content, activities, and so on) in the process of learning to improvise at the piano.

Jorgensen (1987) suggested an approach to curriculum design in music which moves from philosophical premise to practice. Her approach is relevant to all levels of music instruction, and represents “a quantum leap from a higher order to a lower order of generality and a corresponding increase in the number of practical options that reflect this generality” (Jorgensen, 1987, p. 94). Jorgensen’s definition of curriculum, “the content of instruction” (p. 95), focused on a working list of principles: economy, richness, balance, realism, structure, ethical acceptability, excellence, consistency, correspondence, coherence, relevance, personal preference, and utility (pp. 96-98). Jorgensen believed that “students need a structure or a framework on which to hang ideas” (p. 100). Before students themselves can be expected to have such a structure for the musical knowledge and skills they acquire, their teachers must first have it clearly in mind. Jorgensen maintains that this curriculum-design process becomes “a significant, developmentally sequenced body of substantive content” (p. 105). The design process she explains is useful to all who plan courses and curriculum in music at all levels, including improvisation instruction.

Summary

Historically, improvisation was practiced by keyboard players from the Baroque through the Romantic eras, but declined in the nineteenth century. Piano improvisation in public performances has been relatively dormant in the twentieth century except for jazz, and for the brief surge of interest in art music in the late
1970s.

Improvising pianists emphasized that improvisation is best understood through the practical experiences of doing it. These pianists reinforced the irrepressible nature of improvisation, and its value to them as performers. Pressing's technical and comprehensive discussion of improvisation explored the processes involved and pedagogical approaches to improvisation. Like Nettl, he also stressed that the student must learn the model before improvising on it. Clearly, aural skills development plays a critical role in the development of musicianship, as it does in learning to improvise. In piano instruction, the importance of playing by ear and ear-training was emphasized in the literature.

The literature on jazz improvisation made clear the similarities in the process of learning to improvise in all styles, and placed particular importance on knowing the underlying harmony of specific works. The pedagogy of improvisation encompasses both jazz and classical styles. These materials utilized a range of written explanations, notation, and recordings in the instruction.

Comprehensive Musicianship provides a basis for the curriculum presented in Chapter V; its emphasis on listening, performing and creating is the logical combination for allowing the student to broaden his or her musical experiences. This musicianship curriculum, concentrated in aural skill development and the permutations of melodies and accompaniment textures, was launched from Vallance's curriculum theory, with its varieties of ways of knowing, and practical considerations related to curriculum design in real-life situations. Chapter III presents literature specific to piano instruction in musicianship development, including various perspectives and applications of the technique and process of improvisation.
Chapter III

Six Relevant Dissertations on Piano Instruction, Musicianship, and Improvisation

Six dissertations particularly relevant to teaching musicianship, including oral skills and various levels of improvisation at the piano are reviewed here. Improvisation training is described in terms of the development of the instruction, the students for whom it is intended, the length and context of the instruction, the actual musical materials, and the instructional strategies employed. This chapter concludes with a comparison of principal components of the instructional process featured within the six studies, thus providing a foundation for the current curriculum project.

Rosfeld: The Development of a Series of Instructional Units for Teaching Improvisational Principles to Pianists

Rosfeld's (1989) purpose was to develop a series of instructional units for teaching improvisational principles to pianists. The study gave guidance to students on processes of experimentation and repetition, as critical components of improvisation, and suggested some logical systems of harmonic progression that have worked for many composers, arrangers, and improvisers. Through the recommended curriculum, Rosfeld maintained that students would acquire functional performance skills and learn the nature of musical structure—"how music really works" (p. 10). She intended her instruction to be used in college piano classes, as the keyboard harmony component of the freshman-sophomore theory sequence, in private study for students from high school through adult ages, or as a self-instruction guide to improvisation.

Rosfeld considered several basic working principles in her development of the instructional units. The first principle was more practical than theoretical, in that students were encouraged to learn by experimentation and repetition rather
than by theoretical study. The second principle was the use of broadly based sound materials, not specific musical idioms. Melodies were derived from traditional art, folk, patriotic, popular, and religious genres. Third, the “authenticity of the [music] theoretical concepts was established by examples from piano literature” (1989, p. 287). Fourth, the musical concepts were applied to phrases, sections, and whole pieces where possible. Fifth, the instructional units were designed so that students might proceed to study the entire sequence or choose randomly those units applicable to their abilities and interests. Last, the improvisational principles were designed to encourage experimentation of pianistic and compositional techniques.

Rosfeld used music that spanned a spectrum of classical, folk, jazz/popular and hymn tunes. Notation of familiar melodies was given for students to play, and to add harmonizations and improvised accompaniments. Notated scores of classical works containing the concept being focused upon, were presented for study. Also included were lists of familiar melodies for students to play, to add harmony and improvised accompaniments. Classical examples used in Rosfeld’s instruction included, for example, Kuhlau, J.S. Bach, and Debussy. “Lightly Row,” “Erie Canal,” and “Kum Ba Ya,” were some of the many folk melodies used for improvisation activities. Jazz/popular selections included “Blue Shadows in the Street” by Brubeck, “How About You” by Shearing, and “Five Foot Two” by Henderson, among others. Hymn tunes included “How Firm a Foundation,” “Crusaders’ Hymn,” and “Ode to Joy” by Beethoven. “Swing Low, Sweet Chariot,” and “Nobody Knows the Trouble I’ve Seen” were two of the spirituals used in the study.

Rosfeld’s instructional procedures began with a review of scales and intervals, triads, inversions and harmonic functions. Each subsequent unit began
with a description of the theoretical music concept on which the unit was
focused: tonic and dominant seventh chords, subdominant chords, three primary
chords and melody in right hand, octaves in left hand, chord substitutions, static
bass, horn fifths, circle of fifths, seventh, ninth, and eleventh chords, descending
bass line with step progression, ascending bass in diatonic and chromatic motion,
sequential bass pattern, walking bass, chords in parallel motion, chords in
contrary motion, and quartal harmony.

She included practice steps which would prepare the student for
experimentation at the piano using the featured concept. Instructional suggestions
involved practice of the concept at the piano, such as playing a chord pattern in a
variety of keys, playing pentatonic scales in all keys, and playing the primary
chords in a given minor example in all minor keys. Notation of familiar melodies
using the music-theoretical concept was given for the student to play and analyze.
In every unit, the music-theoretical concept was then applied to Beethoven’s “Ode
to Joy” theme. Notation of examples from familiar piano literature, which
contained the theoretical concept, were given. Melodies with, or sometimes
without, chord symbols, for harmonization by the student, were then presented.
Finally, titles of other familiar melodies for further melodic and harmonic
improvisation were suggested.

Rosfeld’s guide was exemplar in its use of compositional and
improvisational procedures, and its creation of a means by which to focus student
experimentation in a systematic and productive manner. While numerous
theoretical concepts were selected, there was no evidence of the use of
contrapuntal devices such as canon, or instruction in L.H. accompaniment
patterns. The units might have been expanded to include such musical styles as
jazz, ragtime, gospel, and rock.
Kolar: A Guide to Elementary Keyboard Improvisation Using Selected Twentieth-Century Compositional Techniques

The purpose of Kolar’s (1975) study was to present an organized, developmental approach to improvisation instruction as a component of basic music learning at the keyboard. She used elementary improvisation experiences, elementary materials and teaching strategies, and certain relevant twentieth century compositional techniques, in order to address the keyboard instructor’s absence of, or limited experience in improvisation. The study also provided necessary background material essential to the process of self-growth in music.

Kolar identified a need for teachers and students to know how to improvise as a means of enriching musical experience, both as a learning tool, and as a creative endeavor. She noted that most keyboard teachers may neglect to teach improvisation because of their own inability to improvise, and their lack of understanding of twentieth century harmony. She suggested that teachers might first develop their own improvisation skills through employment of twentieth-century compositional techniques, in order to ready themselves to develop the improvisation skills of their students.

Kolar designed her study for keyboard teachers working with children, ages 6-10, in the first three levels of piano instruction, whose experience in improvisation was limited. She implied that the instructional unit could be adapted with the continuing piano student, the older beginner and the adult piano student, and the student playing other instruments, but focused her curriculum development on the needs and interests of children. Many of her instructional activities were designed for ensembles and group piano instruction, but are able to be modified for the “private” lesson.
The materials and instructional strategies for learning the contemporary compositional techniques were taken from a curriculum in the Agnes Russell Piano Program of Teachers College, Columbia University. The Robert Pace Music for Piano and Skills and Drills, Books I - III, were used as a guide for determining elementary musical skills and understandings for the various levels.

The preparatory stage of Kolar’s curriculum for contemporary keyboard improvisation included rhythmic, melodic, and harmonic improvisation using call-and-response structures, her own and children’s invented stories, and question and answer. Kolar’s expectations were for the student to experience conceptual learning through simultaneous activities in dictation, theory, sight-reading, transposition, technique and improvisation, leading to the children’s understandings and skills required for improvisation that utilized her selected twentieth-century techniques.

The following “twentieth century techniques of composition” (Kolar, 1975, p. 3) were selected for use in her study: the pentatonic scale; modes (including Ionian, Dorian, Phrygian, Lydian, Mixolydian, and Aeolian); the whole-tone scale, as tonal material for developing improvisational skills; bitonal technique, such as combining D major and D flat major; bimodal technique, for example, when Dorian and Phrygian appear simultaneously; bichordal technique, as when two chords, such as C major and D minor, are employed simultaneously; quartal harmonies; and the twelve tone scale, which uses the twelve tones of the chromatic scale in a “tone row”. Kolar selected these compositional techniques because they were used extensively in keyboard literature for children, such as in Robert Pace’s Music for Piano, Books I - VI. Her selections provided a variety of opportunities for guided and free improvisation.
Kolar arranged for two levels of evaluation: the teacher’s evaluation of the student, and the student’s own self-assessment. The teacher evaluated improvisational activities focusing on technical growth on isolated exercises and on the active application of technical skills to creative activities. Students evaluated themselves simultaneously with the teacher’s evaluation, according to the tonal and rhythmic material they employed in their improvisations, their expressiveness, and their technical execution.

One of the strengths of Kolar’s instructional plan is that students who utilize twentieth century compositional techniques in their improvisation have the structural knowledge and kinesthetic skills for continuous exploration and application of musical ideas. Her intent was to direct students toward maintaining continued growth in music and expressiveness after formal lessons have ended.

Kolar’s study may have been weakened by the limited number of musical techniques used for improvisation. Also, her selection of twentieth century music was somewhat limited, and did not include any genres that could be described as jazz, rock, electronic or aleatoric. Occasionally, descriptions and explanations designed for the student are cumbersome in precise specifications of tasks to be accomplished. Another limitation of the instructional material was the absence of any relationship to composed piano literature.

**Larsen: Teaching Basic Jazz Piano Skills to Classically-Trained Adult Pianists:**

**A Mastery Learning Approach**

The purpose of Larsen’s (1986) study was to determine whether systematic, linear procedures—the theoretical models of Markle (1967), Carroll (1963) and Bloom (1968), and Scriven (1966)—could be used in the development, design, and evaluation of a course in teaching basic jazz piano skills to classically-trained adult pianists.
This study addressed the need for a short, encapsulated course in basic jazz piano skills which begins at a very rudimentary level. Such a course was deemed necessary to help adult pianists overcome inhibitions about their improvisational ability, foster group improvisation activities, and allow interaction in developing jazz piano skills. Larsen maintained that a course in jazz skills was needed which could serve as a model of systematic course development and evaluation, and one which could provide certain knowledges, skills, and attitudes for every student who takes the course.

Subjects were classically-trained adult pianists who were interested in acquiring basic jazz piano skills. All except one of the eight subjects were female, and ranged in age from 19 to 72.

Larsen's course consisted of lesson plans and evaluation materials for a five-week, 15-hour course. Goals of the course were, first, to provide students with knowledge of the jazz idiom, jazz terminology, jazz chord symbology, and the names of jazz pianists and pedagogists. The second goal was to develop students' ability to realize seventh chords from letter symbols. Third, the course was to develop students' skills in jazz improvisation. The fourth goal was to improve students' attitudes toward their own improvisation ability.

The course was developed in three stages. Stage 1 was “developmental testing,” to identify major problems in the materials and teaching strategies. Stage 2, “validation testing,” was to determine the entry characteristics necessary for the learners, the conditions necessary for efficient and effective learning, and the time frame appropriate for the course. Stage 3, “field testing,” was to provide information on the effectiveness of materials and teaching strategies.

Larsen's instructional strategies included the teacher's presentation of concepts and themes in didactic lecture style. Concepts addressed in lectures and
through practice sheets were: jazz-related terms, important jazz pianists and jazz pedagogy materials, jazz chord symbols, lead sheets and their interpretation, melodic jazz improvisation, the acquisition of positive attitudes toward one's improvisational ability, and listening to live and recorded jazz performances. In the application of demonstration as an instructional strategy, the teacher demonstrated melodic riffs, using blues tetrachords, which the students then imitated. Larsen reinforced desired skills over a series of lessons, building on previous learning.

Teaching tools for the course included one keyboard per student, with earphones, a record player, a cassette tape player, a blackboard, chalk, eraser, the handouts, and recordings as listed in a discography.

Both formative and summative evaluation instruments were devised by Larsen in the process of developing the course. Results of the evaluation indicated that her course was successful because most students reached the predetermined mastery levels of knowledge and performance within the time frame of the instruction, through the instructional strategies used.

The study provided strategies which seemed to affect positively the attitudes of the students toward their improvisational talent and ability. Specific techniques for improvisation helped students to become less dependent upon notation. The use of groups, and the use of familiar jazz and popular tunes both, helped to motivate students. Larsen's use of a systematic and linear schemata grounded in several theories of instruction provided for a solid contribution to the area of jazz improvisation training. Adding further to the merits of her instruction were the enrichment activities for students who needed a greater challenge, and remedial activities for students who needed extra help.
This course lacked notated examples of the music presented in the lessons. The only notated examples were technical ones, such as notation for the blues scale, riffs, blues bass patterns, chord types and symbols, and the various modes, in the handouts. Since recorded and taped examples were used in the curriculum, the reader, and possibly the student as well, would benefit from seeing the notation, as a model for reinforcement, for at least some of the musical activities suggested.

**Bash: The Effectiveness of Three Instructional Methods on the Acquisition of Jazz Improvisation Skills**

The purpose of Bash's (1983) study was to examine the effectiveness of three instructional methods to determine if any produced effective jazz improvisation performance skills. The first method presented notated exercises from the Aebersold (1979) text. The second method supplemented the first through the addition of aural perception procedures, such as vocal and instrumental activities. The third method utilized historical-analytical information as an adjunct to the procedures and materials of the first treatment. Method three also provided specific directed listening to the recorded performances of respected jazz performers.

Bash evaluated the three methods through a pretest-posttest design with three treatment groups and a control group. Fifteen high school instrumental students, all performers of melodic instruments in their jazz ensembles, were randomly assigned to each experimental group. Class duration was one hour per week for seven weeks.

The materials for teaching were gleaned from a pedagogical manual by Aebersold (1979), the Smithsonian Collection of Classic Jazz (Williams, 1973), and the teacher-prepared handouts. These handouts, used as a component of all
three treatments, included “A Guide for Practicing any Scale, Chord, Pattern, or Idea”, “Playing With the Record”, “A New Approach to Jazz Improvisation,” “Playing the Blues,” “Improvising Check List,” “Pentatonic Scales,” “Instructor’s Pattern Sheet,” “Musical Development,” “Cadential Patterns,” “Chromatic 2,” “Random Minor,” “Chromatic,” “Articulation,” “Chromatic 3,” “Minor to Dominant Seventh,” “Time,” and “Points to Keep in Mind When Improvising.” The handouts were used during class and as assignments to be completed out of class.

Students receiving improvisation instruction through experimental treatments two and three showed significantly greater improvisation ability than students in the first treatment or control group. A strength of the course, according to various informal observers, was in the use of improvised solos (vocal and instrumental), as a supplement to the Aebersold material, for treatments two and three. Bash noted that the course should have been extended over a longer period for maximum effect, as well as increasing instruction from once to at least twice weekly.

Despite non-significant differences between treatments II and III, a particularly enjoyable activity as noted by participating students, was the use of aural stimuli from recordings, combined with explanations of the procedures to be followed. This researcher suggests that the addition of notated musical examples to supplement the instructions, might have made some of the procedures more clear for the student.

**Konowitz: Jazz Improvisation at the Piano--a Textbook for Teachers**

The major purpose of Konowitz’s (1969) study was to offer a sequentially structured course in jazz improvisation at the piano oriented toward specific musical elements--rhythm, harmony, melody, form and expressive elements. His focus was the training of teachers so that they would gain deeper insights into the
nature of jazz improvisation and its place in the development of students’ musical growth. A second purpose of the study was to develop preparatory experiences to introduce the potential improvisor to jazz improvisation, and a third purpose was for Konowitz himself to compose original jazz piano compositions highlighting specific musical elements which would satisfy the needs of this instructional approach.

Konowitz’s textbook began with an explanation of the nature of the improvisational experience. Basic goals of the instructional approach were the student's self-discovery of spontaneity and the development of motor skills critical to performing jazz style. The textbook format served the purposes of a sequentially structured program of activities that could be a) applied to a group instruction situation, a private studio, or an elementary, secondary or college level class, and b) utilized by an individual teacher as a self-teaching, learning program.

The textbook Konowitz designed was to fulfill the scope of work covered during one academic year. Musical materials included notated exercises to “clap, say, tap the foot to, analyze, play, and improvise on” (pp. 61-363). Supportive listening lists were included in most of the units, suggesting students’ regular listening to musical works that would provide them with ideas for later improvisation.

Konowitz’s procedure for the eleven units began with presentation of the basic concept, followed by practice techniques, a list of supportive listening, along with an historical background and description of style. His approach utilized a playing-by-ear technique, as well as singing, whistling, listening, and analysis, and of course, creative/compositional strategies.

The sequence of activities began with non-piano jazz-oriented improvisational experiences such as clapping rhythmic questions and answers,
expressing feelings non-verbally, improvising body movements, creating 
environmental and body sounds, exploring the timbres and techniques of rhythm 
instruments, chanting and singing any written textual material aloud. A second 
step in the sequence moved students to the piano. Jazz-oriented improvisational 
experiences at the piano included rhythm and pitch activities, and procedures for 
implementing improvisational experiences such as using single random notes, 
tone clusters, scales, modes, ragas, and programmatic devices. Konowitz offered 
exercises and experiences in melodic, rhythmic and harmonic development, as 
well as ways to incorporate the expressive elements. Konowitz discussed the 
evaluation of jazz improvisation performance by students in terms of assessing 
harmonic accuracy, “swing”, unity and contrast, restraint of material, and 
originality.

Konowitz’s study is strong in its comprehensive, sequential instructional 
procedure. It was particularly unique in that it spanned an entire year’s worth of 
study. His listening lists may need to be updated, as it is likely that there are more 
current examples to be added to those available at the time of the dissertation’s 
writing over twenty-five years ago.

Brown: An Investigation of the Effectiveness of a Piano Course in Playing By Ear 
and Aural Skills Development for College Students

The purpose of Brown’s (1990) study was the development and evaluation 
of a course in the cultivation of aural skills in music through playing piano by ear. 
By extension, Brown sought to facilitate greater aural comprehension of music in 
general among his students.

Brown’s course objectives were to teach students how to play the piano by 
ear, improve their aural skills, and facilitate greater understanding of harmonic 
structure. Course content was conceived in terms of melodic and harmonic
comprehension. Melodic comprehension was taught by means of melodic exercises which the students played, sang, and wrote in a type of melodic dictation, to demonstrate aural understanding. Harmonic comprehension was taught through harmonic activities such as chord root dictation and playing chord progressions.

The length of the course was one semester, and the setting was a university piano laboratory which incorporated a Wurlitzer “Visualizer”. The visualizer allowed students to see notes on a musical staff or a keyboard that were played by the instructor on the keyboard. The lab contained a teacher's console and 12 student keyboards. The class met for an hour three days each week.

Students were a volunteer sample of college undergraduate music and non-music majors generally homogeneous in musical abilities. Students auditioned, and were accepted if they met the selection qualifications: the ability to read music, and elementary level keyboard proficiency. Eleven students completed the course.

Materials of instruction included chalk board, cassette tape players, and student handouts. Music used in the instructional process included familiar folk songs, such as “Frere Jacques,” popular songs, such as “Somewhere, My Love,” spirituals, such as “Oh, When the Saints,” jazz, such as “Song Sung Blue,” and cassette tapes containing melodic pattern exercises and song excerpts. Instructional procedures focused on subproblems relevant to the development of aural and performance skills. The first subproblem examined the extent to which a semester's instruction affects students' ability to notate melodic patterns after hearing them played on the piano, and to play melodic patterns by ear on the piano after hearing them modeled by the instructor. The second subproblem focused on developing, through selected bass and harmonic exercises, students’
ability to a) identify chord roots, b) identify the quality of chords played on the piano, c) identify by name the chords in a chord progression played on the piano, and d) play a musical example by ear after hearing it modeled on the piano. The third subproblem dealt with the extent to which the students’ understanding of concepts related to playing piano by ear, and aural comprehension of melodic and harmonic exercises, were affected by the course of instruction. Students were required as part of the instruction to play 25 popular and folk songs by ear, which were graded in terms of correct notes, correct chords, and number of interruptions in performance. Subproblem four investigated what information in course definition, sequencing, and pacing can be derived from the use of formative evaluation instruments. The investigator collected formative evaluation information by means of unit tests, questionnaires and an instructor's log. Subproblem five is not relevant to this discussion.

Brown first designed a series of instructional exercises to increase aural awareness of melody, which took the form of students responding to melodic patterns played by the instructor on the piano. These patterns were sequenced according to complexity and derived from a growing list of chords. For example, Unit I included melodic patterns derived from chords I and V7. The investigator prepared and distributed tapes containing melodic patterns used as homework. Students listened to the patterns on their own, played them by ear, and notated them as in traditional dictation. Students were instructed to play familiar melodies, such as “Frere Jacques” and “London Bridge,” by ear, when given titles and starting notes. Individually and as a group, melodies were sung, using scale degree numbers, and later using note names. Melodies were played and transposed individually, and as a group. Chord exercises, such as playing chord progressions were explained and demonstrated by the instructor, then played by the students.
Brown included outcomes, or evaluations of each class which were used as feedback to improve the instructional procedures. Brown used unit tests, questionnaires, and an instructor’s log as the basis for the evaluation of student knowledge, skills, and attitudes toward instruction. The use of student evaluative feedback during the instruction process was integral to the effectiveness of the course. The instructor evaluated the effectiveness of the student’s learning through assignments, class activities, tests, and individual and group performances as the course progressed. In general, students preferred playing songs by ear to playing pattern-and-progression activities based on taped stimuli. Students considered singing and chording accompaniment activities to be effective and enjoyable.

Comparisons Among the Six Dissertations

Relevant to improvisation instruction, the six dissertations are distinctive and yet share in several elements. The following were among the instructional strategies employed by some, if not all, of the six dissertations examined: vocalization (singing and rhythmic chanting); teacher demonstration; teacher verbalization (lecturing, questioning, assigning, checking, critiquing, and reading aloud); group or partner (rather than individual) activities; evaluative strategies (student self-assessment and teacher-assessment); kinesthetic activities such as tapping and clapping; playing activities (playing exercises, melodies, harmonic chord progressions, excerpts, and whole pieces); listening (both holistic and focused on specific components); and enrichment strategies.

Vocalization

Vocalization is defined here as singing and rhythmic chanting of melodic and accompaniment patterns. Singing strategies were utilized in three of the six studies, in which students were directed to sing patterns, song melodies, and tones
of triadic chords. Brown (1990) used melodies (using scale degree numbers, note names, in various keys), chord roots using neutral syllables, passing tones between chord tones, and a chord root bass line. Konowitz (1969) utilized the diatonic scale (then creating blues notes), and advised that students vocalize new rhythms or melodies above a riff. Bash’s (1983) singing strategies included suggestions for melodic and rhythmic patterns, and for improvising the blues.

Chanting, or vocalized sounds in rhythm were used in two studies. Kolar (1975) used word chants as a vocal reinforcement to physical movement, added words to establish meter (pine-ap-ple pine-ap-ple), and added words to verbally reinforce the rhythm (walk, walk, run-ning, run-ning). Konowitz (1969) utilized chanted sounds to express feelings, and written material chosen by the students that were chanted aloud.

Teacher Demonstration

Teacher demonstration, live and recorded, was used explicitly in three of the dissertations. In all cases, demonstration was followed by the student’s imitation of the musical behavior. Brown (1990) employed teacher demonstration of finger technique of scales and chords, using a visualizer to demonstrate chord type, root position chords, and chord inversions. Bash (1983) used demonstration of pieces and scales, and playing along with a recording. Larsen (1986) used call-and-response, playing one-measure melodic motives an octave higher, playing a bass pattern while students improvised individually with their right hands. She also planned for the teacher to deliberately make an error in a given excerpt or exercise to ascertain the musical awareness and style sensitivity of her students.

Teacher Verbalization

Teacher verbalization is defined as spoken behaviors that include lecturing, questioning, assigning, checking, critiquing, and reading aloud. These strategies
were utilized by all six studies, with more extensive use by four of them. Lecturing (presenting concepts, writing on the board, questioning, and dictating material) were used by Rosfeld (1989), Brown (1990), and Larsen (1986). Explaining (text, notation, chord nomenclature, lead sheets) was used by Rosfeld (1989) and Larsen (1986). Assigning of various activities, such as memorizing and taping of improvisations was used by Rosfeld (1989) and Larsen (1986). Konowitz (1969) used reading, playing, singing, practicing, composing, improvising, analyzing, listening (to recordings), transposing, writing/notating, experimenting, and researching in his comprehensive text. Reviewing of instructions for a handout and for tests, was utilized by Brown. Evaluative strategies utilizing teacher verbalization used by Larsen were evaluation of student tapes in class and giving of feedback.

**Group or partner strategies**

In group or partner strategies, students interacted with each other in pairs, or with the group as a whole to learn how to improvise. Kolar (1975) recommended the formation of partners or groups for clapping and marching activities. She suggested the use of call-and-response, first as a group, then in pairs, where one group claps while the other group plays variations in various ways, while emphasizing various musical elements. Other group strategies included ensemble playing and activities, and group improvisation.

**Evaluative strategies**

Evaluation, or assessment, of the effectiveness of the instruction—both by teacher and student—was an integral part of the instructional process for Larsen (1986). Teacher and students evaluated each of the 31 class lessons to ascertain whether or not course objectives were met. Teacher evaluative feedback was given, and each student's improvisation tape was evaluated in class, with specific
constructive criticisms given. In all dissertations, evaluation of progress by the teacher or student was implied, if not directly and formally advised.

**Kinesthetic activities**

Kinesthetic, or movement-based strategies, included use of the hands, arms, legs, and feet to realize rhythmic, melodic, and formal components of the music studied. Kolar (1975) used clapping of the beat and the rhythm, shaping of the melody with the hands, and marching in a circle. The playing of small percussion instruments while marching, swinging the arms, or walking and running were other kinesthetic activities employed. Konowitz (1969) proposed improvising body movements to express types and qualities of sounds; these were preparatory experiences to actual improvisation at the piano.

**Playing activities**

Student playing activities, or the use of explicit, specific playing techniques and musical material at the keyboard, were key to all of the six dissertations. Playing included exercises, melodies, harmonic chord progressions, excerpts, whole pieces, “hands separate,” and “hands together.” In his study, Brown (1990) employed transposing, improvising (structured and free), patterns (exploring), whole pieces followed by improvising through making changes. Konowitz (1969) utilized playing of lead sheets, playing/taping it/analyzing, and playing, then writing an improvisation. Kolar (1975) utilized call-and-response or question/answer, and use of various textures. The remaining three dissertations (Rosfeld, 1989; Larsen, 1986; Bash, 1983) presented some combination of these techniques and materials.

**Listening**

Listening is the conscious effort to hear, or give aural attention to the musical features (Sykes, 1984). Listening may provide aural models of the
improvisatory process, thus playing an important role. Listening strategies were used repeatedly by three of the dissertations: listening to pre-recorded tapes (Larsen, 1986—jazz and blues; Brown, 1990—various ear training-related pretests/posttests); avoiding notation, and recording improvisatory attempts (to be listened to by the student, and evaluated) (Larsen, 1986). Konowitz (1969) presented listening lists of non-jazz and jazz to reinforce concepts such as recognition of style. Brown (1990) utilized students playing songs and chord progressions by ear, and melodic and chordal dictation exercises. For Rosfeld (1989) and Kolar (1975), listening was assumed, and implied throughout the instruction.

**Enrichment strategies**

Enrichment activities were additional or extra instructional strategies which provided for able students who learned at a faster pace, and therefore needed more challenge than the other students. Larsen's (1986) enrichment activities included optional activities for the student such as relevant reading, research on jazz pianists and musicians, and evaluation of higher and lower quality jazz performances. Other activities were teaching a friend to play 12 bar blues, using hands together rather than separate, and transposing patterns to various keys. Rosfeld (1989) provided supplementary lists of melodies for students to use for additional improvisation experiences, while Kolar (1975) included enrichment activities in her “Implications” section for levels II and III. Konowitz (1969) used self-discovery activities such as exploring, discovering, and analyzing, historical focus (historical material related to the elements of jazz improvisation).

**Summary**

This review of the six dissertations in piano instruction has focused on the development of listening, performing, and creating skills, all of which are included
within the current curriculum. The rationale for, and the process of development of, this curriculum will be presented in Chapter IV.
Chapter IV
Development of Permutations of Standard Piano Works:
A Curriculum for the Development of Student Musicianship

This “piano permutations” curriculum is designed for intermediate-level collegiate piano students as a means of developing their understanding of musical styles and structures, including the melodic, rhythmic, textural, and formal components of particular piano works. Underlying this curriculum are several principles of Comprehensive Musicianship, including aural skill development strategies, and “multiple ways of knowing” theory as espoused by Vallance.

Comprehensive Musicianship provides a rather explicit model of techniques and processes for including listening, performing, and aspects of improvisation (permutation) in this curriculum. Students who study and then create permutations within the framework of Comprehensive Musicianship are likewise demonstrating an understanding of the relationship between aural comprehension and performance technique. As a specific model of curricular objectives and content in music, Comprehensive Musicianship provides an important reference for this curriculum in piano permutations.

Both the existing improvisation instruction materials and the six dissertations described earlier contain useful techniques reflective of relevant means of developing student musicianship, many of which are incorporated within this curriculum. Directed listening, vocalization (both singing and chanting), repetition and practice, kinesthetic activities, and evaluative strategies are integrated within the curriculum.

Curricular Goals

There are three goals of Permutations of Standard Piano Works: A Curriculum for the Development of Student Musicianship:
a) To improve students' analytical listening skills, with directed attention to elements of melody, rhythm, texture (i.e. harmony or polyphony), form, articulations, and expressiveness, that comprise a style;
b) To allow students to become interactive with styles exemplified in excerpts from selected works of standard Western European piano literature, through experiences in directed listening, performing, and creating;
c) To vocalize through the singing and chanting of melodies, rhythms, melodic exercises, chord roots and pitches, and accompaniment patterns.

All three goals are intended to be accomplished without reference to notation.

**Instructional Sequence for Permutations of Standard Piano Works: A Curriculum for the Development of Student Musicianship**

The procedures in the design of the curriculum consisted of selecting appropriate piano works that could serve as musical models for developing permutations, and the preparation of a sequential order through which musical understanding and skills could be advanced. Strategies employed in the instructional sequence of the curriculum were 1) **listening** to whole musical works, excerpts from these works (including melodies only or accompaniment patterns), and permutations of these works; 2) **vocalizing** (singing and chanting) melodies, patterns, and exercises, (using la, scale degree numbers, and letter names of notes); 3) **playing** melodies and exercises by ear that are comprehended aurally and without the aid of notation; 4) **tapping** the rhythmic patterns during and following listening; 5) **exploring** one's own ideas, playing them with the right or left hand, or with both hands; 6) **practicing** melodic and rhythmic motifs and
harmonic chord progressions, and 7) **evaluating** one's own permutation of the selected work.

**Selection of the Musical Examples**

Selection of musical examples for *Permutations of Standard Piano Works: A Curriculum for the Development of Student Musicianship* began with a review of an extensive range of typical intermediate-level piano literature in order to determine the appropriateness of the musical content of model pieces for use in developing musical skills and understanding at the intermediate level. The following criteria emerged in the selection of music for the curriculum: a) Each piece should be a piano composition by a known European composer (J.S.Bach, Beethoven, Mozart, Haydn, Schumann, Chopin, Bartok, and Kabalevsky); and b) Each piano composition should be stylistically representative of the composer's works and within the technical range of intermediate-level students (see Tables 2-13, pp. 73-84, for a summary of the musical and technical features of the selected model pieces).

**Equipment**

The curriculum uses a printed student manual, a MIDI keyboard interfaced to the computer, and the aural component delivered to the student through a computer. Any computer (PC or Macintosh), with a keyboard display (viewing screen), a mouse (hand-held device which allows the operator to control the software on the computer by accessing commands located in various menus), and a software sequencer (software installed on the hard drive) may be used. In this curriculum, sequencing software (e.g., "Mastertracks Pro" or "Performer") records all of the nuances (pitches, duration, velocity and pedaling) demonstrated in the performance of a musical work, excerpts, or exercises. Variety of dynamics, various tempi, specific articulations and pedaling are digitally recorded. The
sequencer stores on the computer’s hard drive what the student plays (known as the sequence), and plays back this MIDI information through speakers in the MIDI keyboard. The actual sound is regenerated through the MIDI keyboard when “play” is clicked on the symbol representing the particular recording function; a control panel with symbols indicating start, record, pause, and stop are located on the display (see Figure 2, p. 92). This is roughly analogous to a tape recorder, but it records data instead of sound. If the student wishes to take the aural component of this curriculum to a computer at a different location, the data can be saved on a removable diskette, which can then be transferred to a compatible computer with the appropriate music editing software installed.

The student begins by sitting at a MIDI work station, which contains a computer, computer display, computer keyboard, mouse, and MIDI keyboard (see Figure 1, p. 89). Once the computer and the MIDI keyboard are turned on, the student can proceed through the curriculum by reading the explanations and directions in the manual, and listening to the aurally presented musical works, excerpts, and exercises. The student moves the mouse to the appropriate symbol on the display and clicks the mouse to access the various files (see Figure 2, p. 92). The student’s own folder containing each of twelve musical works in separate folders is accessed first. After the appropriate composer’s folder is selected, the appropriate file containing the musical examples for the particular piece is opened within that folder. Next, the student hears the musical sound, stops and starts the sound as desired, responds to the various directions to listen, vocalize, tap, and play, and records his or her improvisation. At no time does the student view the notation; within the presentation of the curriculum in Chapter V, notation is included only to inform the reader of the sounds that are presented aurally.
The Curricular Plan

Strategies that comprise the instructional sequence for this permutation curriculum were selected for their match with the goals of the curriculum; all twelve musical works utilize similar procedures (see Table 1 for steps in the instructional sequence, pp. 73-84). As noted above, the aural component of this curriculum was initially generated through use of Finale, a music notation program. The notation contained in the reader’s edition of the curriculum--Chapter V--is not part of the actual student manual. (See Appendix for the student manual without notation; the disk which contains all aural examples is in the pocket inside the back cover of the dissertation). In the first steps of the instructional sequence, the student listens to a performance of the entire piano work--without reference to notation. The purpose of hearing the entire work is to familiarize the student with the compositional style in the fuller musical context, rather than just the eight to twelve measures of the excerpt. The student then listens to a performance of the selected musical excerpt, the model on which the student’s own musical permutation will be based (Table 1, #2).

In the next listening, the student is directed to focus attention on the melody (Table 1, #3). The student is then directed to listen to the melody played alone three times (an arbitrary number chosen to allow the student to become somewhat familiar with the melody) (Table 1, #4). This allows the student to focus attention on particular musical components from which a “new” melodic improvisation will be launched. Then, with eyes closed, the student sings the melody using a neutral syllable (“la”) (Table 1, #5), and then again sings the melody using scale degree numbers (Table 1, #6), and then letter names of pitches (Table 1, #7). If the student cannot sing the melody using “la” or scale degree numbers, he or she may listen to the melody again and try until the task can be
<table>
<thead>
<tr>
<th>Table 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>THE STUDENT:</strong></td>
</tr>
<tr>
<td>1. HEARS entire piano work.</td>
</tr>
<tr>
<td>2. HEARS the excerpt of the work, hands together (8-12 measures).</td>
</tr>
<tr>
<td>3. HEARS excerpt again; focus on melody.</td>
</tr>
<tr>
<td>4. HEARS melody alone three times (usually the right hand).</td>
</tr>
<tr>
<td>5. SINGS melody on “la,” with eyes closed.</td>
</tr>
<tr>
<td>6. SINGS melody using scale degree numbers.</td>
</tr>
<tr>
<td>7. HEARS melody again; sings letter names of pitches.</td>
</tr>
<tr>
<td>8. PLAYS entire melody by ear on piano in given key.</td>
</tr>
<tr>
<td>9. HEARS first melodic permutation.</td>
</tr>
<tr>
<td>10. HEARS melodic permutation again; taps rhythm while listening, and</td>
</tr>
<tr>
<td>after listening.</td>
</tr>
<tr>
<td>11. HEARS the melodic permutation again and sings it on “la,” with eyes</td>
</tr>
<tr>
<td>closed.</td>
</tr>
<tr>
<td>12. SINGS the melodic permutation using scale degree numbers.</td>
</tr>
<tr>
<td>13. SINGS the melodic permutation using letter names of pitches.</td>
</tr>
<tr>
<td>14. HEARS the melodic permutation, sings “la” while listening.</td>
</tr>
<tr>
<td>15. HEARS the permutation again, then plays it by ear in the given key.</td>
</tr>
<tr>
<td>16. PLAYS the melodic permutation along with the recording of the</td>
</tr>
<tr>
<td>accompaniment part (usually left hand).</td>
</tr>
<tr>
<td>(Follows steps 9-16 for the two remaining melodic permutations)</td>
</tr>
<tr>
<td>17. EXPLORES melodic ideas the length of the model excerpt; uses given</td>
</tr>
<tr>
<td>meter and key.</td>
</tr>
<tr>
<td>18. MENTALLY IMAGES a melodic permutation of his or her own using given</td>
</tr>
<tr>
<td>length, meter, key.</td>
</tr>
<tr>
<td>19. SINGS mentally-imaged melodic permutation on “la.”</td>
</tr>
<tr>
<td>20. PLAYS his or her melodic permutation on the piano, repeating until</td>
</tr>
<tr>
<td>it is “natural.”</td>
</tr>
<tr>
<td>21. PLAYS his or her melodic permutation along with the accompaniment</td>
</tr>
<tr>
<td>part played by the computer.</td>
</tr>
<tr>
<td>22. HEARS the accompaniment part (usually the left hand).</td>
</tr>
<tr>
<td>23. HEARS accompaniment part again and sings it on “la” (bottom notes</td>
</tr>
</tbody>
</table>
|     of broken chords; each note of blocked chords beginning
with the bottom note and ascending).
24. SINGS accompaniment part again using scale degree numbers.
25. HEARS the accompaniment again and mentally images the melody--how it blends with the accompaniment.
26. HEARS the first accompaniment permutation.
27. HEARS the accompaniment permutation again, tapping the rhythm while listening.
28. HEARS the accompaniment permutation again, then sings it on “la.”
29. PLAYS the accompaniment permutation by ear in the given key (Repeats steps 27-30 for accompaniment permutation two and three).
30. EXPLORES various accompaniment ideas (same length, meter, key as model excerpt).
31. MENTALLY IMAGES an accompaniment permutation of his or her own invention (same length, meter, key as model excerpt).
32. PLAYS his or her own accompaniment permutation along with the computer playing the melody part.
33. RECALLS his or her melodic permutation, connects it with the new accompaniment; plays permutation three times, hands together.
34. HEARS an acceptable permutation.
35. HEARS an unacceptable permutation.
36. RECALLS and plays his or her own permutation and records it.
37. EVALUATES his or her permutation using evaluative questions given.

completed. The student may choose a slower tempo for these tasks, and may select a slower tempo for the performance of the aural examples on the computer by clicking the mouse on the appropriate icon in the lower left corner of the display screen. The entire melody is played by the student without notation (Table 1, #8), with the expectation that the extensive listening will have provided an aural comprehension of the work. The student evaluates the playing of the entire melody.

The student listens to each of the melodic motifs--prescribed permutations or exercises, of sorts-- (Table 1, #9), and taps (with fingers on the edge of the
keyboard or on his or her lap) the rhythm of each permutation during and following listening (Table 1, #10). The purpose of tapping is to reinforce the student's understanding of the rhythmic patterns of the melodic motifs. The student evaluates the rhythmic patterns of the melodic motifs. If the student is unsure of the accuracy, he or she may listen to the motif again. With eyes closed, each melodic permutation is sung using "la" (Table 1, #11), then using scale degree numbers (Table 1, #12), and finally using letter names (Table 1, #13), followed by evaluation of each. The student listens again to each permutation, singing each one on "la" with eyes closed while listening (Table 1, #14). Then, the student plays each permutation from memory in the given key with the given starting note (Table 1, #15) followed by evaluation of the accuracy of the playing. The final step in assembling melodic ideas in the style of the model is to play the permutations along with the computer recording of the accompaniment (usually the left hand part) (Table 1, #16). This final step is then evaluated by the student (does the melodic permutation fit with the accompaniment part?). The goal of the above permutations is to assist the student in becoming familiar with melodic patterns in the given key and style at the keyboard through careful listening. The student evaluates his or her progress during and after each step in the instructional sequence as indicated. Steps 9-16 are repeated for melodic permutations two and three.

The focus then shifts to the accompaniment with the same pattern of student evaluation continuing throughout the sequence. The student listens to the accompaniment three times (Table 1, #22), singing it on "la" in a comfortable range the second time (Table 1, #23). The accompaniment is sung again using scale degree numbers (Table 1, #24), and then the letter names of notes (Table 1, #25). As the part is heard again, the student focuses on how the accompaniment
will “fit” with the melody. For example, diatonic, and particularly triadic tones of a melody will sound best played with triadic accompaniment—chords, arpeggios, and patterns.

The student next hears three left hand permutations (Table 1, #26)) and taps (on the edge of the keyboard or on his or her lap) (Table 1, #27), vocalizes (chants and sings) (Table 1, #28), and plays each permutation by ear in the given key (Table 1, #29). Next, the student explores various accompaniment ideas in order to develop his or her own permutation of the left hand accompaniment (Table 1, #30). Steps #27-30 are repeated for LH exercises two and three. The student then mentally images an accompaniment permutation of his or her own (Table 1, #31). Next, the student plays each left hand permutation along with the melody of the model excerpt, played by the aural track on the computer at a tempo chosen by the student (Table 1, #32). There is no time limit for this exercise. After exploring various ideas, the student plays his or her accompaniment permutation along with the computer recording of the melody “in the style of” the work.

The student then recalls his or her earlier invented melodic permutation or one as similar to it as possible, and connects it with the new accompaniment permutation, and practices the new permutation (using both hands) (Table 1, #33). The student hears an “acceptable permutation” played on the computer (following the established guidelines that pertain to the original musical model) (Table 1, #34), as well as an “unacceptable permutation” (one that clearly does not follow the established guidelines or components of the musical model) (Table 1, #35). The student then plays again his or her permutation (a practiced piece by this stage), and records it in his or her personal file (Table 1, #36); this allows the student (or the teacher) to return to it at any time. In the last stage of the curriculum, the student is directed to listen to this taped permutation and to
evaluate it (Table 1, #37). The student then uses this personal evaluation of the permutation as a means of understanding the original piece and compositional style more completely. The following questions serve to guide the student in evaluating the final permutation:

1) Does the permutation utilize accompaniment textures and chordal harmony similar to the original piece?

2) Is the permutation in the indicated key?

3) Is the permutation in the indicated meter?

4) Does the permutation utilize melodic material within the range of the original piece?

5) Does the permutation utilize the form or structural outline similar to that of the original piece?

6) Does the permutation employ articulations similar to those used within the original piece?

7) Are dynamics and other expressive nuances similar to those of the original piece?

8) Is the overall style of the permutation complementary with (and thus "in the style of") the model—the original piece? The student's permutation should be heard as a new musical piece, but one that is matched stylistically, through the use of similar components, to the original piece. Creativity is desired, but within the style indicated.

Although this piano permutations curriculum is oriented toward independent use by the student, the role of the piano instructor is important. The instructor may evaluate the permutations, and thus stimulate discussion on compositional style, piano technique, and creative expression. Based on the need to provide motivation for the student to continue to improve his or her musicianship, the teacher may offer positive commentary and also constructive ideas for improvement. If a student requires reinforcement of certain musical
components of the selected work before progressing ahead, the teacher may suggest repetition of selected steps in the instructional sequence. Students will be motivated to continue their attempts at inventing permutations of works studied, as they find fulfillment in the process and the products of their efforts. The role of the instructor is the provision of regular feedback as the student progresses toward the goal of creating new transformations that are “in the style of” the piano work.

**The Context of the Curriculum**

*Permutations of Standard Piano Works: A Curriculum for the Development of Student Musicianship* is intended for use with intermediate-level adult piano students in studio and class settings. It may be used as a supplement to the traditional curriculum for intermediate-level piano students, or may even replace more traditional instructional plans. Traditional class piano curriculum (for adult collegiate students) may include repertoire, melodies to accompany and transpose, sight-reading, technique, and rhythm exercises. This curriculum provides for some of those features (repertoire, technique, melodic and rhythmic exercises), while also offering the student the opportunity to engage in analytical and creative expression—thinking in the new inventions that are developed.

One potential use of the curriculum might be for independent study by the individual student. If the student has *Permutations of Standard Piano Works: A Curriculum for the Development of Student Musicianship*, owns or has access to a MIDI keyboard linked to a computer, and has obtained the aural component of this curriculum on disk, he or she may proceed on an independent course. In this case, the student would need to rely on self or peer (rather than teacher) evaluation in the learning process.

Another use of this curriculum is as a quarter or semester-long piano class, focusing on musicianship, which meets twice weekly for fifty or sixty minutes per
meeting. Typically, such a class might progress through this curriculum in five or six weeks, then reinforce the concepts through supplementary exercise in permutation (or even improvisation), or move on to other practical skills, technique, and repertoire for the remainder of the quarter or semester.

A third use of the curriculum might be within the context of the private studio lesson. One lesson each month might be devoted to this approach to learning to create permutations of piano works. Of course, the length of instructional use could be expanded or condensed, too. For example, the student (or student with teacher) might choose to spend more time on a selected piece for permutations, or a step within the sequence of the curriculum, with greater repetition and reinforcement as necessary. As well, the use of additional preparatory exercises can be considered, to underscore not only musical features but also the performance skills necessary to execute them.

**Characteristics of the Musical Examples**

Musical style characteristics which were identified in the selected piano literature in this curriculum included 1) texture; including homophony and harmonic chord progressions, 2) key, 3) rhythm, including meter, tempo durations, and rhythmic patterns, 4) melody, including pitch range, intervals used, melodic patterns, and ornamentation, 5) form; including structural outline of the excerpt as identified by phrase patterns, 6) articulation; including touches such as legato and staccato, slurs, and accents, 7) expressiveness and dynamics; including range of dynamics, pedal, and typical arched phrase shaping of various kinds. Tables 2-13, (pp. 73-84) provide a summary of these musical characteristics for each of the twelve pieces.

All of the selected piano works for this curriculum are within the range of lower to upper intermediate level in difficulty. All of the works are standard piano
teaching works. Two of the pieces are compositions from the Baroque era (1600-1750), four from the Classical (1750-1800), three from the Romantic (roughly 1800-1910) and three from the twentieth century (roughly 1910-present).

The selected pieces utilized simple meters and predominately durations of quarter and eighth. Dotted rhythms varied from use of dotted eighths, to dotted quarters, and dotted half notes. Tempos varied from fast to moderate. The variety of rhythm patterns utilized in the pieces is given in notation in Tables 2-13.

In melodic range, the pieces varied from a sixth to a twelfth. Intervals used were predominately seconds, thirds, fourths, and fifths. Melodic patterns used are shown in Tables 2-13. Ornamentation in the form of grace notes and melody harmonized in thirds was also utilized.

Of the musical textures, homophony or chordal harmony predominated. A variety of accompaniment patterns are found among the model pieces.

The structural outline or form of the excerpts were determined by groupings of phrases. The chordal harmony of the first part of each excerpt is notated in Tables 2-13.

Articulations ranged from legato in both hands parts, to legato in one part with staccato in the other. Expressiveness as used here includes dynamics, arched phrase shaping, and use of pedal. Dynamics ranged from piano to forte, with decresendos, accents, scherzandos, and diminuendos also utilized. Pedal markings were not indicated by the composers or the editors in these pieces, so it is left to the student, with the help of the teacher, to add pedal as needed. Of course the dynamic markings indicate different dynamic levels in the different musical eras, so the student will interpret them accordingly. For example, "forte" in baroque pieces may be less loud than "forte" in twentieth century pieces. Genres of pieces included in the curriculum are three lyric pieces, four folk dances, one march,
| **TITLE**       | *Sonatina in G Major, Romanze*  
|                | by Ludwig van Beethoven  
|                | (first eight measures)       |
| **TEXTURE**    | homophonic, broken chord     
|                | accompaniment                |
| **KEY**        | G Major                      |
| **RHYTHM**     | 6/8 meter, moderato, eighths and quarters |
| **MELODY**     | one octave range; 2nds, 3rds, 5ths, grace notes |
| **FORM**       | two 4-measure phrases        |
| **ARTICULATION** | legato                      |
| **EXPRESSIONNESS** | mezzo piano, typical arched phrase shaping |
| **TITLE** | *Evening at the Village*  
from Ten Easy Piano Pieces  
by Bela Bartok |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>TEXTURE</strong></td>
<td>homophonic; blocked chord accompaniment</td>
</tr>
<tr>
<td><strong>KEY</strong></td>
<td>e minor</td>
</tr>
<tr>
<td><strong>RHYTHM</strong></td>
<td>4/4 meter, 8ths, dotted quarters, half notes vivo non rubato, syncopation</td>
</tr>
<tr>
<td><strong>MELODY</strong></td>
<td>range of a 9th; 2nds, 3rds, 4ths, 5ths, pentatonic sound</td>
</tr>
<tr>
<td><strong>FORM</strong></td>
<td>two four-measure phrases, e minor to G major to C minor</td>
</tr>
<tr>
<td><strong>ARTICULATION</strong></td>
<td>staccato predominates</td>
</tr>
<tr>
<td><strong>EXPRESSIVENESS</strong></td>
<td>piano, scherzando, accents</td>
</tr>
<tr>
<td><strong>TITLE</strong></td>
<td><em>Soldiers' March, Op. 68, No. 2</em>  by Robert Schumann</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------</td>
</tr>
<tr>
<td><strong>TEXTURE</strong></td>
<td>chordal; harmonic chordal accompaniment duplicates the melodic rhythm three and four–note chords</td>
</tr>
<tr>
<td><strong>KEY</strong></td>
<td>G major</td>
</tr>
<tr>
<td><strong>RHYTHM</strong></td>
<td>2/4 meter, dotted eighths, sixteenths, eighths; allegro/steady march rhythm; dotted rhythm; eighth rests</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>MELODY</strong></td>
<td>octave range; 2nds, 3rds, 4ths</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>FORM</strong></td>
<td>two four–measure phrases; I to V</td>
</tr>
<tr>
<td><strong>ARTICULATION</strong></td>
<td>legato (dotted rhythm pattern), staccato predominates, slurs</td>
</tr>
<tr>
<td><strong>EXPRESSIVENESS</strong></td>
<td>forte; diminuendo, sforzando; typical arched phrases</td>
</tr>
</tbody>
</table>
| **TITLE** | *Rondo*  
by Wolfgang Amadeus Mozart |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>TEXTURE</strong></td>
<td>homophonic, tonic/dominant harmony</td>
</tr>
<tr>
<td><strong>KEY</strong></td>
<td>C major</td>
</tr>
</tbody>
</table>
| **RHYTHM** | 6/8 meter, allegro rhythmic patterns,  
dotted quarters, eighths, quarters  
| | |
| **MELODY** | range of a 12th; uses tonic and dominant  
triad tones in melody passing tones,  
grace notes, melodic patterns  
| | |
| **FORM** | two four-measure phrases (composed of  
groupings of two-measure phrases) |
| **ARTICULATION** | legato and staccato melody, legato  
accompaniment, accent |
| **EXPRESSIVENESS** | typical phrase shaping (p, cresc. mp-mf,  
decresc. p), soft |
<table>
<thead>
<tr>
<th><strong>TABLE 6</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>TITLE</strong></td>
</tr>
<tr>
<td><strong>TEXTURE</strong></td>
</tr>
<tr>
<td><strong>KEY</strong></td>
</tr>
<tr>
<td><strong>RHYTHM</strong></td>
</tr>
<tr>
<td><strong>MELODY</strong></td>
</tr>
<tr>
<td><strong>FORM</strong></td>
</tr>
<tr>
<td><strong>ARTICULATION</strong></td>
</tr>
<tr>
<td><strong>EXPRESSIVENESS</strong></td>
</tr>
<tr>
<td><strong>TABLE 7</strong></td>
</tr>
<tr>
<td>-----------------------</td>
</tr>
<tr>
<td><strong>TITLE</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>TEXTURE</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>KEY</strong></td>
</tr>
<tr>
<td><strong>RHYTHM</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>MELODY</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>FORM</strong></td>
</tr>
<tr>
<td><strong>ARTICULATION</strong></td>
</tr>
<tr>
<td><strong>EXPRESSIVENESS</strong></td>
</tr>
</tbody>
</table>
| **TITLE** | *Melody, Op. 68, No. 1*  
by Robert Schumann |
|-----------|--------------------------------------------------|
| **TEXTURE** | homophonic; two parts predominately;  
harmonic chord sequence from I to V |
| **KEY** | C major |
| **RHYTHM** | common time; moderato; quarters, eighths,  
dotted quarter, quarter rests |
| **MELODY** | range of a 9th; 2nds, 3rds, 4ths, 5ths, 6ths,  
melodic sequences, descending patterns |
| **FORM** | three two-measure groups, two one-measure  
groups, one two-measure group; phrase;  
| **ARTICULATION** | legato |
| **EXPRESSIVENESS** | piano; first two, two-measure phrases move  
from p to pp, mp to p; one-measure phrase  
decrescendos; final phrase decrescendos |
| TITLE       | *Quadrille*  
|            | by Joseph Haydn |
| TEXTURE    | homophonic; 3rds in R.H., single note  
|            | L.H. accompaniment predominates |
| KEY        | C major |
| RHYTHM     | 3/8 meter; con brio; eighths, quarters, repeated notes |
| MELODY     | one octave range; 3rds, 2nds, 5ths, 4ths, melodic 3rds, repeated notes |
| FORM       | two four-measure phrases; I, V, I |
| ARTICULATION | staccato and legato; slurs |
| EXPRESSIVENESS | mezzo piano; typical arched phrases |
### TABLE 10

| TITLE          | Bourree in D Minor  
|----------------| Attributed to J. S. Bach |
| TEXTURE        | homophonic, two-part |
| KEY            | D minor |
| RHYTHM         | 4/4 meter; allegro; quarters, eighths, half, dotted halves |
|                | [music notation] |
| MELODY          | range of a 10th; 4ths, 3rds, 2nds, 5ths; repeated notes |
|                | [music notation] |
| FORM            | two four-measure phrases; i to i, i to V |
| ARTICULATION   | legato |
| EXPRESSIVENESS  | measure 1–4; f to mf, measure 5–8: mf to f |
### TABLE 11

| **TITLE**             | *German Dance*  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>by Ludwig van Beethoven</td>
</tr>
<tr>
<td><strong>TEXTURE</strong></td>
<td>homophonic, R.H. melody, chordal and broken chord L.H. accompaniment</td>
</tr>
<tr>
<td><strong>KEY</strong></td>
<td>A Major</td>
</tr>
<tr>
<td><strong>RHYTHM</strong></td>
<td>3/4 meter; allegro; quarters, eighths</td>
</tr>
<tr>
<td></td>
<td>![Rhythm notation]</td>
</tr>
<tr>
<td><strong>MELODY</strong></td>
<td>range of a 9th; 6ths, 2nds, 3rds</td>
</tr>
<tr>
<td></td>
<td>![Melody notation]</td>
</tr>
<tr>
<td><strong>FORM</strong></td>
<td>four two-measure phrases</td>
</tr>
<tr>
<td><strong>ARTICULATION</strong></td>
<td>legato</td>
</tr>
<tr>
<td><strong>EXPRESSIVENESS</strong></td>
<td>piano</td>
</tr>
</tbody>
</table>
TABLE 12

<table>
<thead>
<tr>
<th>TITLE</th>
<th>Mazurka in F Major, Op 68, No. 3 by Frederic Chopin</th>
</tr>
</thead>
<tbody>
<tr>
<td>TEXTURE</td>
<td>chordal</td>
</tr>
<tr>
<td>KEY</td>
<td>F Major</td>
</tr>
<tr>
<td>RHYTHM</td>
<td>3/4 meter; allegro ma non troppo; dotted eighths, sixteenths, quarters, half notes; melodic rhythm determines the chordal accompaniment rhythm</td>
</tr>
<tr>
<td>MELODY</td>
<td>range of an 11th; 4ths, 2nds, 3rds</td>
</tr>
<tr>
<td>FORM</td>
<td>four two-measure phrases</td>
</tr>
<tr>
<td>ARTICULATION</td>
<td>legato</td>
</tr>
<tr>
<td>EXPRESSIVENESS</td>
<td>forte</td>
</tr>
<tr>
<td><strong>TITLE</strong></td>
<td>Toccata by Dmitri Kabalevsky</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td><strong>TEXTURE</strong></td>
<td>homophonic: L.H. melody; R.H. chordal accompaniment</td>
</tr>
<tr>
<td><strong>KEY</strong></td>
<td>A Minor</td>
</tr>
<tr>
<td><strong>RHYTHM</strong></td>
<td>2/4 meter; allegretto; eighth, dotted quarters, quarters</td>
</tr>
<tr>
<td><strong>MELODY</strong></td>
<td>range of a 9th; 4ths, 3rds, 2nds, 5ths; R.H. uses first inversion chords</td>
</tr>
<tr>
<td><strong>FORM</strong></td>
<td>six two-measure phrases</td>
</tr>
<tr>
<td><strong>ARTICULATION</strong></td>
<td>legato melody, staccato accompaniment</td>
</tr>
<tr>
<td><strong>EXPRESSIVENESS</strong></td>
<td>mezzo forte to forte melody, p to mp accompaniment</td>
</tr>
</tbody>
</table>
one baroque dance, two French dances, and one cantando piece.

Curricular Goals and Strategies

The goals of *Permutations of Standard Piano Works: A Curriculum for the Development of Student Musicianship* are intended to be accomplished through, and the contents shaped by, Vallance's curriculum theory and Comprehensive Musicianship. These goals give focus to the development of students' analytical listening skills with particular focus on their attention to melody, rhythm, chordal harmony and various accompaniment patterns. This curriculum enables students to become interactive with musical styles in selected piano works, through directed listening, performance, and creating permutations. Students vocalize melodies, melodic exercises, chord roots and pitches, and accompaniment patterns based on listening, with no notation present. The Curriculum is presented in its entirety in Chapter V.

Instructional strategies utilized in this curriculum, in a logical sequence, include 1) directed listening to whole musical works, excerpts, and permutations 2) vocalizing (singing and chanting), 3) playing excerpts, and permutations by ear 4) tapping rhythmic patterns, of excerpts and permutations, 5) exploring one's own ideas toward the development of a new permutation, (right, left, and hands together), 6) practicing melodic and rhythmic motifs and harmonic chord progressions, and 7) evaluating one's own permutation.

This curriculum is unique in its use of aurally-presented musical materials, and in its logical sequence of instructional activities. It uses current music technology (computer and MIDI keyboard at a "work station") to assist the student (and the teacher) to achieve the curriculum objective of learning to transform a work within prescribed parameters of style (and of a particular work), so that the invented permutation serves as a demonstration of a student's
understanding of the components of that musical style and work. In other words, the permutations embedded within the curriculum should motivate and clarify a pathway for the student's own musical expression, thus reflecting the growth of the student's musicianship.
Chapter V

Permutations of Standard Piano Works: A Curriculum for the Development of Student Musicianship

Teachers Manual

N.B. This chapter contains the printed manual for Permutations of Standard Piano Works: A Curriculum for the Development of Student Musicianship. The musical notation is printed as reference only for the reader, while in fact this music isaurally presented on the accompanying disks. Thus, in bold face are the explanations that “the Student Hears.” The actual student manual - without musical notation - is found in the Appendix, and one computer disk containing all aural examples is in the pocket inside the back cover of the dissertation.

The Curriculum

As an intermediate level piano student, you can improve your own basic musicianship, and your understanding of musical style and structure by the permutations (or variations, or transformations) you explore, and by the permutations of these works which you yourself invent. Permutations of Standard Piano Works: A Curriculum for the Development of Student Musicianship is designed to assist you in learning more thoroughly the components of standard piano works. It will assist you in listening analytically to musical structures of selected piano works, and to create new musical configurations of these works with confidence and personal satisfaction.

Much emphasis in piano instruction has been placed upon learning to read music. While learning to read music is necessary, it is the additional aim of this curriculum to emphasize aural learning. The twelve musical works, excerpts from these works, and permutations based on these works are presented aurally by the
computer. A MIDI keyboard generated sound track contains the musical works, excerpts, and exercises essential to the effectiveness of this curriculum. The MIDI keyboard will generate the sound through the computer of the musical excerpts to be used in this curriculum. When you hear the excerpts, you will be invited to listen, vocalize, play, and to invent new musical ideas based upon the music that is presented aurally. Each time you respond by singing or playing, you will evaluate your response: Was your response similar to the given melodic motif or accompaniment pattern? Was it exactly the same as the given model? If not, try again until you succeed in imitating the model as closely as possible.

One permutation for each work will be saved on a computer in a personal folder as you progress through this curriculum. A “work station” at which you will be located while pursuing this consists of 1) a MIDI keyboard, attached to 2) a Macintosh computer, connected by 3) MIDI cables and a MIDI interface. With sequencing software, the computer records and plays back your final permutations created from the MIDI keyboard. (See Figure 1)

Permutations of Standard Piano Works: A Curriculum for the Development of Student Musicianship will make its greatest impact when you monitor your own work, as your self-evaluation is an integral part of the curriculum. The emphasis of this experience is on increasing your musical skills and understanding through the process of listening, performing, and creating.

The following definitions of terms will help you in your progress through the curriculum:

**Improvisation:** The musical by-product of a creative process attributed to the individual who can generate a new sound within the framework of a given musical style. It requires that the performer know the rules of the musical tradition, genre, or even particular work. Improvisation has been variously
defined, and encompasses a spectrum from expressive re-creation of the music to a reconfiguration of musical components—hence, a new musical work. **Intermediate level:** To assume that the student has aural/listening skills, basic technical skills, and basic music reading skills, acquired through three to five years of piano instruction; to assume that the student can sightread with ease at a level below the regular repertoire performance level, and can perform literature musically within a given style, and can analyze and determine the form and structure of literature studied. Intermediate level competencies include the ability to: 1) Sight-read repertoire and accompaniments beyond the elementary level, 2) Transpose repertoire and simple accompaniments to closely related keys, 3) Play chord progressions using secondary chords and secondary dominants in major and minor keys, 4) Harmonize melodies with secondary chords and secondary dominants using simple accompaniment style and, 5) Create second parts to solo piano repertoire based on analysis of theoretical concepts. All of the preceding should be related to the students’ study of theory, technique, and repertoire (Uszler et al., 1991).

**Mentally image:** To form a mental representation or picture of a musical idea (not necessarily a mental representation or picture of the score).

**Permutation:** Variation, or a limited transformation of the melody and accompaniment patterns of standard piano works in which certain pitches or rhythms are changed while still retaining the “spirit” and character of the piece. In a spectrum of creative musical thinking, permutation is at a distant point from free improvisation, in that the principal musical components restrict the performer from developing beyond the structures provided. Permutation within the curriculum aid the student’s comprehension of the musical style and structure of a work. It is both an instructional strategy for understanding the work—an end in
itself, and a personal expression and playful interpretation of the work.

**Play by ear:** To play the piano without reference to notation, using the ear as the guide; this is not the same as playing a piece by memory.

**Style:** The musical choices that a composer or performer makes from among the possibilities available (Randel, 1986). It may refer to features that characterize the works of an individual composer, or it may also distinguish an individual work from other works by the same composer.

One end-product of *Permutations of Standard Piano Works: A Curriculum for the Development of Student Musicianship* is to invent a parallel musical work in the style of the model. You should follow these guideline questions as closely as possible, in order that your own musical permutation can be a careful balance of the features of the model piece with your own expressive possibilities.

- a) Does the permutation utilize similar textures and chordal harmony to those used in the model piece?
- b) Is the permutation in the meter of the original model?
- c) Is the permutation in the key of the original model?
- d) Does the permutation utilize rhythmic characteristics which are evident in the given piano piece?
- e) Does the permutation utilize melodic characteristics present in the model?
- f) Does the permutation utilize a similar structural outline to that of the model?
- g) Are the articulations used within the range used in the model?
- h) Are the dynamics used within the range indicated in the model?
- i) Is the overall style of the permutation similar to that of the model?
- j) Does the permutation generate a new sound within the guidelines?
- k) Does it utilize new musical ideas not found in the musical model?

A reminder: See Figure 1 for a graphic of the “MIDI Workstation” indicating the equipment you will be using for progressing through this curriculum (computer, computer display, computer keyboard, mouse, MIDI keyboard). See Figure 2 for a
graphic of the computer display which you will use for listening and recording.

**Technicalities: How to use this Manual**

The instructional strategies employed within this curriculum match the critical musical goals of analytical listening and creative and expressive development of structural features of the selected piano literature. The same instructional sequence is used throughout the curriculum, for all twelve musical works. As you follow the printed instructions, listen carefully to the aural examples, and trial exercises and new musical inventions. Throughout this curriculum you will be instructed to listen to several examples leading to a recording of your own permutation. The following steps will allow you to “listen” to an example (or listen while playing):

a) Open the folder with your name by double-clicking it.

b) Look for the Beethoven 1 folder and open it. Now, open the name of the file you want to hear (e.g. Ex 1, Ex 2)

c) When it opens, look toward the bottom of the display and notice the recording controls (see Figure 2).

d) Click the Play control the (the arrow in the middle) and the music will sound

e) To replay, click the arrow again. You may wish to replay examples more times than indicated. The number given is the minimum number to be played.

f) When finished, click and hold on the File menu at the top left of your display. Now, scroll down to Quit and release the mouse button. You are finished.

The following steps will allow you to record your permutation:

a) Open the folder with your name by double-clicking it.

b) Look for the appropriate composer's folder, then open the file labeled Improvisation and double-click it

c) Think about what you are going to play. When you are
ready, look at the standard recording controls at the bottom of the computer display.
d) Click the recording control (circle) and start playing. (If, at any time you want to start over, click and hold on the Edit menu. Scroll down to Erase and release the button.
e) When you are finished, click the stop control (square).
f) For playback, click the single arrow to your right.
g) To save your work, click and hold on the File menu at the top of your display. Now, scroll down to Save and release the mouse button.
h) When you have saved your file, scroll down and release the button on Quit under the same menu. You are finished.

You may now proceed to the curriculum.
Unit 1

As you follow the printed instructions, listen carefully to the aural examples, and trial exercises and new musical inventions.

1. Listen to the entire piano work, Romanze from Sonatina in G Major, by Ludwig van Beethoven. In your folder in the computer, open the Beethoven 1 folder. Now, open the file labeled Romanze and follow the above steps for listening to this example.

THE STUDENT HEARS
*Notation given here is not physically present within the student manual; it serves only as a guide for the reader as to the music that is aurally presented via the MIDI keyboard-generated soundtrack.

**Right Hand Only: Melodic Permutation in the Right Hand (R.H.)**

2. Listen to the excerpt of the piano work, played hands together: In your folder in the computer, open the Beethoven 1 folder. Now, open the file labeled Example 1.
   a) Click the Play control (the arrow to your right).
   b) To replay, click the arrow again.
   c) When finished, click and hold on the File menu at the top left of your display. Now, scroll down to Quit and release the mouse button. You are finished.

Example 1 (first eight measures).

**THE STUDENT HEARS**

3. Listen again a second time; focus on the melody in the right hand.

**THE STUDENT HEARS**
4. Listen to the R.H. melody played alone three times: In your folder in the computer, open the Beethoven 1 folder. Now, open the file labeled Example 2.
   a) Click the Play control (the arrow to your right).
   b) To replay, click the arrow again.
   c) When finished, click and hold on the File menu at the top left of your display. Now, scroll down to Quit and release the mouse button. You are finished.

Example 2 (first eight measures).

THE STUDENT HEARS

\[\text{Example 2}\]

5. With eyes closed, sing the melody in G Major in a comfortable octave range using “la”; start on b, the third degree of the scale, and slowly continue through the melody.

THE STUDENT SINGS

6. Sing the melody again at a slow tempo using scale degree numbers; start on “3”, in the key of G, the third degree of the scale, and slowly continue through the melody.

THE STUDENT SINGS

7. Listen to the melody of the piano work again at a slow tempo; sing the letter names of the pitches while listening.

THE STUDENT HEARS AND SINGS

\[\text{Example 2}\]
8. Play the entire melody by ear on the piano in the key indicated, starting on b, the third degree of the G Major scale, above middle C.


9. Listen to each of the melodic permutations for the right hand three times; they are each given aurally on the sound track. They include scale, five-finger, and other permutations typically found in Beethoven’s piano music: In your folder in the computer, open the Beethoven 1 folder. Now, open the file labeled Example 3.

a) Click the Play control (the arrow to your right).
b) To replay, click the arrow again.
c) When finished, click and hold on the File menu at the top left of your display. Now, scroll down to Quit and release the mouse button. You are finished.

Repeat this process for Examples 4 and 5.

Examples 3–5.

THE STUDENT HEARS

Example 3

Example 4

Example 5
10. Listen again and tap the rhythm of each melodic permutation, not the pulse, as you listen. You will hear a rhythmic cue to help you know when to begin. Tap the rhythm of each permutation again after you have finished listening: Examples 3–5.

THE STUDENT HEARS AND TAPS, AND THEN TAPS AGAIN

11. With eyes closed, listen to the melodic permutation again and then sing it on “la”; repeat for each of the melodic permutations: Examples 3–5.

THE STUDENT HEARS AND SINGS

12. Listen and sing each melodic permutation again, this time using scale degree numbers: For Examples 3–5, the scale degree numbers of the starting pitches are as follows:
   Example 3: (second d above middle C)
   Example 4: (d above middle C)
   Example 5: (second d above middle C)

THE STUDENT HEARS AND THEN SINGS

13. Listen and then sing each permutation again, using letter names of pitches. The letter names of starting pitches are as follows:
   Example 3: (second d above middle C)
   Example 4: (d above middle C)
   Example 5: (second d above middle C)

THE STUDENT HEARS AND THEN SINGS

14. Listen again to each melodic permutation, singing on “la” Example 3–5.

THE STUDENT SINGS WHILE LISTENING
15. Listen and then play each melodic permutation by ear in the given key of G Major with the given starting note, using R.H. For Examples 3–5 the letter names of starting pitches are as follows:
Example 3: (second d above middle C)
Example 4: (d above middle C)
Example 5: (second d above middle C)

THE STUDENT HEARS THEN PLAYS

16. Play each melodic permutation by ear again along with the recording of the Left Hand (L.H.). The letter name of the starting pitch is:
Example 3: d (second d above middle C)
Example 4: d (d above middle C)
Example 5: d (second d above middle C)

THE STUDENT PLAYS WHILE LISTENING

17. Explore various melodic ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key.

18. Mentally image ("think") a melodic permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

19. Sing your mentally-imaged melodic permutation on "la".

20. Sing your melodic permutation again, using letter names of pitches.

21. Play your melodic permutation on the piano with your R.H. Continue to play until you are quite certain of it – until it is "natural" for you.
22. Play your R.H. melodic permutation along with the L.H. part that is played by
the computer. In your folder in the computer, open the Beethoven 1 folder.
Now, open the file labeled Example 6.
   a) Click the Play control (the arrow to your right).
   b) To replay, click the arrow again.
   c) When finished, click and hold on the File menu at the
top left of your display. Now, scroll down to Quit and
release the mouse button. You are finished.

Example 6.

THE STUDENT PLAYS WHILE LISTENING

Example 6

Left Hand Only: Accompaniment Permutation in the Left Hand (L.H.)


THE STUDENT HEARS

Example 6

24. Listen to the L.H. accompaniment again and sing it on "la" in a comfortable
range; sing the bottom notes of the broken chords (the bass notes that sound on
the pulse).

THE STUDENT HEARS

Example 6
25. Sing the bottom notes of the broken chords again using scale degree numbers; start on number 1, the first degree of the scale. Sing the bottom notes of the broken chords again using letter names of pitches; start on G.

**THE STUDENT SINGS**

26. As you listen a third time, mentally image the melody. Notice the harmony of the L.H. accompaniment as it blends with the melody you are mentally imaging. Typical of the style, melody pitches usually sound best with those pitches within the chords of the accompaniment.

**THE STUDENT HEARS**

<table>
<thead>
<tr>
<th>Example 6</th>
</tr>
</thead>
</table>


27. Listen to each of the L.H. permutations. In your folder in the computer, open the Beethoven 1 folder. Now, open the file labeled Example 7.
   a) Click the Play control (the arrow to your right).
   b) To replay, click the arrow again.
   c) When finished, click and hold on the File menu at the top left of your display. Now, scroll down to Quit and release the mouse button. You are finished.

Repeat this process for Examples 8 and 9.

Exercises 7–9.

**THE STUDENT HEARS**

| Example 7 |
28. Listen to each accompaniment permutation again and tap the rhythm of each with your L.H. as you listen. Tap the rhythm of each exercise after you have finished listening.

THE STUDENT HEARS AND TAPS

29. Listen again to the L.H. accompaniment permutations, then sing the three pitches in the broken chords in a comfortable vocal range on “la”. Sing both pitches of the blocked chords, ascending from the bottom pitch upwards. The letter names of the starting pitches are:
Example 7: G (first G below middle C)
Example 8: G (first G below middle C)
Example 9: G (first G below middle C)

THE STUDENT SINGS WHILE LISTENING

30. Play each L.H. permutation by ear in the key of G. The letter names of the starting pitches are:
Example 7: G (first G below middle C)
Example 8: G (first G below middle C)
Example 9: G (first G below middle C)

31. Explore various accompaniment permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key. Remember that the goal is to create a permutation “in the style of” the master composer’s work.
32. Mentally image ("think") an accompaniment permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

33. Try playing your own left hand improvised accompaniment permutation along with the computer playing the R.H. part. In your folder in the computer, open the Beethoven 1 folder. Now, open the file labeled 10.
   a) Click the Play control (the arrow to your right).
   b) To replay, click the arrow again.
   c) When finished, click and hold on the File menu at the top left of your display. Now, scroll down to Quit and release the mouse button. You are finished.

Example 10.

THE STUDENT LISTENS AND PLAYS

Example 10

Hands Together Instructional Strategies

34. Recall your invented melodic permutation, and connect it with your new accompaniment permutation. Play your permutation, hands together, three times. Listen carefully and evaluate how well the melodic permutation and the accompaniment permutation fit together.

35. Listen to the following acceptable permutation. In your folder in the computer, open the Beethoven 1 folder. Now, open the file labeled Example 11.
   a) Click the Play control (the arrow to your right).
   b) To replay, click the arrow again.
   c) When finished, click and hold on the File menu at the top left of your display. Now, scroll down to Quit and release the mouse button. You are finished.

Example 11.

THE STUDENT HEARS
The permutation is acceptable because it uses rhythmic, melodic and textural components similar to those used in the model (e.g., it uses the same chordal harmony as the model, it is in the same meter and key as the model, it utilizes some of the rhythmic and melodic characteristics of the model, it uses a similar structural outline to that of the model, the articulations and dynamics are within the range used in the model, the overall style is similar to that of the model, it generates a new sound within the guidelines, and utilizes new musical ideas not found in the musical model).

36. Listen to the following unacceptable permutation. In your folder in the computer, open the Beethoven 1 folder. Now, open the file labeled Example 12.  
   a) Click the Play control (the arrow to your right).  
   b) To replay, click the arrow again.  
   c) When finished, click and hold on the File menu at the top left of your display. Now, scroll down to Quit and release the mouse button. You are finished.

Example 12.

THE STUDENT HEARS

The permutation is unacceptable because it does not use rhythmic, melodic and textural components similar to those used in the model (e.g., it does not use the chordal harmony or textures of the model, it does not utilize rhythmic and melodic characteristics used in the model, it does not use articulations or dynamics used in the model, it generates a new sound, but not within the guidelines).
37. Now, recall and play your permutation hands together and record it in your file. Start by finding your folder (it will have your name on it) and proceed as follows:
   a) Open the folder with your name by double-clicking it.
   b) Look for folder labeled Improvisation and double-click it.
   c) Open the file labeled #1. When you are ready to record, look at the recording symbols at the bottom of the display.
   d) Click the recording control (circle) and start playing. (If, at any time you want to start over, click and hold on the Edit menu. Scroll down to Erase and release the button.
   e) When you are finished, click the stop control (square).
   f) For playback, click the single arrow to your right.
   g) To save your work, click and hold on the File menu at the top of your display. Now, scroll down to Save and release the mouse button.
   h) When you have saved your file, scroll down and release the button on Quit under the same menu. You are finished.

38. Listen to your permutation and evaluate it using the following questions:
   a) Does the permutation utilize similar textures and chordal harmony to those used in the model piece?
   b) Is the permutation in the meter of the original model?
   c) Is the permutation in the key of the original model?
   d) Does the permutation utilize rhythmic characteristics which are evident in the given piano piece? (e.g., tempo)
   e) Does the permutation utilize melodic characteristics present in the model?
   f) Does the permutation utilize a similar structural outline to that of the model?
   g) Are the articulations used within the range used in the model?
   h) Are the dynamics used within the range indicated in the model?
   i) Is the overall style of the permutation similar to that of the model?
   j) Does the permutation generate a new sound within the guidelines? Does it utilize new musical ideas not found in the musical model?

39. Use your evaluation (and your teacher’s response to your efforts here) to help you with your next permutation assignment.
As you follow the printed instructions, listen carefully to the aural examples, and trial exercises and new musical inventions.

1. Listen to the entire piano work, *Evening at the Village* from Ten Easy Piano Pieces, by Béla Bartók. In your folder in the computer, open the Bartók 1 folder. Now, open the file labeled Evening at the Village.
Right Hand Only: Melodic Permutation in the Right Hand (R.H.)

2. Listen to the excerpt of the piano work, played hands together: In your folder in the computer, open the Bartók 1 folder. Now, open the file labeled Example 1.

Example 1 (first ten measures).

THE STUDENT HEARS

Example 1

3. Listen again a second time; focus on the melody in the right hand.

THE STUDENT HEARS

Example 1
4. Listen to the R.H. melody played alone three times: In your folder in the computer, open the Bartók 1 folder. Now, open the file labeled Example 2.

Example 2 (first ten measures).

**THE STUDENT HEARS**

5. With eyes closed, sing the melody in a comfortable vocal range on “la”; start on d, the seventh degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**

6. Sing the melody again using scale degree numbers; start on “7”, in the key of e minor, the seventh degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**

7. Listen to the melody of the piano work again; sing the letter names of pitches while listening.

**THE STUDENT HEARS**
8. Play the entire melody by ear on the piano in the key indicated, starting on d, the seventh degree of the e minor scale, above middle C.


9. Listen to each of the melodic permutations for the right hand three times; they are each given aurally on the sound track. They include scale, five–finger, and other permutations typically found in Bartók’s piano music: In your folder in the computer, open the Bartók 1 folder. Now, open the file labeled Example 3. Repeat this process for Examples 4 and 5.

Examples 3–5.

THE STUDENT HEARS

Example 3

Example 4

Example 5
10. Listen to each permutation again and tap the rhythm of each as you listen. Tap the rhythm of each permutation again after you have finished listening: Examples 3–5.

THE STUDENT HEARS AND TAPS, AND THEN TAPS AGAIN

11. With eyes closed, listen to the melodic permutation again and then sing it on “la”; repeat for each of the melodic permutations: Examples 3–5.

THE STUDENT HEARS AND SINGS

12. Listen and sing each melodic permutation again, this time using scale degree numbers: For Examples 3–5, the scale degree numbers of the starting pitches are as follows:
   Example 3: 1 (second e above middle C)
   Example 4: 3 (g above middle C)
   Example 5: 1 (second e above middle C)

THE STUDENT HEARS AND THEN SINGS

13. Listen and then sing each permutation again, using letter names of pitches. The letter names of starting pitches are as follows:

   Example 3: (second e above middle C)
   Example 4: (g above middle C)
   Example 5: (second e above middle C)

THE STUDENT HEARS AND THEN SINGS

14. Listen again to each melodic permutation, singing on “la” as you listen: Examples 3–5.

THE STUDENT SINGS WHILE LISTENING
15. Listen and then play each melodic permutation by ear in the given key of e minor with the given starting note, using R.H. For Examples 3–5 the letter names of starting pitches are as follows:
   Example 3:  (second e above middle C)
   Example 4:  (g above middle C)
   Example 5:  (second e above middle C)

THE STUDENT HEARS THEN PLAYS

16. Play each melodic permutation by ear again along with the recording of the Left Hand (L.H.). The letter name of the starting pitch is:
   Example 3:  (second e above middle C)
   Example 4:  (g above middle C)
   Example 5:  (second e above middle C)

THE STUDENT PLAYS WHILE LISTENING

17. Explore various melodic permutation ideas, ten measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key.

18. Mentally image ("think") a melodic permutation of your own, one that is ten measures in length, in the same meter and key as the musical model.

19. Sing your mentally-imaged melodic permutation on "la".

20. Sing your melodic permutation again, using letter names of pitches.

21. Play your melodic permutation on the piano with your R.H. Continue to play until you are quite certain of it – until it is "natural" for you.
22. Play your R.H. melodic permutation along with the L.H. part that is played by the computer. In your folder in the computer, open the Bartók 1 folder. Now, open the file labeled Example 6.

Example 6.

**THE STUDENT PLAYS WHILE LISTENING**

![Example 6](image)

**Left Hand Only: Accompaniment Permutation in the Left Hand (L.H.)**


**THE STUDENT HEARS**

![Example 6](image)

24. Listen to the L.H. accompaniment again and sing it on “la” in a comfortable range; sing all the notes in the L.H. chords, beginning with the bottom note.

**THE STUDENT HEARS**

![Example 6](image)
25. Sing the L.H. accompaniment again using scale degree numbers; start on number 1, the first degree of the scale. Sing all the notes in the L.H. chords beginning with the bottom note, again using letter names of pitches; start on e below middle C.

THE STUDENT SINGS

26. As you listen a third time, mentally image the melody. Notice the harmony of the L.H. accompaniment as it blends with the melody you are mentally imaging. Typical of the style, melody pitches usually sound best with those pitches within the chords of the accompaniment.

THE STUDENT HEARS

Example 6


27. Listen to each of the L.H. permutations. In your folder in the computer, open the Bartók 1 folder. Now, open the file labeled Example 7. Repeat this process for Examples 8 and 9.

Exercises 7–9.

THE STUDENT HEARS

Example 7

Example 8
28. Listen to each accompaniment permutation again and tap the rhythm of each with your L.H. as you listen. Tap the rhythm of each permutation after you have finished listening.

THE STUDENT HEARS AND TAPS

29. Listen again to the accompaniment permutation, then sing it in a comfortable vocal range on “la”. Sing all pitches of the blocked chords, ascending from the bottom pitch upwards. The letter names of the starting pitches are:
   Example 7: E (first E below middle C)
   Example 8: E (first E below middle C)
   Example 9: E (first E below middle C)

THE STUDENT SINGS WHILE LISTENING

30. Play each L.H. permutation by ear in the key of e minor. The letter names of the starting pitches are:
   Example 7: E (first E below middle C)
   Example 8: E (first E below middle C)
   Example 9: E Chord (first E below middle C)

31. Explore various accompaniment permutation ideas, ten measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key. Remember that the goal is to create a permutation “in the style of” the master composer’s work.

32. Mentally image (“think”) an accompaniment permutation of your own, one that is ten measures in length, in the same meter and key as the musical model.
33. Try playing your own left hand accompaniment permutation along with the computer playing the R.H. part. In your folder in the computer, open the Bartók 1 folder. Now, open the file labeled Example 10.

Example 10.

THE STUDENT LISTENS AND PLAYS

Hands Together Instructional Strategies

34. Recall your invented melodic permutation, and connect it with your new accompaniment permutation. Play your permutation, hands together, three times. Listen carefully and evaluate how well the melodic permutation and the accompaniment permutation fit together.

35. Listen to the following acceptable permutation. In your folder in the computer, open the Bartók 1 folder. Now, open the file labeled Example 11.

Example 11.

THE STUDENT HEARS

The permutation is acceptable because it uses the rhythmic, melodic and textural components similar to those used in the model. (e.g. it uses the same texture and chordal harmony as the model, it is the same meter and key as the model, it uses some of the rhythmic and melodic characteristics of the model, it uses a similar
structural outline to that of the model, the articulations and dynamics are within
the range used in the model, the overall style is similar to that of the model, it
generates a new sound within the guidelines, and utilizes new musical ideas not
found in the musical mode).

36. Listen to the following unacceptable permutation. In your folder in the
computer, open the Bartók 1 folder. Now, open the file labeled Example 12.

Example 12.

THE STUDENT HEARS

Example 12

The permutation is unacceptable because it does not use rhythmic, melodic
and textural components similar to those used in the model (e.g., it does not
use the chordal harmony or textures of the model, it does not utilize rhythmic
and melodic characteristics used in the model, it does not use articulations
or dynamics used in the model, it generates a new sound, but not within
the guidelines).

37. Now, recall and play your permutation hands together and record it
in your file. Start by finding your folder (it will have your name on it) and
proceed as follows:

a) Open the folder with your name by double-clicking it.
b) Look for folder labeled Improvisation and double-click it.
c) Open the file labeled #1. When you are ready to record,
look at the recording symbols at the bottom of the display.
d) Click the recording control (circle) and start playing. (If,
at any time you want to start over, click and hold on the
Edit menu. Scroll down to Erase and release the button.
e) When you are finished, click the stop control (square).
f) For playback, click the single arrow to your right.
g) To save your work, click and hold on the File menu at the top of your display. Now, scroll down to Save and release the mouse button.

h) When you have saved your file, scroll down and release the button on Quit under the same menu. You are finished.

38. Listen to your permutation and evaluate it using the following questions:
   a) Does the permutation utilize similar textures and chordal harmony to those used in the model piece?
   b) Is the permutation in the meter of the original model?
   c) Is the permutation in the key of the original model?
   d) Does the permutation utilize rhythmic characteristics which are evident in the given piano piece?
   e) Does the permutation utilize melodic characteristics present in the model?
   f) Does the permutation utilize a similar structural outline to that of the model?
   g) Are the articulations used within the range used in the model?
   h) Are the dynamics used within the range indicated in the model?
   i) Is the overall style of the permutation similar to that of the model?
   j) Does the permutation generate a new sound within the guidelines? Does it utilize new musical ideas not found in the musical model?

39. Use your evaluation (and your teacher's response to your efforts here) to inform your next permutation assignment.
Unit 3

As you follow the printed instructions, listen carefully to the aural examples, and trial exercises and new musical inventions.

1. Listen to the entire piano work, *Soldier’s March*, by Robert Schumann. In your folder in the computer, open the Schumann 1 folder. Now, open the file labeled Soldier’s March and listen to the example.

**THE STUDENT HEARS**

![Musical notation]

**Right Hand Only: Melodic Permutation in the Right Hand (R.H.)**

2. Listen to the excerpt of the piano work, played hands together: In your folder in the computer, open the Schumann 1 folder. Now, open the file labeled Example 1.

Example 1 (first eight measures).

**THE STUDENT HEARS**
3. Listen again a second time; focus on the melody in the right hand.

THE STUDENT HEARS

4. Listen to the R.H. melody (top note in chord) played alone three times: In your folder in the computer, open the Schumann 1 folder. Now, open the file labeled Example 2.

Example 2 (first eight measures).

THE STUDENT HEARS

5. With eyes closed, sing the melody in a comfortable vocal range on “la”; start on b, the third degree of the scale, and slowly continue through the melody.

THE STUDENT SINGS
6. Sing the melody again using scale degree numbers; start on 3, in the key of G Major, the third degree of the scale, and slowly continue through the melody.

THE STUDENT SINGS

7. Listen to the melody of the piano work again; sing the letter names of pitches while listening.

THE STUDENT HEARS

Example 2

8. Play the entire melody by ear on the piano in the key indicated, starting on b, the third degree of the G Major scale, first b above middle C.


9. Listen to each of the melodic permutations for the right hand three times; they are each given aurally on the sound track. They include scale, five-finger, and other permutations typically found in Schumann’s piano music: In your folder in the computer, open the Schumann 1 folder. Now, open the file labeled Example 3. Repeat this process for Examples 4 and 5.

Examples 3–5.

THE STUDENT HEARS

Example 3
10. Listen to each permutation again and tap the rhythm of each as you listen. Tap the rhythm of each permutation again after you have finished listening: Examples 3–5.

THE STUDENT HEARS AND TAPS, AND THEN TAPS AGAIN

11. With eyes closed, listen to the melodic permutation again and then sing it on "la"; repeat for each of the melodic permutation: Examples 3–5.

THE STUDENT HEARS AND SINGS

12. Listen and sing each melodic permutation again, this time using scale degree numbers: For Examples 3–5, the scale degree numbers of the starting pitches are as follows:
   Example 3: 3  (first b above middle C)
   Example 4: d'  (second d above middle C)
   Example 5: g  (first g above middle C)

THE STUDENT HEARS AND THEN SINGS

13. Listen and then sing each permutation again, using letter names of pitches. The letter names of starting pitches are as follows:
Example 3:  (b above middle C)
Example 4:  (second d above middle C)
Example 5:  (first g above middle C)

THE STUDENT HEARS AND THEN SINGS

14. Listen again to each melodic permutation, singing on “la” as you listen:
   Example 3–5.

THE STUDENT SINGS WHILE LISTENING

15. Listen and then play each melodic permutation by ear in the given key of G
    Major with the given starting note, using R.H. For Examples 3–5 the letter names
    of starting pitches are as follows:
    Example 3:  (b above middle C)
    Example 4:  (second d above middle C)
    Example 5:  (first g above middle C)

THE STUDENT HEARS THEN PLAYS

16. Play each melodic permutation by ear again along with the recording of the
    Left Hand (L.H.). The letter name of the starting pitch is:
    Example 3:  (first d above middle C)
    Example 4:  (first B above middle C)
    Example 5:  (first d above middle C)

THE STUDENT PLAYS WHILE LISTENING

17. Explore various melodic permutation ideas, eight measures in length, on the
    piano until you are satisfied with the results. Stay within the given meter and key.

18. Mentally image (“think”) a melodic permutation of your own, one that is eight
    measures in length, in the same meter and key as the musical model.
19. Sing your mentally-imaged melodic permutation on “la”.

20. Sing your melodic permutation again, using letter names of pitches.

21. Play your melodic permutation on the piano with your R.H. Continue to play until you are quite certain of it – until it is “natural” for you.

22. Play your R.H. melodic permutation along with the L.H. that is played by the computer. In your folder in the computer, open the Schumann 1 folder. Now, open the file labeled Example 6.

Example 6.

THE STUDENT PLAYS WHILE LISTENING

Example 6

Left Hand Only: Accompaniment Permutation in the Left Hand (L.H.)


THE STUDENT HEARS

Example 6

24. Listen to the L.H. accompaniment again and sing it on “la” in a comfortable range; sing all the notes in the L.H. chords beginning with the bottom note.

THE STUDENT HEARS
25. Sing the L.H. accompaniment again using scale degree numbers; start on number 1, the first degree of the scale. Sing all notes in the L.H. chord beginning with the bottom note using letter names of pitches; start on G below middle C.

THE STUDENT SINGS

26. As you listen a third time, mentally image the melody. Notice the harmony of the L.H. accompaniment as it blends with the melody you are mentally imaging. Typical of the style, melody pitches usually sound best with those pitches within the chords of the accompaniment.

THE STUDENT HEARS


27. Listen to each of the L.H. permutations. In your folder in the computer, open the Schumann 1 folder. Now, open the file labeled Example 7. Repeat this process for Examples 8 and 9.

Exercises 7–9.

THE STUDENT HEARS
Example 8

Example 9

28. Listen to each accompaniment permutation again and tap the rhythm of each with your L.H. as you listen. Tap the rhythm of each permutation after you have finished listening.

THE STUDENT HEARS AND TAPS

29. Listen again to the accompaniment permutation, then sing it in a comfortable vocal range on “la”. Sing all pitches of the blocked chords, ascending from the bottom pitch upwards. The letter names of the starting pitches are:
Example 7: d (first d above middle C)
Example 8: B (first B below middle C)
Example 9: d (first d above middle C)

THE STUDENT SINGS WHILE LISTENING

30. Play each L.H. permutation by ear in the key of G Major. The letter names of the starting pitches are:
Example 7: d (first d above middle C)
Example 8: B (first B below middle C)
Example 9: d (first d above middle C)

31. Explore various accompaniment permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key. Remember that the goal is to create a permutation “in the style of” the master composer’s work.
32. Mentally image ("think") an accompaniment permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

33. Try playing your own left hand accompaniment permutation along with the computer playing the R.H. part. In your folder in the computer, open the Schumann 1 folder. Now, open the file labeled Example 10.

Example 10.

THE STUDENT LISTENS AND PLAYS

Hands Together Instructional Strategies

34. Recall your invented melodic permutation, and connect it with your new accompaniment permutation. Play your permutation, hands together, three times. Listen carefully and evaluate how well the melodic permutation and the accompaniment permutation fit together.

35. Listen to the following acceptable permutation. In your folder in the computer, open the Schumann 1 folder. Now, open the file labeled labeled Example 11.

Example 11.

THE STUDENT HEARS
The permutation is acceptable because it uses rhythmic, melodic and textural components similar to those used in the model (e.g., it uses the same texture and chordal harmony as the model, it is in the same meter and key as the model, it utilizes some of the rhythmic and melodic characteristics of the model, it uses a similar structural outline to that of the model, the articulations and dynamics are within the range used in the model, the overall style is similar to that of the model, it generates a new sound within the guidelines, and utilizes new musical ideas not found in the musical model).

36. Listen to the following unacceptable permutation. In your folder in the computer, open the Schumann 1 folder. Now, open the file labeled Example 12.

Example 12.

THE STUDENT HEARS

![Example 12](image)

The permutation is unacceptable because it does not use rhythmic, melodic and textural components similar to those used in the model (e.g., it does not use the chordal harmony or textures of the model, it does not utilize rhythmic and melodic characteristics used in the model, it does not use articulations or dynamics used in the model, it generates a new sound, but not within the guidelines).

37. Now, recall and play your permutation hands together and record it in your file. Start by finding your folder (it will have your name on it) and proceed as follows:
   a) Open the folder with your name by double-clicking it.
   b) Look for file labeled Improvisation and double-click it.
   c) Think about what you are going to play. When you are ready, look at the standard recording controls at the bottom of the computer display.
   d) Click the recording control (circle) and start playing. (If, at any time you want to start over, click and hold on the Edit menu. Scroll down to Erase and release the button.
e) When you are finished, click the stop control (square).
f) For playback, click the single arrow to your right.
g) To save your work, click and hold on the File menu at the top of your display. Now, scroll down to Save and release the mouse button.
h) When you have saved your file, scroll down and release the button on Quit under the same menu. You are finished.

38. Listen to your permutation and evaluate it using the following questions:
   a) Does the permutation utilize similar textures and chordal harmony to those used in the model piece?
   b) Is the permutation in the meter of the original model?
   c) Is the permutation in the key of the original model?
   d) Does the permutation utilize rhythmic characteristics which are evident in the given piano piece?
   e) Does the permutation utilize melodic characteristics present in the model?
   f) Does the permutation utilize a similar structural outline to that of the model?
   g) Are the articulations used within the range used in the model?
   h) Are the dynamics used within the range indicated in the model?
   i) Is the overall style of the permutation similar to that of the model?
   j) Does the permutation generate a new sound within the guidelines? Does it utilize new musical ideas not found in the musical model?

39. Use your evaluation (and your teacher’s response to your efforts here) to inform your next permutation assignment.
Unit 4

As you follow the printed instructions, listen carefully to the aural examples, and trial exercises and new musical inventions.

1. Listen to the entire piano work, *Rondo*, by Wolfgang Amadeus Mozart. In your folder in the computer, open the Mozart folder. Now, open the file labeled Rondo.

THE STUDENT HEARS
Right Hand Only: Melodic Permutation in the Right Hand (R.H.)

2. Listen to the excerpt of the piano work, played hands together: In your folder in the computer, open the Mozart folder. Now, open the file labeled Example 1.

Example 1 (first eight measures).

THE STUDENT HEARS

3. Listen again a second time; focus on the melody in the right hand.

THE STUDENT HEARS
4. Listen to the R.H. melody played alone three times: In your folder in the computer, open the Mozart folder. Now, open the file labeled Example 2.

Example 2 (first eight measures).

THE STUDENT HEARS

Example 2

5. With eyes closed, sing the melody in a comfortable vocal range on “la”; start on g', the fifth degree of the scale, and slowly continue through the melody.

THE STUDENT SINGS

6. Sing the melody again using scale degree numbers; start on 5, in the key of C Major, the fifth degree of the scale, and slowly continue through the melody.

THE STUDENT SINGS

7. Listen to the melody of the piano work again; sing the letter names of pitches while listening.

THE STUDENT HEARS

Example 2

8. Play the entire melody by ear on the piano in the key indicated, starting on g', the fifth degree of the C Major scale, second g above middle C.

9. Listen to each of the melodic permutations for the right hand three times; they are each given aurally on the sound track. They include scale, five–finger, and other permutations typically found in Mozart’s piano music: In your folder in the computer, open the Mozart folder. Now, open the file labeled Example 3. Repeat this process for Examples 4 and 5.

Examples 3–5.

THE STUDENT HEARS

Example 3

Example 4

Example 5

10. Listen to each permutation again and tap the rhythm of each as you listen. Tap the rhythm of each permutation again after you have finished listening: Examples 3–5.

THE STUDENT HEARS AND TAPS, AND THEN TAPS AGAIN
11. With eyes closed, listen to the melodic permutation again and then sing on “la”; repeat for each of the melodic permutations: Examples 3–5.

THE STUDENT HEARS AND SINGS

12. Listen and sing each melodic permutation again, this time using scale degree numbers: For Examples 3–5, the scale degree numbers of the starting pitches are as follows:
   Example 3: e¹, (second e above middle C)
   Example 4: c   (C above middle C)
   Example 5: g¹ (second g above middle C)

THE STUDENT HEARS AND THEN SINGS

13. Listen and then sing each permutation again, using letter names of pitches.
   The letter names of starting pitches are as follows:
   Example 3: (second e above middle C)
   Example 4: (C above middle C)
   Example 5: (second g above middle C)

THE STUDENT HEARS AND THEN SINGS

14. Listen again to each melodic permutation, singing on “la” as you listen:
    Example 3–5.

THE STUDENT SINGS WHILE LISTENING

15. Listen and then play each melodic permutation by ear in the given key of G Major with the given starting note, using R.H. For Examples 3–5 the letter names of starting pitches are as follows:
   Example 3: (second e above middle C)
   Example 4: (C above middle C)
   Example 5: (second g above middle C)

THE STUDENT HEARS THEN PLAYS
16. Play each melodic permutation by ear again along with the recording of the Left Hand (L.H.). The letter name of the starting pitch is:
Example 3: (second e above middle C)
Example 4: (C above middle C)
Example 5: (second g above middle C)

THE STUDENT PLAYS WHILE LISTENING

17. Explore various melodic permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key.

18. Mentally image (“think”) a melodic permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

19. Sing your mentally-imaged melodic permutation on “la”.

20. Sing your melodic permutation again, using letter names of pitches.

21. Play your melodic permutation on the piano with your R.H. Continue to play until you are quite certain of it – until it is “natural” for you.

22. Play your R.H. melodic permutation along with the L.H. part that is played by the computer. In your folder in the computer, open the Mozart folder. Now, open the file labeled Example 6.

Example 6.

THE STUDENT PLAYS WHILE LISTENING

Example 6

\[ \text{Example 6} \]

\[ \text{Example 6} \]

\[ \text{Example 6} \]
Left Hand Only: Accompaniment Permutation in the Left Hand (L.H.)


THE STUDENT HEARS

Example 6

24. Listen to the L.H. accompaniment again and sing it on “la” in a comfortable range.

THE STUDENT HEARS

Example 6

25. Sing the L.H. part again using scale degree numbers; start on number 1, the first degree of the scale. Sing the L.H. part again using letter names of pitches; start on middle C.

THE STUDENT SINGS

26. As you listen a third time, mentally image the melody. Notice the harmony of the L.H. accompaniment as it blends with the melody you are mentally imaging. Typical of the style, melody pitches usually sound best with those pitches within the chords of the accompaniment.

THE STUDENT HEARS

Example 6

27. Listen to each of the L.H. permutations. In your folder in the computer, open the Mozart folder. Now, open the file labeled Example 7. Repeat this process for Examples 8 and 9.

Exercises 7–9.

THE STUDENT HEARS

Example 7

Example 8

Example 9

28. Listen to each accompaniment permutation again and tap the rhythm of each with your L.H. as you listen. Tap the rhythm of each exercise after you have finished listening.

THE STUDENT HEARS AND TAPS

29. Listen again to the accompaniment permutation, then sing it in a comfortable vocal range on “la”. Sing all pitches of the blocked chords, ascending from the bottom pitch upwards. The letter names of the starting pitches are:
Example 7: C (middle C)
Example 8: C (middle C)
Example 9: C (middle C)

THE STUDENT SINGS WHILE LISTENING

30. Play each L.H. permutation by ear in the key of G. The letter names of the starting pitches are:
Example 7: C (middle C)
Example 8: C (middle C)
Example 9: C (middle C)

31. Explore various accompaniment permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key. Remember that the goal is to create a permutation “in the style of” the master composer’s work.

32. Mentally image (“think”) an accompaniment permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

33. Try playing your own left hand accompaniment permutation along with the computer playing the R.H. part. In your folder in the computer, open the Mozart folder. Now, open the file labeled Example 10.

Example 10.

THE STUDENT LISTENS AND PLAYS

Example 10
Hands Together Instructional Strategies

34. Recall your invented melodic permutation, and connect it with your new accompaniment permutation. Play your permutation, hands together, three times. Listen carefully and evaluate how well the melodic permutation and the accompaniment permutation fit together.

35. Listen to the following acceptable permutation. In your folder in the computer, open the Mozart folder. Now, open the file labeled Example 11.

Example 11.

THE STUDENT HEARS

![Example 11](image)

The permutation is acceptable because it uses rhythmic, melodic and textural components similar to those used in the model (e.g., it uses the same chordal harmony as the model, it is in the same meter and key as the model, it utilizes some of the rhythmic and melodic characteristics of the model, it uses a similar structural outline to that of the model, the articulations and dynamics are within the range used in the model, the overall style is similar to that of the model, it generates a new sound within the guidelines, and utilizes new musical ideas not found in the musical model).

36. Listen to the following unacceptable permutation. In your folder in the computer, open the Mozart folder. Now, open the file labeled Example 12.

Example 12.

THE STUDENT HEARS
The permutation is unacceptable because it does not use rhythmic, melodic and textural components similar to those used in the model (e.g., it does not use the chordal harmony or textures of the model, it does not utilize rhythmic and melodic characteristics used in the model, it does not use articulations or dynamics used in the model, it generates a new sound, but not within the guidelines).

37. Now, recall and play your permutation hands together and record it in your file. Start by finding your folder (it will have your name on it) and proceed as follows:

   a) Open the folder with your name by double-clicking it.
   b) Look for file labeled Improvisation and double-click it.
   c) Think about what you are going to play. When you are ready, look at the standard recording controls at the bottom of the computer display.
   d) Click the recording control (circle) and start playing. (If, at any time you want to start over, click and hold on the Edit menu. Scroll down to Erase and release the button.
   e) When you are finished, click the stop control (square).
   f) For playback, click the single arrow to your right.
   g) To save your work, click and hold on the File menu at the top of your display. Now, scroll down to Save and release the mouse button.
   h) When you have saved your file, scroll down and release the button on Quit under the same menu. You are finished.

38. Listen to your permutation and evaluate it using the following questions:

   a) Does the permutation utilize similar textures and chordal harmony to those used in the model piece?
   b) Is the permutation in the meter of the original model?
   c) Is the permutation in the key of the original model?
d) Does the permutation utilize rhythmic characteristics which are evident in the given piano piece?

e) Does the permutation utilize melodic characteristics present in the model?

f) Does the permutation utilize a similar structural outline to that of the model?

g) Are the articulations used within the range used in the model?

h) Are the dynamics used within the range indicated in the model?

i) Is the overall style of the permutation similar to that of the model?

j) Does the permutation generate a new sound within the guidelines? Does it utilize new musical ideas not found in the musical model?

39. Use your evaluation (and your teacher's response to your efforts here) to inform your next permutation assignment.
Unit 5

As you follow the printed instructions, listen carefully to the aural examples, and trial exercises and new musical inventions.


**THE STUDENT HEARS**

![Music notation image]

**Right Hand Only: Melodic Permutation in the Right Hand (R.H.)**

2. Listen to the excerpt of the piano work, played hands together: In your folder in the computer, open the Bartók 2 folder. Now, open the file labeled Example 1.

Example 1 (first eight measures).

**THE STUDENT HEARS**
Example 1

3. Listen again a second time; focus on the melody in the right hand.

THE STUDENT HEARS

Example 1

4. Listen to the R.H. melody played alone three times: In your folder in the computer, open the Bartók 2 folder. Now, open the file labeled Example 2.

Example 2 (first eight measures).

THE STUDENT HEARS

Example 2

5. With eyes closed, sing the melody (top note in chord) in a comfortable vocal range on “la”; start on g, the fifth degree of the scale, and slowly continue through the melody.

THE STUDENT SINGS
6. Sing the melody again using scale degree numbers; start on g, in the key of C Major, the fifth degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**

7. Listen to the melody of the piano work again; sing the letter names of pitches while listening.

**THE STUDENT HEARS**

![Example 2](image)

8. Play the entire melody by ear on the piano in the key indicated, starting on g, the fifth degree of the C Major scale, second g above middle C.


9. Listen to each of the melodic permutations for the right hand three times; they are each given aurally on the sound track. They include scale, five-finger, and other permutations typically found in Bartok's piano music: In your folder in the computer, open the Bartók 2 folder. Now, open the file labeled Example 3. Repeat this process for Examples 4 and 5.

Examples 3–5.

**THE STUDENT HEARS**

![Example 3](image)
10. Listen to each permutation again and tap the rhythm of each as you listen. 
Tap the rhythm of each permutation again after you have finished listening: 
Examples 3–5.

THE STUDENT HEARS AND TAPS, AND THEN TAPS AGAIN

11. With eyes closed, listen to the melodic permutation again and then sing it on 
"la"; repeat for each of the melodic permutations: Examples 3–5.

THE STUDENT HEARS AND SINGS

12. Listen and sing each melodic permutation again, this time using scale degree 
numbers: For Examples 3–5, the scale degree numbers of the starting pitches 
are as follows:
Example 3:  3  (C above middle C)  
Example 4:  3  (C above middle C)  
Example 5:  3  (C above middle C)  

THE STUDENT HEARS AND THEN SINGS

13. Listen and then sing each permutation again, using letter names of pitches. 
The letter names of starting pitches are as follows: 
Example 3:  c  (c above middle C)  
Example 4:  c  (c above middle C)  
Example 5:  c  (c above middle C)
THE STUDENT HEARS AND THEN SINGS

14. Listen again to each melodic permutation, singing on “la” as you listen:
Example 3–5.

THE STUDENT SINGS WHILE LISTENING

15. Listen and then play each melodic permutation by ear in the given key of e
minor with the given starting note, using R.H. For Examples 3–5 the letter names
of starting pitches are as follows:
Example 3: c (c above middle C)
Example 4: c (c above middle C)
Example 5: c (c above middle C)

THE STUDENT HEARS THEN PLAYS

16. Play each melodic permutation by ear again along with the recording of the
Left Hand (L.H.). The letter name of the starting pitch is:
Example 3: c (c above middle C)
Example 4: c (c above middle C)
Example 5: c (c above middle C)

THE STUDENT PLAYS WHILE LISTENING

17. Explore various melodic permutation ideas, eight measures in length, on the
piano until you are satisfied with the results. Stay within the given meter and key.

18. Mentally image (“think”) a melodic permutation of your own, one that is eight
measures in length, in the same meter and key as the musical model.

19. Sing your mentally–imaged melodic permutation on “la”.

20. Sing your melodic permutation again, using letter names of pitches.
21. Play your melodic permutation on the piano with your R.H. Continue to play until you are quite certain of it – until it is “natural” for you.

22. Play your R.H. melodic permutation along with the L.H. part that is played by the computer. In your folder in the computer, open the Bartók 2 folder. Now, open the file labeled Example 6.

Example 6.

**THE STUDENT PLAYS WHILE LISTENING**

![Example 6](image)

**Left Hand Only: Accompaniment Permutation in the Left Hand (L.H.)**


**THE STUDENT HEARS**

![Example 6](image)

24. Listen to the L.H. accompaniment again and sing it on “la” in a comfortable range; sing all the notes in the L.H. chords starting on the bottom note.

**THE STUDENT HEARS**

![Example 6](image)
25. Sing the L.H. part again using scale degree numbers; start on number 1, the first degree of the scale. Sing the L.H. part again using letter names of pitches; start on A below middle C.

THE STUDENT SINGS

26. As you listen a third time, mentally image the melody. Notice the harmony of the L.H. accompaniment as it blends with the melody you are mentally imagining. Typical of the style, melody pitches usually sound best with those pitches within the chords of the accompaniment.

THE STUDENT HEARS

Example 6


27. Listen to each of the L.H. permutations. In your folder in the computer, open the Bartók 2 folder. Now, open the file labeled Example 7. Repeat this process for Examples 8 and 9.

Exercises 7–9.

THE STUDENT HEARS

Example 7

Example 8
28. Listen to each accompaniment permutation again and tap the rhythm of each with your L.H. as you listen. Tap the rhythm of each permutation after you have finished listening.

THE STUDENT HEARS AND TAPS

29. Listen again to the accompaniment permutation, then sing it in a comfortable vocal range on “la”. The letter names of the starting pitches are:
Example 7:  A  (A below middle C)
Example 8:  A  (A below middle C)
Example 9:  A  (A below middle C)

THE STUDENT SINGS WHILE LISTENING

30. Play each L.H. permutation by ear in the key of e minor. The letter names of the starting pitches are:

Example 7:  A  (A below middle C)
Example 8:  A  (A below middle C)
A  (e above middle C)
Example 9:  A  (A below middle C)

31. Explore various accompaniment permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key. Remember that the goal is to create a permutation “in the style of” the master composer’s work.
32. Mentally image ("think") an accompaniment permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

33. Try playing your own left hand permutation accompaniment along with the computer playing the R.H. part. In your folder in the computer, open the Bartók 2 folder. Now, open the file labeled Example 10.

Example 10.

THE STUDENT LISTENS AND PLAYS

Example 10

Hands Together Instructional Strategies

34. Recall your invented melodic permutation, and connect it with your new accompaniment permutation. Play your permutation, hands together, three times. Listen carefully and evaluate how well the melodic permutation and the accompaniment permutation fit together.

35. Listen to the following acceptable permutation. In your folder in the computer, open the Bartok folder. Now, open the file labeled Example 11.

Example 11.

THE STUDENT HEARS

Example 11
The permutation is acceptable because it uses the rhythmic, melodic and textural components similar to those used in the model. (e.g. it uses the same chordal harmony as the model, it is in the same meter and key, it utilizes some of the rhythmic and melodic characteristics of the model, it uses a similar structural outline, the articulations and dynamics are within the range used in the model, the overall style is similar to that of the model, it generates a new sound within the guidelines, and utilizes new musical ideas not found in the musical mode).

36. Listen to the following unacceptable permutation. In your folder in the computer, open the Bartók 2 folder. Now, open the file labeled Example 12.

Example 12.

THE STUDENT HEARS

Example 12

The permutation is unacceptable because it does not use rhythmic, melodic and textural components similar to those used in the model (e.g., it does not use the chordal harmony or textures of the model, it does not utilize rhythmic and melodic characteristics used in the model, it does not use articulations or dynamics used in the model, it generates a new sound, but not within the guidelines).

37. Now, recall and play your permutation hands together and record it in your file. Start by finding your folder (it will have your name on it) and proceed as follows:

a) Open the folder with your name by double-clicking it.

b) Look for folder labeled Improvisation and double-click it.

c) Open the file labeled #1. When you are ready to record, look at the recording symbols at the bottom of the display.

d) Click the recording control (circle) and start playing. (If, at any time you want to start over, click and hold on the Edit menu. Scroll down to Erase and release the button.
e) When you are finished, click the stop control (square).
f) For playback, click the single arrow to your right.
g) To save your work, click and hold on the File menu at the top of your display. Now, scroll down to Save and release the mouse button.
h) When you have saved your file, scroll down and release the button on Quit under the same menu. You are finished.

38. Listen to your permutation and evaluate it using the following questions:
   a) Does the permutation utilize similar textures and chordal harmony to those used in the model piece?
   b) Is the permutation in the meter of the original model?
   c) Is the permutation in the key of the original model?
   d) Does the permutation utilize rhythmic characteristics which are evident in the given piano piece?
   e) Does the permutation utilize melodic characteristics present in the model?
   f) Does the permutation utilize a similar structural outline to that of the model?
   g) Are the articulations used within the range used in the model?
   h) Are the dynamics used within the range indicated in the model?
   i) Is the overall style of the permutation similar to that of the model?
   j) Does the permutation generate a new sound within the guidelines? Does it utilize new musical ideas not found in the musical model?

39. Use your evaluation (and your teacher’s response to your efforts here) to inform your next permutation assignment.
Unit 6

As you follow the printed instructions, listen carefully to the aural examples, and trial exercises and new musical inventions.

1. Listen to the entire piano work, *Menuet*, by Johann Sebastian Bach. In your folder in the computer, open the Bach 1 folder. Now, open the file labeled Minuet and listen to the example.

**THE STUDENT HEARS**

![Musical notation]

**Right Hand Only: Melodic Permutation in the Right Hand (R.H.)**

2. Listen to the excerpt of the piano work, played hands together: In your folder in the computer, open the Bach 1 folder. Now, open the file labeled Example 1.

Example 1 (first eight measures).

**THE STUDENT HEARS**
3. Listen again a second time; focus on the melody in the right hand.

THE STUDENT HEARS

4. Listen to the R.H. melody played alone three times: In your folder in the computer, open the Bach 1 folder. Now, open the file labeled Example 2.

Example 2 (first eight measures).

THE STUDENT HEARS

5. With eyes closed, sing the melody in a comfortable vocal range on “la”; start on d¹, the fifth degree of the scale, and slowly continue through the melody.

THE STUDENT SINGS
6. Sing the melody again using scale degree numbers; start on d\(^4\), in the key of G Major, the fifth degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**

7. Listen to the melody of the piano work again; sing the letter names of pitches while listening.

**THE STUDENT HEARS**

Example 2

8. Play the entire melody by ear on the piano in the key indicated, starting on d\(^4\), the fifth degree of the G Major scale, second d above middle C.


9. Listen to each of the melodic permutations for the right hand three times; they are each given aurally on the sound track. They include scale, five-finger, and other permutations typically found in Bach's piano music: In your folder in the computer, open the Bach 1 folder. Now, open the file labeled Example 3. Repeat this process for Examples 4 and 5.

Examples 3–5.

**THE STUDENT HEARS**

Example 3
10. Listen to each permutation again and tap the rhythm of each as you listen. Tap the rhythm of each permutation again after you have finished listening: Examples 3–5.

**THE STUDENT HEARS AND TAPS, AND THEN TAPS AGAIN**

11. With eyes closed, listen to each melodic permutation again and then sing it on “la”; repeat for each of the melodic permutations: Examples 3–5.

**THE STUDENT HEARS AND SINGS**

12. Listen and sing each melodic permutation again, this time using scale degree numbers: For Examples 3–5, the scale degree numbers of the starting pitches are as follows:
   - Example 3: 5 (second d above middle C)
   - Example 4: 5 (second d above middle C)
   - Example 5: 5 (second d above middle C)

**THE STUDENT HEARS AND THEN SINGS**

13. Listen and then sing each permutation again, using letter names of pitches. The letter names of starting pitches are as follows:
   - Example 3: (second d above middle C)
   - Example 4: (second d above middle C)
   - Example 5: (second d above middle C)
THE STUDENT HEARS AND THEN SINGS

14. Listen again to each melodic permutation, singing on “la” as you listen:
Example 3–5.

THE STUDENT SINGS WHILE LISTENING

15. Listen and then play each melodic permutation by ear in the given key of G
Major with the given starting note, using R.H. For Examples 3–5 the letter names
of starting pitches are as follows:
Example 3:  (second d above middle C)
Example 4:  (second d above middle C)
Example 5:  (second d above middle C)

THE STUDENT HEARS THEN PLAYS

16. Play each melodic permutation by ear again along with the recording of the
Left Hand (L.H.). The letter name of the starting pitch is:
Example 3:  (second d above middle C)
Example 4:  (second d above middle C)
Example 5:  (second d above middle C)

THE STUDENT PLAYS WHILE LISTENING

17. Explore various melodic permutation ideas, eight measures in length, on the
piano until you are satisfied with the results. Stay within the given meter and key.

18. Mentally image (“think”) a melodic permutation of your own, one that is eight
measures in length, in the same meter and key as the musical model.

19. Sing your mentally–imaged melodic permutation on “la”.

20. Sing your melodic permutation again, using letter names of pitches.
21. Play your melodic permutation on the piano with your R.H. Continue to play until you are quite certain of it – until it is “natural” for you.

22. Play your R.H. melodic permutation along with the L.H. part that is played by the computer. In your folder in the computer, open the Bach 1 folder. Now, open the file labeled Example 6.

Example 6.

THE STUDENT PLAYS WHILE LISTENING

Left Hand Only: Accompaniment Permutation in the Left Hand (L.H.)


THE STUDENT HEARS

24. Listen to the L.H. accompaniment again and sing it on “la” in a comfortable range.

THE STUDENT HEARS
25. Sing the L.H. part again using scale degree numbers; start on number 1, the first degree of the scale. Sing the L.H. part again using letter names of pitches; start on G below middle C.

THE STUDENT SINGS

26. As you listen a third time, mentally image the melody. Notice the harmony of the L.H. accompaniment as it blends with the melody you are mentally imaging. Typical of the style, melody pitches usually sound best with those pitches within the chords of the accompaniment.

THE STUDENT HEARS

Example 6


27. Listen to each of the L.H. permutations. In your folder in the computer, open the Bach 1 folder. Now, open the file labeled Example 7. Repeat this process for Examples 8 and 9.

Exercises 7–9.

THE STUDENT HEARS

Example 7

Example 8
28. Listen to each accompaniment permutation again and tap the rhythm of each with your L.H. as you listen. Tap the rhythm of each permutation after you have finished listening.

THE STUDENT HEARS AND TAPS

29. Listen again to the accompaniment permutation then sing it in a comfortable vocal range on “La”. Sing all pitches of the blocked chords, ascending from the bottom pitch upwards. The letter names of the starting pitches are:
Example 7: G (first G below middle C)
Example 8: G (first G below middle C)
Example 9: G (second G below middle C)

THE STUDENT SINGS WHILE LISTENING

30. Play each L.H. permutation by ear in the key of G. The letter names of the starting pitches are:
Example 7: G (first G below middle C)
Example 8: G (first G below middle C)
Example 9: G (second G below middle C)

31. Explore various accompaniment permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key. Remember that the goal is to create a permutation “in the style of” the master composer’s work.

32. Mentally image ("think") an accompaniment permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.
33. Try playing your own left hand accompaniment permutation along with the computer playing the R.H. part. In your folder in the computer, open the Bach 1 folder. Now, open the file labeled Example 10.

Example 10.

**THE STUDENT LISTENS AND PLAYS**

![Example 10]

**Hands Together Instructional Strategies**

34. Recall your invented melodic permutation and connect it with your new accompaniment permutation. Play your permutation, hands together, three times. Listen carefully and evaluate how well the melodic permutation and the accompaniment permutation fit together.

35. Listen to the following acceptable permutation. In your folder in the computer, open the Bach 1 folder. Now, open the file labeled labeled Example 11.

Example 11.

**THE STUDENT HEARS**

![Example 11]

The permutation is acceptable because it uses rhythmic, melodic and textural components similar to those used in the model (e.g., it uses the same chordal harmony as the model, it is in the same meter and key as the model, it utilizes some of the rhythmic and melodic characteristics of the model, it uses a similar structural outline to that of the model, the articulations and dynamics are within the range used in the model, the overall style is similar to that of the model, it generates a new sound within the guidelines, and utilizes new musical ideas not found in the musical model).
36. Listen to the following unacceptable permutation. In your folder in the computer, open the Bach 1 folder. Now, open the file labeled Example 12.

Example 12.

**THE STUDENT HEARS**

```
Example 12

\[\text{Music notation image}\]
```

The permutation is unacceptable because it does not use rhythmic, melodic and textural components similar to those used in the model (e.g., it does not use the chordal harmony or textures of the model, it does not utilize rhythmic and melodic characteristics used in the model, it does not use articulations or dynamics used in the model, it generates a new sound, but not within the guidelines).

37. Now, recall and play your permutation hands together and record it in your file. Start by finding your folder (it will have your name on it) and proceed as follows:

a) Open the folder with your name by double-clicking it.
b) Look for file labeled Improvisation and double-click it.
c) Think about what you are going to play. When you are ready, look at the standard recording controls at the bottom of the computer display.
d) Click the recording control (circle) and start playing. (If, at any time you want to start over, click and hold on the Edit menu. Scroll down to Erase and release the button.
e) When you are finished, click the stop control (square).
f) For playback, click the single arrow to your right.
g) To save your work, click and hold on the File menu at the top of your display. Now, scroll down to Save and release the mouse button.
h) When you have saved your file, scroll down and release the button on Quit under the same menu. You are finished.
38. Listen to your permutation and evaluate it using the following questions:
   a) Does the permutation utilize similar textures and chordal
      harmony to those used in the model piece?
   b) Is the permutation in the meter of the original model?
   c) Is the permutation in the key of the original model?
   d) Does the permutation utilize rhythmic characteristics which
      are evident in the given piano piece?
   e) Does the permutation utilize melodic characteristics present
      in the model?
   f) Does the permutation utilize a similar structural outline to that
      of the model?
   g) Are the articulations used within the range used in the model?
   h) Are the dynamics used within the range indicated in the model?
   i) Is the overall style of the permutation similar to that of the model?
   j) Does the permutation generate a new sound within the guidelines?
      Does it utilize new musical ideas not found in the musical model?

39. Use your evaluation (and your teacher’s response to your efforts here) to
    inform your next permutation assignment.
Unit 7

As you follow the printed instructions, listen carefully to the aural examples, and trial exercises and new musical inventions.

1. Listen to the entire piano work, *Melody*, by Robert Schumann. In your folder in the computer, open the Schumann 2 folder. Now, open the file labeled *Melody* and listen to the example.

THE STUDENT HEARS

![Musical notation image]

Right Hand Only: Melodic Permutation in the Right Hand (R.H.)

2. Listen to the excerpt of the piano work, played hands together: In your folder in the computer, open the Schumann 2 folder. Now, open the file labeled Example 1.

Example 1 (first eight measures).

THE STUDENT HEARS
3. Listen again a second time; focus on the melody in the right hand.

**THE STUDENT HEARS**

Example 1

4. Listen to the R.H. melody played alone three times: In your folder in the computer, open the Schumann 2 folder. Now, open the file labeled Example 2.

Example 2 (first eight measures).

**THE STUDENT HEARS**

Example 2

5. With eyes closed, sing the melody in a comfortable vocal range on "la"; start on e\(^1\), the third degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**
6. Sing the melody again using scale degree numbers; start on 3, in the key of C Major, the third degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**

7. Listen to the melody of the piano work again; sing the letter names of pitches while listening.

**THE STUDENT HEARS**

![Example 2](image)

8. Play the entire melody by ear on the piano in the key indicated, starting on e\textsuperscript{1}, the third degree of the C Major scale, second e above middle C.


9. Listen to each of the melodic permutations for the right hand three times; they are each given aurally on the sound track. They include scale, five–finger, and other permutations typically found in Schumann's piano music: In your folder in the computer, open the Schumann 2 folder. Now, open the file labeled Example 3. Repeat this process for Examples 4 and 5.

Examples 3–5.

**THE STUDENT HEARS**

![Example 3](image)
10. Listen to each permutation again and tap the rhythm of each as you listen. Tap the rhythm of each permutation again after you have finished listening: Examples 3–5.

**THE STUDENT HEARS AND TAPS, AND THEN TAPS AGAIN**

11. With eyes closed, listen to each melodic permutation again and then sing it on “la”; repeat for each of the melodic patterns: Examples 3–5.

**THE STUDENT HEARS AND SINGS**

12. Listen and sing each melodic permutation again, this time using scale degree numbers: For Examples 3–5, the scale degree numbers of the starting pitches are as follows:
   Example 3: 3  (second e above middle C)
   Example 4: 3  (second e above middle C)
   Example 5: 1  (C above middle C)

**THE STUDENT HEARS AND THEN SINGS**

13. Listen and then sing each permutation again, using letter names of pitches. The letter names of starting pitches are as follows:
Example 3: (second e above middle C)
Example 4: (second e above middle C)
Example 5: (C above middle C)

**THE STUDENT HEARS AND THEN SINGS**

14. Listen again to each melodic permutation, singing on “la” as you listen:
Example 3–5.

**THE STUDENT SINGS WHILE LISTENING**

15. Listen and then play each melodic permutation by ear in the given key of G Major with the given starting note, using R.H. For Examples 3–5 the letter names of starting pitches are as follows:
Example 3: (second e above middle C)
Example 4: (second e above middle C)
Example 5: (C above middle C)

**THE STUDENT HEARS THEN PLAYS**

16. Play each melodic permutation by ear again along with the recording of the Left Hand (L.H.). The letter name of the starting pitch is:
Example 3: (second e above middle C)
Example 4: (second e above middle C)
Example 5: (C above middle C)

**THE STUDENT PLAYS WHILE LISTENING**

17. Explore various melodic permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key.

18. Mentally image (“think”) a melodic permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.
19. Sing your mentally-imaged melodic permutation on “la”.

20. Sing your melodic permutation again, using letter names of pitches.

21. Play your melodic permutation on the piano with your R.H. Continue to play until you are quite certain of it – until it is “natural” for you.

22. Play your R.H. melodic permutation along with the L.H. part that is played by the computer. In your folder in the computer, open the Schumann 2 folder. Now, open the file labeled Example 6.

Example 6.

THE STUDENT PLAYS WHILE LISTENING

Left Hand Only: Accompaniment Permutation in the Left Hand (L.H.)


THE STUDENT HEARS

24. Listen to the L.H. accompaniment again and sing it on “la” in a comfortable range.

THE STUDENT HEARS
25. Sing the notes of the chords again using scale degree numbers; start on number 1, the first degree of the scale. Sing the L.H. accompaniment permutation again using letter names of pitches; start on middle C.

**THE STUDENT SINGS**

26. As you listen a third time, mentally image the melody. Notice the harmony of the L.H. accompaniment as it blends with the melodic permutation you are mentally imagining. Typical of the style, melody pitches usually sound best with those pitches within the chords of the accompaniment.

**THE STUDENT HEARS**


27. Listen to each of the L.H. permutations. In your folder in the computer, open the Schumann 2 folder. Now, open the file labeled Example 7. Repeat this process for Examples 8 and 9.

Exercises 7–9.

**THE STUDENT HEARS**
28. Listen to each L.H. accompaniment permutation again and tap the rhythm of each with your L.H. as you listen. Tap the rhythm of each permutation after you have finished listening.

THE STUDENT HEARS AND TAPS

29. Listen again to the accompaniment permutation, then sing it in a comfortable vocal range on "la" (all pitches of the blocked chords, ascending from the bottom pitch upwards). The letter names of the starting pitches are:
Example 7: C (middle C)
Example 8: g (g above middle C)
Example 9: C (middle C)

THE STUDENT SINGS WHILE LISTENING

30. Play each L.H. permutation by ear in the key of G Major. The letter names of the starting pitches are:
Example 7: C (middle C)
Example 8: g (g above middle C)
Example 9: C (middle C)

31. Explore various accompaniment permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key. Remember that the goal is to create a permutation "in the style of" the master composer's work.
32. Mentally image ("think") an accompaniment permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

33. Try playing your own left hand improvised accompaniment permutation along with the computer playing the R.H. part. In your folder in the computer, open the Schumann 2 folder. Now, open the file labeled Example 10.

Example 10.

THE STUDENT LISTENS AND PLAYS

![Example 10](image)

Hands Together Instructional Strategies

34. Recall your invented melodic permutation, and connect it with your new accompaniment permutation. Play your permutation, hands together, three times. Listen carefully and evaluate how well the melodic permutation and the accompaniment permutation fit together.

35. Listen to the following acceptable permutation. In your folder in the computer, open the Schumann 2 folder. Now, open the file labeled Example 11.

Example 11.

THE STUDENT HEARS

![Example 11](image)
The permutation is acceptable because it uses rhythmic, melodic and textural components similar to those used in the model (e.g., it uses the same chordal harmony as the model, it is in the same meter and key, it utilizes some of the rhythmic and melodic characteristics of the model, it uses a similar structural outline, the articulations and dynamics are within the range used in the model, the overall style is similar to that of the model, it generates a new sound within the guidelines, and utilizes new musical ideas not found in the musical model).

36. Listen to the following unacceptable permutation. In your folder in the computer, open the Schumann 2 folder. Now, open the file labeled Example 12.

Example 12.

THE STUDENT HEARS

Example 12

The permutation is unacceptable because it does not use rhythmic, melodic and textural components similar to those used in the model (e.g., it does not use the chordal harmony or textures of the model, it does not utilize enough of the rhythmic and melodic characteristics used in the model, it does not use articulations or dynamics used in the model, it generates a new sound, but not within the guidelines).

37. Now, recall and play your permutation hands together and record it in your file. Start by finding your folder (it will have your name on it) and proceed as follows:

   a) Open the folder with your name by double-clicking it.
   b) Look for file labeled Improvisation and double-click it.
   c) Think about what you are going to play. When you are ready, look at the standard recording controls at the bottom of the computer display.
   d) Click the recording control (circle) and start playing. (If, at any time you want to start over, click and hold on the Edit menu. Scroll down to Erase and release the button.
e) When you are finished, click the stop control (square).
f) For playback, click the single arrow to your right.
g) To save your work, click and hold on the File menu at the top of your display. Now, scroll down to Save and release the mouse button.
h) When you have saved your file, scroll down and release the button on Quit under the same menu. You are finished.

38. Listen to your permutation and evaluate it using the following questions:
   a) Does the permutation utilize similar textures and chordal harmony to those used in the model piece?
   b) Is the permutation in the meter of the original model?
   c) Is the permutation in the key of the original model?
   d) Does the permutation utilize rhythmic characteristics which are evident in the given piano piece?
   e) Does the permutation utilize melodic characteristics present in the model?
   f) Does the permutation utilize a similar structural outline to that of the model?
   g) Are the articulations used within the range used in the model?
   h) Are the dynamics used within the range indicated in the model?
   i) Is the overall style of the permutation similar to that of the model?
   j) Does the permutation generate a new sound within the guidelines? Does it utilize new musical ideas not found in the musical model?

39. Use your evaluation (and your teacher's response to your efforts here) to inform your next permutation assignment.
Unit 8

As you follow the printed instructions, listen carefully to the aural examples, and trial exercises and new musical inventions.

1. Listen to the entire piano work, *Quadrille*, by Joseph Haydn. In your folder in the computer, open the Haydn folder. Now, open the file labeled Quadrille and listen to the example.

THE STUDENT HEARS

![Musical notation]

Right Hand Only: Melodic Permutation in the Right Hand (R.H.)

2. Listen to the excerpt of the piano work, played hands together: In your folder in the computer, open the Haydn folder. Now, open the file labeled Example 1.

Example 1 (first eight measures).
THE STUDENT HEARS

Example 1

3. Listen again a second time; focus on the melody in the right hand.

THE STUDENT HEARS

Example 1

4. Listen to the R.H. melody played alone three times: In your folder in the computer, open the Haydn folder. Now, open the file labeled Example 2.

Example 2 (first eight measures).

THE STUDENT HEARS

Example 2

5. With eyes closed, sing the melody in a comfortable vocal range on “la”; start on g, the fifth degree of the scale, and slowly continue through the melody.

THE STUDENT SINGS
6. Sing the melody again using scale degree numbers; start on g, in the key of C Major, the fifth degree of the scale, and slowly continue through the melody.

THE STUDENT SINGS

7. Listen to the melody of the piano work again; sing the letter names of pitches while listening.

THE STUDENT HEARS

Example 2

8. Play the entire melody by ear on the piano in the key indicated, starting on g, the fifth degree of the C Major scale below middle C.


9. Listen to each of the melodic permutations for the right hand three times; they are each given aurally on the sound track. They include scale, five-finger, and other permutations typically found in Haydn’s piano music. In your folder in the computer, open the Haydn folder. Now, open the file labeled Example 3. Repeat this process for Examples 4 and 5.

Examples 3–5.

THE STUDENT HEARS

Example 3
10. Listen to each permutation again and tap the rhythm of each as you listen. Tap the rhythm of each permutation again after you have finished listening: Examples 3–5.

**THE STUDENT HEARS AND TAPS, AND THEN TAPS AGAIN**

11. With eyes closed, listen to each melodic permutation again and then sing it on “la”; repeat for each of the melodic permutations: Examples 3–5.

**THE STUDENT HEARS AND SINGS**

12. Listen and sing each melodic permutation again, this time using scale degree numbers: For Examples 3–5, the scale degree numbers of the starting pitches are as follows:
   - Example 3: 5 (g above middle C)
   - Example 4: g (g above middle C)
   - Example 5: g (g above middle C)

**THE STUDENT HEARS AND THEN SINGS**

13. Listen and then sing each permutation again, using letter names of pitches. The letter names of starting pitches are as follows:
   - Example 3: (g above middle C)
   - Example 4: (g above middle C)
   - Example 5: (g above middle C)
THE STUDENT HEARS AND THEN SINGS

14. Listen again to each melodic permutation, singing on “la” as you listen: Example 3–5.

THE STUDENT SINGS WHILE LISTENING

15. Listen and then play each melodic permutation by ear in the given key of G Major with the given starting note, using R.H. For Examples 3–5 the letter names of starting pitches are as follows:
   Example 3:  (g above middle C)
   Example 4:  (g above middle C)
   Example 5:  (g above middle C)

THE STUDENT HEARS THEN PLAYS

16. Play each melodic permutation by ear again along with the recording of the Left Hand (L.H.). The letter name of the starting pitch is:
   Example 3:  (g above middle C)
   Example 4:  (g above middle C)
   Example 5:  (g above middle C)

THE STUDENT PLAYS WHILE LISTENING

17. Explore various melodic permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key.

18. Mentally image (“think”) a melodic permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

19. Sing your mentally-imaged melodic permutation on “la”.

20. Sing your melodic permutation again, using letter names of pitches.
21. Play your melodic permutation on the piano with your R.H. Continue to play until you are quite certain of it – until it is “natural” for you.

22. Play your R.H. melodic permutation along with the L.H. part that is played by the computer. In your folder in the computer, open the Haydn folder. Now, open the file labeled Example 6.

Example 6.

THE STUDENT PLAYS WHILE LISTENING

![Example 6](image)

Left Hand Only: Accompaniment Permutation in the Left Hand (L.H.)


THE STUDENT HEARS

![Example 6](image)

24. Listen to the L.H. accompaniment again and sing it on “la” in a comfortable range; sing all the notes in the L.H. chords, beginning with the bottom note.

THE STUDENT HEARS

25. Sing the L.H. again using scale degree numbers; start on number 1, the first degree of the scale. Sing the L.H. again using letter names of pitches; start on C below middle C.

THE STUDENT SINGS
26. As you listen a third time, mentally image the melody. Notice the harmony of the L.H. accompaniment as it blends with the melody you are mentally imaging. Typical of the style, melody pitches usually sound best with those pitches within the chords of the accompaniment.

**THE STUDENT HEARS**

Example 6


27. Listen to each of the L.H. permutations. In your folder in the computer, open the Haydn folder. Now, open the file labeled Example 7. Repeat this process for Examples 8 and 9.

Exercises 7–9.

**THE STUDENT HEARS**

Example 7

Example 8

Example 9
28. Listen to each accompaniment permutation again and tap the rhythm of each with your L.H. as you listen. Tap the rhythm of each permutation after you have finished listening.

THE STUDENT HEARS AND TAPS

29. Listen again to the accompaniment permutation, sing it in a comfortable vocal range on “la”. Sing all pitches of the blocked chords, ascending from the bottom pitch upwards. The letter names of the starting pitches are:
   Example 7: G (G below middle C)
   Example 8: C (C below middle C)
   Example 9: C (C below middle C)

THE STUDENT SINGS WHILE LISTENING

30. Play each L.H. permutation by ear in the key of G. The letter names of the starting pitches are:
   Example 7: G (G below middle C)
   Example 8: C (C below middle C)
   Example 9: C (C below middle C)

31. Explore various accompaniment permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key. Remember that the goal is to create a permutation “in the style of” the master composer’s work.

32. Mentally image (“think”) an accompaniment permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

33. Try playing your own left hand permutation accompaniment along with the computer playing the R.H. part. In your folder in the computer, open the Haydn folder. Now, open the file labeled Example 10.

Example 10.
THE STUDENT LISTENS AND PLAYS

Example 10

Hands Together Instructional Strategies

34. Recall your invented melodic permutation, and connect it with your new accompaniment permutation. Play your permutation, hands together, three times. Listen carefully and evaluate how well the melodic permutation and the accompaniment permutation fit together.

35. Listen to the following acceptable permutation. In your folder in the computer, open the Haydn folder. Now, open the file labeled Example 11.

Example 11.

THE STUDENT HEARS

Example 11

The permutation is acceptable because it uses rhythmic, melodic and textural components similar to those used in the model (e.g., it uses the same chordal harmony as the model, it is in the same meter and key, it utilizes some of the rhythmic and melodic characteristics of the model, it uses a similar structural outline, the articulations and dynamics are within the range used in the model, the overall style is similar to that of the model, it generates a new sound within the guidelines, and utilizes new musical ideas not found in the musical model).

36. Listen to the following unacceptable permutation. In your folder in the computer, open the Haydn folder. Now, open the file labeled Example 12.

Example 12.
THE STUDENT HEARS

Example 12

The permutation is unacceptable because it does not use rhythmic, melodic and textural components similar to those used in the model (e.g., it does not use the chordal harmony or textures of the model, it does not utilize enough of the rhythmic and melodic characteristics used in the model, it does not use articulations or dynamics used in the model, it generates a new sound, but not within the guidelines).

37. Now, recall and play your permutation hands together and record it in your file. Start by finding your folder (it will have your name on it) and proceed as follows:
   a) Open the folder with your name by double-clicking it.
   b) Look for file labeled Improvisation and double-click it.
   c) Think about what you are going to play. When you are ready, look at the standard recording controls at the bottom of the computer display.
   d) Click the recording control (circle) and start playing. (If, at any time you want to start over, click and hold on the Edit menu. Scroll down to Erase and release the button.
   e) When you are finished, click the stop control (square).
   f) For playback, click the single arrow to your right.
   g) To save your work, click and hold on the File menu at the top of your display. Now, scroll down to Save and release the mouse button.
   h) When you have saved your file, scroll down and release the button on Quit under the same menu. You are finished.

38. Listen to your permutation and evaluate it using the following questions:
   a) Does the permutation utilize similar textures and chordal harmony to those used in the model piece?
   b) Is the permutation in the meter of the original model?
c) Is the permutation in the key of the original model?
d) Does the permutation utilize rhythmic characteristics which are evident in the given piano piece?
e) Does the permutation utilize melodic characteristics present in the model?
f) Does the permutation utilize a similar structural outline to that of the model?
g) Are the articulations used within the range used in the model?
h) Are the dynamics used within the range indicated in the model?
i) Is the overall style of the permutation similar to that of the model?
j) Does the permutation generate a new sound within the guidelines? Does it utilize new musical ideas not found in the musical model?

39. Use your evaluation (and your teacher’s response to your efforts here) to inform your next permutation assignment.
As you follow the printed instructions, listen carefully to the aural examples, and trial exercises and new musical inventions.

1. Listen to the entire piano work, Bourrée, by Johann Sebastian Bach. In your folder in the computer, open the Bach 2 folder. Now, open the file labeled Bourrée and listen to the example.

THE STUDENT HEARS

Right Hand Only: Melodic Permutation in the Right Hand (R.H.)

2. Listen to the excerpt of the piano work, played hands together: In your folder in the computer, open the Bach 2 folder. Now, open the file labeled Example 1.

Example 1 (first eight measures).

THE STUDENT HEARS
3. Listen again a second time; focus on the melody in the right hand.

**THE STUDENT HEARS**

![Example 1](image)

4. Listen to the R.H. melody played alone three times: In your folder in the computer, open the Bach 2 folder. Now, open the file labeled Example 2.

Example 2 (first eight measures).

**THE STUDENT HEARS**

![Example 2](image)

5. With eyes closed, sing the melody in a comfortable vocal range on "la"; start on a, the fifth degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**

6. Sing the melody again using scale degree numbers; start on 5, in the key of d Minor, the fifth degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**

7. Listen to the melody of the piano work again; sing the letter names of pitches while listening.

**THE STUDENT HEARS**
8. Play the entire melody by ear on the piano in the key indicated, starting on a, the fifth degree of the d Minor scale, first a above middle C.


9. Listen to each of the melodic permutations for the right hand three times; they are each given aurally on the sound track. They include scale, five–finger, and other permutations typically found in Bach’s piano music: In your folder in the computer, open the Bach 2 folder. Now, open the file labeled Example 3. Repeat this process for Examples 4 and 5.

Examples 3–5.

**THE STUDENT HEARS**

Example 3

Example 4

Example 5
10. Listen to each permutation again and tap the rhythm of each as you listen. Tap the rhythm of each permutation again after you have finished listening: Examples 3–5.

THE STUDENT HEARS AND TAPS, AND THEN TAPS AGAIN

11. With eyes closed, listen to each melodic permutation again and then sing it on “la”; repeat for each of the melodic permutations: Examples 3–5.

THE STUDENT HEARS AND SINGS

12. Listen and sing each melodic permutation again, this time using scale degree numbers: For Examples 3–5, the scale degree numbers of the starting pitches are as follows:
   Example 3: 5 (a fifth above middle C)
   Example 4: 5 (a fifth above middle C)
   Example 5: 5 (a fifth above middle C)

THE STUDENT HEARS AND THEN SINGS

13. Listen and then sing each permutation again, using letter names of pitches. The letter names of starting pitches are as follows:
   Example 3: (first a above middle C)
   Example 4: (first a above middle C)
   Example 5: (first a above middle C)

THE STUDENT HEARS AND THEN SINGS

14. Listen again to each melodic permutation, singing on “la” as you listen: Example 3–5.

THE STUDENT SINGS WHILE LISTENING

15. Listen and then play each melodic permutation by ear in the given key of G Major with the given starting note, using R.H. For Examples 3–5 the letter names of starting pitches are as follows:
   Example 3: (first a above middle C)
   Example 4: (first a above middle C)
   Example 5: (first a above middle C)

THE STUDENT HEARS THEN PLAYS
16. Play each melodic permutation by ear again along with the recording of the Left Hand (L.H.). The letter name of the starting pitch is:
Example 3: (first a above middle C)
Example 4: (first a above middle C)
Example 5: (first a above middle C)

THE STUDENT PLAYS WHILE LISTENING

17. Explore various melodic permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key.

18. Mentally image ("think") a melodic permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

19. Sing your mentally–imaged melodic permutation on "la".

20. Sing your melodic permutation again, using letter names of pitches.

21. Play your melodic permutation on the piano with your R.H. Continue to play until you are quite certain of it – until it is "natural" for you.

22. Play your R.H. melodic permutation along with the L.H. part that is played by the computer. In your folder in the computer, open the Bach 2 folder. Now, open the file labeled labeled Example 6.

Example 6.

THE STUDENT PLAYS WHILE LISTENING

Example 6
Left Hand Only: Accompaniment Permutation in the Left Hand (L.H.)


THE STUDENT HEARS

Example 6

24. Listen to the L.H. accompaniment again and sing it on “la” in a comfortable range.

THE STUDENT HEARS

Example 6

25. Sing the L.H. accompaniment again using scale degree numbers; start on number 1, the first degree of the scale. Use letter names of pitches; start on d above middle C.

THE STUDENT SINGS

26. As you listen a third time, mentally image the melody. Notice the harmony of the L.H. accompaniment as it blends with the melody you are mentally imaging. Typical of the style, melody pitches usually sound best with those pitches within the chords of the accompaniment.

THE STUDENT HEARS

Example 6

27. Listen to each of the L.H. permutations. In your folder in the computer, open the Bach 2 folder. Now, open the file labeled Example 7. Repeat this process for Examples 8 and 9.

Exercises 7–9.

THE STUDENT HEARS

Example 7

Example 8

Example 9

28. Listen to each accompaniment permutation again and tap the rhythm of each with your L.H. as you listen. Tap the rhythm of each permutation after you have finished listening.

THE STUDENT HEARS AND TAPS

29. Listen again to the accompaniment permutation, then sing in a comfortable vocal range on “la”. The letter names of the starting pitches are:

Example 7: f (first f above middle C)
Example 8: D (first D below middle C)
Example 9: A (first A below middle C)

THE STUDENT SINGS WHILE LISTENING
30. Play each L.H. permutation by ear in the key of G. The letter names of the starting pitches are:
   Example 7: f  (first f above middle C)
   Example 8: D  (first D below middle C)
   Example 9: A  (first A below middle C)

31. Explore various accompaniment permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key. Remember that the goal is to create a permutation “in the style of” the master composer’s work.

32. Mentally image (“think”) an accompaniment permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

33. Try playing your own left hand accompaniment permutation along with the computer playing the R.H. part. In your folder in the computer, open the Bach 2 folder. Now, open the file labeled Example 10.

Example 10.

THE STUDENT LISTENS AND PLAYS

Hands Together Instructional Strategies

34. Recall your invented melodic permutation, and connect it with your new accompaniment permutation. Play your permutation, hands together, three times. Listen carefully and evaluate how well the melodic permutation and the accompaniment permutation fit together.

35. Listen to the following acceptable permutation. In your folder in the computer, open the Bach 2 folder. Now, open the file labeled labeled Example 11.

Example 11.

THE STUDENT HEARS
The permutation is acceptable because it uses rhythmic, melodic and textural components similar to those used in the model (e.g., it uses the same chordal harmony as the model, it is in the same meter and key, it utilizes some of the rhythmic and melodic characteristics of the model, it uses a similar structural outline, the articulations and dynamics are within the range used in the model, the overall style is similar to that of the model, it generates a new sound within the guidelines, and utilizes new musical ideas not found in the musical model).

36. Listen to the following unacceptable permutation. In your folder in the computer, open the Bach 2 folder. Now, open the file labeled Example 12.

Example 12.

THE STUDENT HEARS

The permutation is unacceptable because it does not use rhythmic, melodic and textural components similar to those used in the model (e.g., it does not use the chordal harmony or textures of the model, it does not utilize enough of the rhythmic and melodic characteristics used in the model, it does not use articulations or dynamics used in the model, it generates a new sound, but not within the guidelines).
37. Now, recall and play your permutation hands together and record it in your file. Start by finding your folder (it will have your name on it) and proceed as follows:
   a) Open the folder with your name by double-clicking it.
   b) Look for file labeled Improvisation and double-click it.
   c) Think about what you are going to play. When you are ready, look at the standard recording controls at the bottom of the computer display.
   d) Click the recording control (circle) and start playing. (If, at any time you want to start over, click and hold on the Edit menu. Scroll down to Erase and release the button.
   e) When you are finished, click the stop control (square).
   f) For playback, click the single arrow to your right.
   g) To save your work, click and hold on the File menu at the top of your display. Now, scroll down to Save and release the mouse button.
   h) When you have saved your file, scroll down and release the button on Quit under the same menu. You are finished.

38. Listen to your permutation and evaluate it using the following questions:
   a) Does the permutation utilize similar textures and chordal harmony to those used in the model piece?
   b) Is the permutation in the meter of the original model?
   c) Is the permutation in the key of the original model?
   d) Does the permutation utilize rhythmic characteristics which are evident in the given piano piece?
   e) Does the permutation utilize melodic characteristics present in the model?
   f) Does the permutation utilize a similar structural outline to that of the model?
   g) Are the articulations used within the range used in the model?
   h) Are the dynamics used within the range indicated in the model?
   i) Is the overall style of the permutation similar to that of the model?
   j) Does the permutation generate a new sound within the guidelines? Does it utilize new musical ideas not found in the musical model?

39. Use your evaluation (and your teacher’s response to your efforts here) to inform your next permutation assignment.
Unit 10

As you follow the printed instructions, listen carefully to the aural examples, and trial exercises and new musical inventions.

1. Listen to the entire piano work, *German Dance*, by Ludwig van Beethoven. In your folder in the computer, open the Beethoven 2 folder. Now, open the file labeled German Dance and listen to the example.

**THE STUDENT HEARS**

![Music notation]

**Right Hand Only: Melodic Permutation in the Right Hand (R.H.)**

2. Listen to the excerpt of the piano work, played hands together: In your folder in the computer, open the Beethoven 2 folder. Now, open the file labeled Example 1.

Example 1 (first eight measures).

**THE STUDENT HEARS**

![Music notation]
3. Listen again a second time; focus on the melody in the right hand.

**THE STUDENT HEARS**

![Example 1](image)

4. Listen to the R.H. melody played alone three times: In your folder in the computer, open the Beethoven 2 folder. Now, open the file labeled Example 2.

Example 2 (first eight measures).

**THE STUDENT HEARS**

![Example 2](image)

5. With eyes closed, sing the melody in a comfortable vocal range on “la”; start on e¹, the fifth degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**

6. Sing the melody again using scale degree numbers; start on 5, in the key of A Major, the fifth degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**

7. Listen to the melody of the piano work again; sing the letter name of pitches while listening.
8. Play the entire melody by ear on the piano in the key indicated, starting on e, the fifth degree of the A Major scale, the first e above middle C.


9. Listen to each of the melodic permutations for the right hand three times; they are each given aurally on the sound track. They include scale, five-finger, and other permutations typically found in Beethoven's piano music: In your folder in the computer, open the Beethoven 2 folder. Now, open the file labeled Example 3. Repeat this process for Examples 4 and 5.
10. Listen to each permutation again and tap the rhythm of each as you listen. Tap the rhythm of each permutation again after you have finished listening: Examples 3–5.

**THE STUDENT HEARS AND TAPS, AND THEN TAPS AGAIN**

11. With eyes closed, listen to each melodic permutation again and then sing it on “la”; repeat for each of the melodic permutations: Examples 3–5.

**THE STUDENT HEARS AND SINGS**

12. Listen and sing each melodic permutation again, this time using scale degree numbers: For Examples 3–5, the scale degree numbers of the starting pitches are as follows:
Example 3: 5 (above middle C)
Example 4: e (a fifth above middle C)
Example 5: e (a fifth above middle C)

**THE STUDENT HEARS AND THEN SINGS**

13. Listen and then sing each permutation again, using letter names of pitches. The letter names of starting pitches are as follows:
Example 3: (first e above middle C)
Example 4: (first e above middle C)
Example 5: (first e above middle C)

**THE STUDENT HEARS AND THEN SINGS**

14. Listen again to each melodic permutation, singing on “la” as you listen: Example 3–5.

**THE STUDENT SINGS WHILE LISTENING**

15. Listen and then play each melodic permutation by ear in the given key of A Major with the given starting note, using R.H. For Examples 3–5 the letter names of starting pitches are as follows:
Example 3:  (first e above middle C)
Example 4:  (first e above middle C)
Example 5:  (first e above middle C)

THE STUDENT HEARS THEN PLAYS

16. Play each melodic permutation by ear again along with the recording of the Left Hand (L.H.). The letter name of the starting pitch is:
   Example 3:  (first e above middle C)
   Example 4:  (first e above middle C)
   Example 5:  (first e above middle C)

THE STUDENT PLAYS WHILE LISTENING

17. Explore various melodic permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key.

18. Mentally image (“think”) a melodic permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

19. Sing your mentally-imaged melodic permutation on “la”.

20. Sing your melodic permutation again, using letter names of pitches.

21. Play your melodic permutation on the piano with your R.H. Continue to play until you are quite certain of it – until it is “natural” for you.

22. Play your R.H. melodic permutation along with the L.H. part that is played by the computer. In your folder in the computer, open the Beethoven 2 folder. Now, open the file labeled Example 6.

Example 6.
THE STUDENT PLAYS WHILE LISTENING

Example 6

Left Hand Only: Accompaniment Permutation in the Left Hand (L.H.)


THE STUDENT HEARS

Example 6

24. Listen to the L.H. accompaniment again and sing it on “la” in a comfortable range; sing all the notes in the L.H. chords, beginning with the bottom notes.

THE STUDENT HEARS

Example 6

25. Sing the L.H. accompaniment again using scale degree numbers; start on number 1, the first degree of the scale. Sing the bottom notes of the broken chords again using letter names of pitches; start on A below middle C.

THE STUDENT SINGS

26. As you listen a third time, mentally image the melody. Notice the harmony of the L.H. accompaniment as it blends with the melody you are mentally imaging. Typical of the style, melody pitches usually sound best with those pitches within the chords of the accompaniment.
THE STUDENT HEARS

Example 6


27. Listen to each of the L.H. permutations. In your folder in the computer, open the Beethoven 2 folder. Now, open the file labeled Example 7. Repeat this process for Examples 8 and 9.

Exercises 7–9.

THE STUDENT HEARS

Example 7

Example 8

Example 9

28. Listen to each accompaniment permutation again and tap the rhythm of each with your L.H. as you listen. Tap the rhythm of each permutation after you have finished listening.
THE STUDENT HEARS AND TAPS

29. Listen again to the accompaniment permutation, then sing it in a comfortable vocal range on “la”. Sing all pitches of the blocked chords, ascending from the bottom pitch upwards. The letter names of the starting pitches are:
   Example 7: A  (A below middle C)
   Example 8: e  (e above middle C)
   Example 9: A  (A below middle C)

THE STUDENT SINGS WHILE LISTENING

30. Play each L.H. permutation by ear in the key of A. The letter names of the starting pitches are:
   Example 7: A  (A below middle C)
   Example 8: e  (e above middle C)
   Example 9: A  (A below middle C)

31. Explore various accompaniment permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key. Remember that the goal is to create a permutation “in the style of” the master composer’s work.

32. Mentally image (“think”) an accompaniment permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

33. Try playing your own left hand permutation accompaniment along with the computer playing the R.H. part. In your folder in the computer, open the Beethoven 2 folder. Now, open the file labeled Example 10.

Example 10.

THE STUDENT LISTENS AND PLAYS

Example 10

\[\text{Music notation image}\]
Hands Together Instructional Strategies

34. Recall your invented melodic permutation, and connect it with your new accompaniment permutation. Play your permutation hands together three times. Listen carefully and evaluate how well the melodic permutation and the accompaniment permutation fit together.

35. Listen to the following acceptable permutation. In your folder in the computer, open the Beethoven 2 folder. Now, open the file labeled labeled Example 11.

Example 11.

THE STUDENT HEARS

The permutation is acceptable because it uses rhythmic, melodic and textural components similar to those used in the model (e.g., it uses the same chordal harmony as the model, it is in the same meter and key, it utilizes some of the rhythmic and melodic characteristics of the model, it uses a similar structural outline, the articulations and dynamics are within the range used in the model, the overall style is similar to that of the model, it generates a new sound within the guidelines, and utilizes new musical ideas not found in the musical model).

36. Listen to the following unacceptable permutation. In your folder in the computer, open the Beethoven 2 folder. Now, open the file labeled Example 12.

Example 12.

THE STUDENT HEARS
The permutation is unacceptable because it does not use rhythmic, melodic and textural components similar to those used in the model (e.g., it does not use the chordal harmony or textures of the model, it does not utilize enough of the rhythmic and melodic characteristics used in the model, it does not use articulations or dynamics used in the model, it generates a new sound, but not within the guidelines).

37. Now, recall and play your permutation hands together and record it in your file. Start by finding your folder (it will have your name on it) and proceed as follows:
   a) Open the folder with your name by double-clicking it.
   b) Look for file labeled Improvisation and double-click it.
   c) Think about what you are going to play. When you are ready, look at the standard recording controls at the bottom of the computer display.
   d) Click the recording control (circle) and start playing. (If, at any time you want to start over, click and hold on the Edit menu. Scroll down to Erase and release the button.
   e) When you are finished, click the stop control (square).
   f) For playback, click the single arrow to your right.
   g) To save your work, click and hold on the File menu at the top of your display. Now, scroll down to Save and release the mouse button.
   h) When you have saved your file, scroll down and release the button on Quit under the same menu. You are finished.

38. Listen to your permutation and evaluate it using the following questions:
   a) Does the permutation utilize similar textures and chordal harmony to those used in the model piece?
   b) Is the permutation in the meter of the original model?
   c) Is the permutation in the key of the original model?
d) Does the permutation utilize rhythmic characteristics which are evident in the given piano piece?
e) Does the permutation utilize melodic characteristics present in the model?
f) Does the permutation utilize a similar structural outline to that of the model?
g) Are the articulations used within the range used in the model?
h) Are the dynamics used within the range indicated in the model?
i) Is the overall style of the permutation similar to that of the model?
j) Does the permutation generate a new sound within the guidelines? Does it utilize new musical ideas not found in the musical model?

39. Use your evaluation (and your teacher's response to your efforts here) to inform your next permutation assignment.
Unit 11

As you follow the printed instructions, listen carefully to the aural examples, and trial exercises and new musical inventions.

1. Listen to the entire piano work, Mazurka in F Major, by Frédéric Chopin. In your folder in the computer, open the Chopin folder. Now, open the file labeled Mazurka and listen to the example.
Right Hand Only: Melodic Permutation in the Right Hand (R.H.)

2. Listen to the excerpt of the piano work, played hands together: In your folder in the computer, open the Chopin folder. Now, open the file labeled Example 1.

Example 1 (first eight measures).

THE STUDENT HEARS

Example 1

3. Listen again a second time; focus on the melody in the right hand.

THE STUDENT HEARS

Example 1
4. Listen to the R.H. melody played alone three times: In your folder in the computer, open the Chopin folder. Now, open the file labeled Example 2.

Example 2 (first eight measures).

**THE STUDENT HEARS**

![Example 2](image)

5. With eyes closed, sing the melody (top note in the chord) in a comfortable vocal range on “la”; start on c, the fifth degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**

6. Sing the melody (top note in the chord) again using scale degree numbers; start on C, in the key of F Major, the fifth degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**

7. Listen to the melody of the piano work again; sing the letter names of pitches while listening.

**THE STUDENT HEARS**

![Example 2](image)

8. Play the entire melody (top note in the chords) by ear on the piano in the key indicated, starting on C, the fifth degree of the F Major scale, C above middle C.

9. Listen to each of the melodic permutations for the right hand three times; they are each given aurally on the sound track. They include scale, five-finger, and other permutations typically found in Chopin’s piano music: In your folder in the computer, open the Chopin folder. Now, open the file labeled Example 3. Repeat this process for Examples 4 and 5.

Examples 3–5.

THE STUDENT HEARS

Example 3

Example 4

Example 5

10. Listen to each permutation again and tap the rhythm of each as you listen. Tap the rhythm of each permutation again after you have finished listening: Examples 3–5.

THE STUDENT HEARS AND TAPS, AND THEN TAPS AGAIN

11. With eyes closed, listen to each melodic permutation again and then sing it on “la”; repeat for each of the melodic permutations (top note in the chords): Examples 3–5.
THE Student Hears and Sings

12. Listen and sing each melodic permutation again, this time using scale degree numbers: For Examples 3–5, the scale degree numbers of the starting pitches are as follows:
   Example 3: 1 (fourth above middle C)
   Example 4: 3 (third above middle C)
   Example 5: 5 (octave above middle C)

THE Student Hears and Then Sings

13. Listen and then sing each permutation again (top note in the chords), using letter names of pitches. The letter names of starting pitches are as follows:
   Example 3: (f above middle C)
   Example 4: (a above middle C)
   Example 5: (c above middle C)

THE Student Hears and Then Sings

14. Listen again to each melodic permutation (top note in the chords), singing on “la” as you listen: Example 3–5.

THE Student Sings while Listening

15. Listen and then play each melodic permutation by ear in the given key of F Major with the given starting note, using R.H. For Examples 3–5 the letter names of starting pitches are as follows:
   Example 3: (f above middle C)
   Example 4: (a above middle C)
   Example 5: (c above middle C)

THE Student hears then plays
16. Play each melodic permutation by ear again along with the recording of the Left Hand (L.H.). The letter name of the starting pitch is:
Example 3: (f above middle C)
Example 4: (a above middle C)
Example 5: (c above middle C)

THE STUDENT PLAYS WHILE LISTENING

17. Explore various melodic permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key.

18. Mentally image (“think”) a melodic permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

19. Sing your mentally-imaged melodic permutation on “la”.

20. Sing your melodic permutation again, using letter names of pitches.

21. Play your melodic permutation on the piano with your R.H. Continue to play until you are quite certain of it – until it is “natural” for you.

22. Play your R.H. melodic permutation along with the L.H. part that is played by the computer. In your folder in the computer, open the Chopin folder. Now, open the file labeled Example 6.

Example 6.

THE STUDENT PLAYS WHILE LISTENING
Left Hand Only: Accompaniment Permutation in the Left Hand (L.H.)


THE STUDENT HEARS

Example 6

24. Listen to the L.H. accompaniment again and sing it on “la” in a comfortable range; sing all the notes in the L.H. chords beginning with the bottom note.

THE STUDENT HEARS

Example 6

25. Sing the L.H. accompaniment again using scale degree numbers; start on number 1, the first degree of the scale. Sing the L.H. accompaniment again using letter names of pitches; start on F below middle C.

THE STUDENT SINGS

26. As you listen a third time, mentally image the melody. Notice the harmony of the L.H. accompaniment as it blends with the melody you are mentally imaging. Typical of the style, melody pitches usually sound best with those pitches within the chords of the accompaniment.

THE STUDENT HEARS

Example 6

27. Listen to each of the L.H. permutations. In your folder in the computer, open the Chopin folder. Now, open the file labeled Example 7. Repeat this process for Examples 8 and 9.

Exercises 7–9.

THE STUDENT HEARS

Example 7

![Musical notation for Example 7]

Example 8

![Musical notation for Example 8]

Example 9

![Musical notation for Example 9]

28. Listen to each accompaniment permutation again and tap the rhythm of each with your L.H. as you listen. Tap the rhythm of each exercise after you have finished listening.

THE STUDENT HEARS AND TAPS

29. Listen again to the accompaniment permutation, then sing it in a comfortable vocal range on "la"; sing all pitches of the chords, ascending from the bottom pitch upwards. The letter names of the starting pitches are:
THE STUDENT SINGS WHILE LISTENING

30. Play each L.H. exercise by ear in the key of F Major. The letter names of the starting pitches are:
Example 7: F (F below middle C)
Example 8: F (F below middle C)
Example 9: F (F below middle C)

31. Explore various accompaniment permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key. Remember that the goal is to create a permutation “in the style of” the master composer’s work.

32. Mentally image (“think”) an accompaniment permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

33. Try playing your own left hand accompaniment permutation along with the computer playing the R.H. part. In your folder in the computer, open the Chopin folder. Now, open the file labeled Example 10.

THE STUDENT LISTENS AND PLAYS

Example 10
Hands Together Instructional Strategies

34. Recall your invented melodic permutation, and connect it with your new accompaniment permutation. Play your permutation, hands together, three times. Listen carefully and evaluate how well the melodic permutation and the accompaniment permutation fit together.

35. Listen to the following acceptable permutation. In your folder in the computer, open the Chopin folder. Now, open the file labeled labeled Example11.

Example 11.

THE STUDENT HEARS

The permutation is acceptable because it uses rhythmic, melodic and textural components similar to those used in the model (e.g., it uses the same chordal harmony as the model, it is in the same meter and key, it utilizes many of the rhythmic and melodic characteristics of the model, it uses a similar structural outline, the articulations and dynamics are within the range used in the model, the overall style is similar to that of the model, it generates a new sound within the guidelines, and utilizes new musical ideas not found in the musical model).

36. Listen to the following unacceptable permutation. In your folder in the computer, open the Chopin folder. Now, open the file labeled Example 12.

Example 12.

THE STUDENT HEARS
The permutation is unacceptable because it does not use rhythmic, melodic and textural components similar to those used in the model (e.g., it does not use the chordal harmony or textures of the model, it does not utilize enough of the rhythmic and melodic characteristics used in the model, it does not use articulations or dynamics used in the model, it generates a new sound, but not within the guidelines).

37. Now, recall and play your permutation hands together and record it in your file. Start by finding your folder (it will have your name on it) and proceed as follows:
   a) Open the folder with your name by double-clicking it.
   b) Look for file labeled Improvisation and double-click it.
   c) Think about what you are going to play. When you are ready, look at the standard recording controls at the bottom of the computer display.
   d) Click the recording control (circle) and start playing. (If, at any time you want to start over, click and hold on the Edit menu. Scroll down to Erase and release the button.
   e) When you are finished, click the stop control (square).
   f) For playback, click the single arrow to your right.
   g) To save your work, click and hold on the File menu at the top of your display. Now, scroll down to Save and release the mouse button.
   h) When you have saved your file, scroll down and release the button on Quit under the same menu. You are finished.

38. Listen to your permutation and evaluate it using the following questions:
   a) Does the permutation utilize similar textures and chordal harmony to those used in the model piece?
   b) Is the permutation in the meter of the original model?
   c) Is the permutation in the key of the original model?
   d) Does the permutation utilize rhythmic characteristics which are evident in the given piano piece?
   e) Does the permutation utilize melodic characteristics present in the model?
   f) Does the permutation utilize a similar structural outline to that of the model?
g) Are the articulations used within the range used in the model?
h) Are the dynamics used within the range indicated in the model?
i) Is the overall style of the permutation similar to that of the model?
j) Does the permutation generate a new sound within the guidelines?
   Does it utilize new musical ideas not found in the musical model?

39. Use your evaluation (and your teacher’s response to your efforts here) to inform your next permutation assignment.
Unit 12

As you follow the printed instructions, listen carefully to the aural examples, and trial exercises and new musical inventions.

1. Listen to the entire piano work, Toccata, by Dmitri Kabalevsky. In your folder in the computer, open the Kabalevsky folder. Now, open the file labeled Toccatina and listen to the example.

THE STUDENT HEARS
Right Hand Only: Melodic Permutation in the Left Hand (L.H.)

2. Listen to the excerpt of the piano work, played hands together: In your folder in the computer, open the Kabalevsky folder. Now, open the file labeled Example 1.

Example 1 (first twelve measures).

THE STUDENT HEARS

Example 1

3. Listen again a second time; focus on the melody in the left hand.

THE STUDENT HEARS

Example 1

4. Listen to the L.H. melody played alone three times: In your folder in the computer, open the Kabalevsky folder. Now, open the file labeled Example 2.

Example 2 (first twelve measures).

THE STUDENT HEARS

Example 2
5. With eyes closed, sing the melody in a comfortable vocal range on "la"; start on E, the fifth degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**

6. Sing the melody again using scale degree numbers; start on E, in the key of a minor, the fifth degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**

7. Listen to the melody of the piano work again; sing the letter names of pitches while listening.

**THE STUDENT HEARS**

![Example 2](image)

8. Play the entire melody by ear on the piano in the key indicated, starting on E, the fifth degree of the a minor scale, a sixth below middle C.


9. Listen to each of the melodic permutations for the left hand three times; they are each given aurally on the sound track. They include scale, five-finger, and other permutations typically found in Kabalevsky's piano music: In your folder in the computer, open the Kabalevsky folder. Now, open the file labeled Example 3. Repeat this process for Examples 4 and 5.

Examples 3–5.

**THE STUDENT HEARS**
10. Listen to each permutation again and tap the rhythm of each as you listen. Tap the rhythm of each permutation again after you have finished listening: Examples 3–5.

**THE STUDENT HEARS AND TAPS, AND THEN TAPS AGAIN**

11. With eyes closed, listen to each melodic permutation again and then sing it on “la”; repeat for each of the melodic permutations: Examples 3–5.

**THE STUDENT HEARS AND SINGS**

12. Listen and sing each melodic permutation again, this time using scale degree numbers: For Examples 3–5, the scale degree numbers of the starting pitches are as follows:
   - Example 3: 5 (sixth below middle C)
   - Example 4: 5 (sixth below middle C)
   - Example 5: 5 (sixth below middle C)

**THE STUDENT HEARS AND THEN SINGS**
13. Listen and then sing each permutation again, using letter names of pitches. The letter names of starting pitches are as follows:
Example 3: (e below middle C)
Example 4: (e below middle C)
Example 5: (e below middle C)

THE STUDENT HEARS AND THEN SINGS

14. Listen again to each melodic permutation, singing on “la” as you listen:
Example 3–5.

THE STUDENT SINGS WHILE LISTENING

15. Listen and then play each melodic permutation by ear in the given key of a Minor with the given starting note, using L.H. For Examples 3–5 the letter names of starting pitches are as follows:
Example 3: (e below middle C)
Example 4: (e below middle C)
Example 5: (e below middle C)

THE STUDENT HEARS THEN PLAYS

16. Play each melodic permutation by ear again along with the recording of the Right Hand (R.H.). The letter name of the starting pitch is:
Example 3: (e below middle C)
Example 4: (e below middle C)
Example 5: (e below middle C)

THE STUDENT PLAYS WHILE LISTENING

17. Explore various melodic permutation ideas, twelve measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key.

18. Mentally image (“think”) a melodic permutation of your own, one that is twelve measures in length, in the same meter and key as the musical model.
19. Sing your mentally-imaged melodic permutation on “la”.

20. Sing your melodic permutation again, using letter names of pitches.

21. Play your melodic permutation on the piano with your L.H. Continue to play until you are quite certain of it — until it is “natural” for you.

22. Play your L.H. melodic permutation along with the R.H. part that is played by the computer. In your folder in the computer, open the Kabalevsky folder. Now, open the file labeled Example 6.

Example 6.

THE STUDENT PLAYS WHILE LISTENING

Left Hand Only: Accompaniment Permutation in the Right Hand (R.H.)


THE STUDENT HEARS

24. Listen to the R.H. accompaniment again and sing it on “la” in a comfortable range; sing all the notes in the R.H. chords beginning with the bottom note.

THE STUDENT HEARS
25. Sing the R.H. accompaniment again using scale degree numbers; start on number 3, the third degree of the scale. Sing the R.H. accompaniment again using the letter names of pitches; start on middle C; sing all the notes in the R.H. chords beginning with the bottom note.

THE STUDENT SINGS

26. As you listen a third time, mentally image the melody. Notice the harmony of the R.H. accompaniment as it blends with the melody you are mentally imaging. Typical of the style, melody pitches usually sound best with those pitches within the chords of the accompaniment.

THE STUDENT HEARS


27. Listen to each of the R.H. permutations. In your folder in the computer, open the Kabalevsky folder. Now, open the file labeled Example 7. Repeat this process for Examples 8 and 9.

Exercises 7–9.

THE STUDENT HEARS
28. Listen to each accompaniment permutation again and tap the rhythm of each with your L.H. as you listen. Tap the rhythm of each permutation after you have finished listening.

THE STUDENT HEARS AND TAPS

29. Listen again to the accompaniment permutation, then sing it in a comfortable vocal range on "la"; sing top notes of chords only. The letter names of the starting pitches are:

Example 7: E above middle C  
Example 8: A above middle C  
Example 9: A above middle C

THE STUDENT SINGS WHILE LISTENING

30. Play each L.H. permutation by ear in the key of F Major. The letter names of the starting pitches are:

Example 7: E above middle C  
Example 8: A above middle C  
Example 9: A above middle C
31. Explore various accompaniment permutation ideas, twelve measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key. Remember that the goal is to create a permutation “in the style of” the master composer’s work.

32. Mentally image (“think”) an accompaniment permutation of your own, one that is twelve measures in length, in the same meter and key as the musical model.

33. Try playing your own R.H. accompaniment permutation along with the computer playing the L.H. part. In your folder in the computer, open the Kabalevsky folder. Now, open the file labeled Example 10.

Example 10.

**THE STUDENT LISTENS AND PLAYS**

![Example 10](image)

**Hands Together Instructional Strategies**

34. Recall your invented melodic permutation, and connect it with your new accompaniment permutation. Play your permutation, hands together, three times. Listen carefully and evaluate how well the melodic permutation and the accompaniment permutation fit together.

35. Listen to the following acceptable permutation. In your folder in the computer, open the Kabalevsky folder. Now, open the file labeled labeled Example 11.

Example 11.

**THE STUDENT HEARS**
Example 11

The permutation is acceptable because it uses rhythmic, melodic and textural components similar to those used in the model (e.g., it uses the same chordal harmony as the model, it is in the same meter and key, it utilizes many of the rhythmic and melodic characteristics of the model, it uses a similar structural outline, the articulations and dynamics are within the range used in the model, the overall style is similar to that of the model, it generates a new sound within the guidelines, and utilizes new musical ideas not found in the musical model).

36. Listen to the following unacceptable permutation. In your folder in the computer, open the Kabalevsky folder. Now, open the file labeled Example 12.

Example 12.

THE STUDENT HEARS

Example 12

The permutation is unacceptable because it does not use rhythmic, melodic and textural components similar to those used in the model (e.g., it does not use the chordal harmony or textures of the model, it does not utilize a L.H. melody as does the model. Although it uses 2/4 meter, it does not use the rhythmic characteristics used in the model, it does not use articulations or dynamics used in the model, it generates a new sound, but not within the guidelines).

37. Now, recall and play your permutation hands together and record it in your file. Start by finding your folder (it will have your name on it) and proceed as follows:
   a) Open the folder with your name by double-clicking it.
   b) Look for file labeled Improvisation and double-click it.
c) Think about what you are going to play. When you are ready, look at the standard recording controls at the bottom of the computer display.

d) Click the recording control (circle) and start playing. (If, at any time you want to start over, click and hold on the Edit menu. Scroll down to Erase and release the button.

e) When you are finished, click the stop control (square).

f) For playback, click the single arrow to your right.

g) To save your work, click and hold on the File menu at the top of your display. Now, scroll down to Save and release the mouse button.

h) When you have saved your file, scroll down and release the button on Quit under the same menu. You are finished.

38. Listen to your permutation and evaluate it using the following questions:

   a) Does the permutation utilize similar textures and chordal harmony to those used in the model piece?
   b) Is the permutation in the meter of the original model?
   c) Is the permutation in the key of the original model?
   d) Does the permutation utilize rhythmic characteristics which are evident in the given piano piece?
   e) Does the permutation utilize melodic characteristics present in the model?
   f) Does the permutation utilize a similar structural outline to that of the model?
   g) Are the articulations used within the range used in the model?
   h) Are the dynamics used within the range indicated in the model?
   i) Is the overall style of the permutation similar to that of the model?
   j) Does the permutation generate a new sound within the guidelines? Does it utilize new musical ideas not found in the musical model?

39. Use your evaluation (and your teacher’s response to your efforts here) to inform your next permutation assignment.
Chapter VI
Summary and Discussion

Summary

The inability of many intermediate level piano students to listen analytically, to think in musically inventive ways, and to experiment with the melodic motifs and accompaniment patterns--permutations--of standard piano works led to the development of Permutations of Standard Piano Works: A Curriculum for the Development of Student Musicianship. Various ways of knowledge construction (Vallance, 1982) are employed in this curriculum, including: 1) Listening to whole musical works, excerpts from these works, permutation exercises, and acceptable and unacceptable permutation models, 2) Vocalizing (singing and chanting) melodies, accompaniment patterns, and exercises, 3) Playing melodies, accompaniment patterns and exercises by ear that are presented aurally, without notation present, 4) Tapping rhythmic patterns, 5) Exploring one's own ideas with right, left, and both hands, 6) Practicing melodic and rhythmic motifs and harmonic chord progressions and, 7) Evaluating one's own permutation. Technology plays a central part in this curriculum, in making the learning task more efficient and enjoyable for the student and the teacher. The student is provided with a real learning situation, in which he or she integrates many components of musicianship, in creating permutations of standard piano works from various style periods and composers.

Comprehensive Musicianship, the prominent curricular design for musical study in collegiate and pre-collegiate programs, was influential in the development of this curriculum in several ways. First, it provided a model for the development of aural skills leading to improved musicianship, and concurrently, a model for students' better understanding of musical structure. Comprehensive Musicianship
enhanced students’ ability to create musically because of their increased understanding of the relationships among components of basic musicianship. The components of basic musicianship include experiences in and understanding of analysis, composition and improvisation, and performance. Students’ increased skill in creating permutations of works may well transfer to increased skill in the performance of other piano works, and even, improvisation. At least, this is in keeping with the Comprehensive Musicianship program, and was viewed as a plausible outcome of this curriculum.

In the design of the curriculum, existing pedagogical resources were examined for their usefulness and application to the project. Among these, the approach of Hilley and Olson’s (1986) class piano text, using “classical” piano literature models for improvisation assignments and taped, aurally-presented accompaniments for play-along activities, was instructive for the current project. Hilley and Olson’s text gave notation for one twentieth century composition and instructed the student to improvise a 16-measure piece in the style of the given piece. This assignment was given to the student as part of a unit near the end of the text, with no specific instructions as to how to approach the task.

In contrast to Hilley and Olson’s approach, the current curriculum presents aurally on the computer twelve complete piano pieces, excerpts, and permutation exercises, with no notation present, and allows for the student to interact with the computer as he or she proceeds step by step through a carefully planned instructional sequence leading to the student’s own permutations, each one in the style of a specific model. The student evaluates his or her responses while progressing through the curriculum.

A review of pedagogical approaches to improvisation indicated the need for materials 1) to assist students in thinking more analytically and inventively
about the styles of the repertoire which they study, and 2) to assist students to be less notation-bound, in order to develop and utilize their listening skills.

Six dissertations particularly relevant to improvisation training provided a wealth of technical and instructional strategies. The following strategies emerged as key in *Permutations of Standard Piano Works: A Curriculum for the Development of Student Musicianship*: listening to whole works, excerpts, and permutation exercises; vocalizing (singing and chanting); playing melodies, excerpts, and permutations by ear; tapping rhythmic permutations; exploring one’s own ideas (right, left, and both hands); practicing melodic and rhythmic motifs and harmonic chord progressions; and evaluating one’s own permutation (see Chapter IV for more complete discussion).

**Development and Description of the Curriculum**

The development of this piano permutations curriculum was a dynamic process which evolved over a period of several years. This process involved learning the use of music technology to facilitate both the development of the curriculum itself, and to provide the student with a context, in a music technology lab, in which to progress through the various steps of the curriculum. The need for this curriculum was established through the literature review and from observations based on many years of experience in piano teaching at various levels.

**Validation of the Curriculum**

This curriculum will need to be validated to test its effectiveness as a viable means of developing not only analytical and creative–expressive skills, but also overall musicianship. While most parts of the instructional sequence contained within the curriculum have been sampled through instruction (often resulting in considerable revision), no systematic inquiry has yet been undertaken as to its
potential for the musical enrichment of piano students. Research might be initiated to determine the use of the curriculum with individual piano students in a lab or in private lesson settings, or in a class piano situation. The length of time to progress through the entire curriculum, or individual “lessons,” might be tested. The effects of a teacher’s monitoring and evaluation as compared to the independent use of the curriculum by students might be controlled and studied. Although the curriculum is aurally-based, perhaps notation might be allowed for a certain few phases of the instruction (such as the initial exposure of the student to the complete piece). After testing the curriculum systematically in real teaching situations, further revisions may be necessary before advocacy and dissemination to particular student populations can be undertaken. Dissemination might then be more confidently undertaken, to individual and class piano instructors at both university and pre-university levels. As a part of dissemination, the curriculum may be presented for publication or demonstration and discussion at professional meetings of piano teachers.

The Role of Technology in the Use of the Curriculum

The use of music technology in developing this curriculum has provided opportunity for the student sitting at a work station to manipulate a “mouse” in order to hear the aural examples, and to respond in various musical ways in understanding and playing with the twelve musical works.

The capability of current music technology demonstrated in this project has been critical to the underlying philosophy of this aurally-based curriculum. The advantages of using music technology in developing and implementing the curriculum suggest that technology may have an important role to play in teaching musical understanding and developing the array of skills inherent in musicianship: harmonization, transposition, playing by ear, vocalization, and musical invention.
Based on the development of this curriculum, there is reason to believe that there is a need for the further development of effective educational music software programs for use in a broad range of piano instruction. These programs will require persons knowledgeable in piano literature and pedagogy, in order that appropriate instructional sequences can be provided. Interactive computer technology--i.e. technology with which the student may access any part of the curriculum instantly, proceed to interact as directed, and go back and forth between sections--will no doubt have an important role to play in curricular development in the future. In addition to the access functions of interactive computer technology described above, the student might also access a range of information related to the topic or concepts being presented, through a click of the mouse. For example, based on this curriculum, a CD Rom (compact disk containing aural and visual data) might be made which would provide background information from this dissertation, or other written, aural, or graphic information related to musicianship, through a click of the mouse on a particular icon (visual symbol) which would appear on the display screen.

**Expansion of the Curriculum**

Expansion of the curriculum to include additional piano literature by the same composers may be useful in assisting the student in more fully understanding the style of the composer, as demonstrated in a range of his compositions. Piano pieces by other composers (such as Clementi, Schubert, Grieg, and Shostakovich who have written literature for young pianists, and with whose styles intermediate level students might be familiar) might be added to broaden the students' understanding of literature from the various stylistic eras, through inventing permutations of the works.
Traditional piano instruction has often been limited to learning to read notation through focusing on Western European art music only. Giving students opportunities to hear, and play with other music (folk, sacred, blues, gospel, pop, and rock) may provide motivation for some students who might otherwise be tempted to discontinue their study of piano. Students may find added enjoyment in their music study through learning to create new musical inventions based on familiar melodies and styles.

**Permutations of Standard Piano Works: A Curriculum for the Development of Student Musicianship** might be adapted for piano teachers who do not have access to the music technology described in this curriculum. A cassette tape containing the aurally presented pieces, excerpts, and exercises may provide an aural option to the use of the computer-generated sound. This tape might be used with the instructional manual which the student sees, and the use of a second tape to record the students’ improvisations for evaluation. A means for the evaluation of students’ permutations without a teacher present would need to be developed. (One option might be for the student to tape his or her permutations to be given to an instructor to be evaluated at a later time, even though the instructor is not present for the instructional period). Again, the effectiveness of the results of this modified approach will need to be evaluated.

This dissertation describes the development of a curriculum of instruction for the improvement of student musicianship. It is hoped that its emphasis on aural skill development, leading to permutations of various works in various styles, and its use of music technology, will encourage piano instructors to incorporate the technique of musical invention--permutations--into their teaching, and make musical learning more enjoyable for students.
REFERENCES


Gauldin, R. (no date). Unpublished manuscript. MENC Historical Center, McKeldin Library, University of Maryland-- College Park (File 3, Drawer 2, Folder 20).


Miller, M. (no date). The Changing Role of the Piano Teacher. Unpublished manuscript, MENC Historical Center, McKeldin Library, University of Maryland, College Park (File 3, Drawer 2, Folder 20).


Vinton, R. (no date). Unpublished manuscript. MENC Historical Center, McKeldin Library, University of Maryland -- College Park (File 3, Drawer 2, Folder 20).


Appendix

Permutations of Standard Piano Works: A Curriculum for the Development of Student Musicianship

Student Manual

The Curriculum

As an intermediate level piano student, you can improve your own basic musicianship, and your understanding of musical style and structure by the permutations (or variations, or transformations) you explore, and by the permutations of these works which you yourself invent. Permutations of Standard Piano Works: A Curriculum for the Development of Student Musicianship is designed to assist you in learning more thoroughly the components of standard piano works. It will assist you in listening analytically to musical structures of selected piano works, and to create new musical configurations of these works with confidence and personal satisfaction.

Much emphasis in piano instruction has been placed upon learning to read music. While learning to read music is necessary, it is the additional aim of this curriculum to emphasize aural learning. The twelve musical works, excerpts from these works, and permutations based on these works are presented aurally by the computer. A MIDI keyboard generated sound track contains the musical works, excerpts, and exercises essential to the effectiveness of this curriculum. The MIDI keyboard will generate the sound through the computer of the musical excerpts to be used in this curriculum. When you hear the excerpts, you will be invited to listen, vocalize, play, and to invent new musical ideas based upon the music that is presented aurally. Each time you respond by singing or playing, you will evaluate your response: Was your response similar to the given melodic motif or
accompaniment pattern? Was it exactly the same as the given model? If not, try again until you succeed in imitating the model as closely as possible.

One permutation for each work will be saved on a computer in a personal folder as you progress through this curriculum. A “work station” at which you will be located while pursuing this consists of 1) a MIDI keyboard, attached to 2) a Macintosh computer, connected by 3) MIDI cables and a MIDI interface. With sequencing software, the computer records and plays back your final permutations created from the MIDI keyboard. (See Figure 1)

*Permutations of Standard Piano Works: A Curriculum for the Development of Student Musicianship* will make its greatest impact when you monitor your own work, as your self-evaluation is an integral part of the curriculum. The emphasis of this experience is on increasing your musical skills and understanding through the process of listening, performing, and creating.

The following definitions of terms will help you in your progress through the curriculum:

**Improvisation**: The musical by-product of a creative process attributed to the individual who can generate a new sound within the framework of a given musical style. It requires that the performer know the rules of the musical tradition, genre, or even particular work. Improvisation has been variously defined, and encompasses a spectrum from expressive re-creation of the music to a re-configuration of musical components—hence, a new musical work.

**Intermediate level**: To assume that the student has aural/listening skills, basic technical skills, and basic music reading skills, acquired through three to five years of piano instruction; to assume that the student can sightread with ease at a level below the regular repertoire performance level, and can perform literature musically within a given style, and can analyze and determine the form and
structure of literature studied. Intermediate level competencies include the ability to: 1) Sight-read repertoire and accompaniments beyond the elementary level, 2) Transpose repertoire and simple accompaniments to closely related keys, 3) Play chord progressions using secondary chords and secondary dominants in major and minor keys, 4) Harmonize melodies with secondary chords and secondary dominants using simple accompaniment style and, 5) Create second parts to solo piano repertoire based on analysis of theoretical concepts. All of the preceding should be related to the students’ study of theory, technique, and repertoire (Uszler et al., 1991).

Mentally image: To form a mental representation or picture of a musical idea (not necessarily a mental representation or picture of the score).

Permutations: Variation or the limited transformation of the melody and accompaniment patterns of standard piano works in which certain pitches or rhythms are changed while still retaining the “spirit” and character of the piece. In a spectrum of creative musical thinking, permutation is at a distant point from free improvisation, in that the principal musical components restrict the performer from developing beyond the structures provided. Permutations within the curriculum aid the student’s comprehension of the musical style and structure of a work. It is both an instructional strategy for understanding the work—an end in itself, and a personal expression and playful interpretation of the work.

Play by ear: To play the piano without reference to notation, using the ear as the guide; this is not the same as playing a piece by memory.

Style: The musical choices that a composer or performer makes from among the possibilities available (Randel, 1986). It may refer to features that characterize the works of an individual composer, or it may also distinguish an individual work from other works by the same composer.
One end-product of Permutations of Standard Piano Works: A Curriculum for the Development of Student Musicianship is to invent a parallel musical work in the style of the model. You should follow these guideline questions as closely as possible, in order that your own musical permutation can be a careful balance of the features of the model piece with your own expressive possibilities.

a) Does the permutation utilize similar textures and chordal harmony to those used in the model piece?
b) Is the permutation in the meter of the original model?
c) Is the permutation in the key of the original model?
d) Does the permutation utilize rhythmic characteristics which are evident in the given piano piece?
e) Does the permutation utilize melodic characteristics present in the model?
f) Does the permutation utilize a similar structural outline to that of the model?
g) Are the articulations used within the range used in the model?
h) Are the dynamics used within the range indicated in the model?
i) Is the overall style of the permutation similar to that of the model?
j) Does the permutation generate a new sound within the guidelines?
k) Does it utilize new musical ideas not found in the musical model?

A reminder: See Figure 1 for a graphic of the “MIDI Workstation” indicating the equipment you will be using for progressing through this curriculum (computer, computer display, computer keyboard, mouse, MIDI keyboard). See Figure 2 for a graphic of the computer display which you will use for listening and recording.

Technicalities: How to use this Manual

The instructional strategies employed within this curriculum match the critical musical goals of analytical listening and creative and expressive development of structural features of the selected piano literature. The same instructional sequence is used throughout the curriculum, for all twelve musical works. As you follow the printed instructions, listen carefully to the aural
examples, and trial exercises and new musical inventions. Throughout this curriculum you will be instructed to listen to several examples leading to a recording of your own permutation. The following steps will allow you to “listen” to an example (or listen while playing):

a) Open the folder with your name by double–clicking it.
b) Look for the Beethoven 1 folder and open it. Now, open the name of the file you want to hear (e.g. Ex 1, Ex 2)
c) When it opens, look toward the bottom of the display and notice the recording controls (see Figure 2).
d) Click the Play control the (the arrow in the middle) and the music will sound
e) To replay, click the arrow again. You may wish to replay examples more times than indicated. The number given is the minimum number to be played.
f) When finished, click and hold on the File menu at the top left of your display. Now, scroll down to Quit and release the mouse button. You are finished.

The following steps will allow you to record your permutation:

a) Open the folder with your name by double–clicking it.
b) Look for the appropriate composer's folder, then open the file labeled Improvisation and double–click it
c) Think about what you are going to play. When you are ready, look at the standard recording controls at the bottom of the computer display.
d) Click the recording control (circle) and start playing. (If, at any time you want to start over, click and hold on the Edit menu. Scroll down to Erase and release the button.
e) When you are finished, click the stop control (square).
f) For playback, click the single arrow to your right.
g) To save your work, click and hold on the File menu at the top of your display. Now, scroll down to Save and release the mouse button.
h) When you have saved your file, scroll down and release the button on Quit under the same menu. You are finished.

You may now proceed to the curriculum.
Permutations of Standard Piano Works: A Curriculum for the Development of Student Musicianship

Unit 1

As you follow the printed instructions, listen carefully to the aural examples, and trial exercises and new musical inventions.

1. Listen to the entire piano work, Romanze from Sonatina in G Major, by Ludvig van Beethoven. In your folder in the computer, open the Beethoven 1 folder. Now, open the file labeled Romanze and follow the above steps for listening to this example.

THE STUDENT HEARS

Right Hand Only: Melodic Permutation in the Right Hand (R.H.)

2. Listen to the excerpt of the piano work, played hands together: In your folder in the computer, open the Beethoven 1 folder. Now, open the file labeled Example 1.
   a) Click the Play control (the arrow to your right).
   b) To replay, click the arrow again.
   c) When finished, click and hold on the File menu at the top left of your display. Now, scroll down to Quit and release the mouse button. You are finished.

Example 1 (first eight measures).

THE STUDENT HEARS

3. Listen again a second time; focus on the melody in the right hand.

THE STUDENT HEARS

4. Listen to the R.H. melody played alone three times: In your folder in the computer, open the Beethoven 1 folder. Now, open the file labeled Example 2.
   a) Click the Play control (the arrow to your right).
   b) To replay, click the arrow again.
   c) When finished, click and hold on the File menu at the top left of your display. Now, scroll down to Quit and release the mouse button. You are finished.
Example 2 (first eight measures).

THE STUDENT HEARS

5. With eyes closed, sing the melody in G Major in a comfortable octave range using “la”; start on b, the third degree of the scale, and slowly continue through the melody.

THE STUDENT SINGS

6. Sing the melody again at a slow tempo using scale degree numbers; start on “3”, in the key of G, the third degree of the scale, and slowly continue through the melody.

THE STUDENT SINGS

7. Listen to the melody of the piano work again at a slow tempo; sing the letter names of the pitches while listening.

THE STUDENT HEARS AND SINGS

8. Play the entire melody by ear on the piano in the key indicated, starting on b, the third degree of the G Major scale, above middle C.


9. Listen to each of the melodic permutations for the right hand three times; they are each given aurally on the sound track. They include scale, five-finger, and other permutations typically found in Beethoven’s piano music: In your folder in the computer, open the Beethoven 1 folder. Now, open the file labeled Example 3.
   a) Click the Play control (the arrow to your right).
   b) To replay, click the arrow again.
   c) When finished, click and hold on the File menu at the top left of your display. Now, scroll down to Quit and release the mouse button. You are finished.

Repeat this process for Examples 4 and 5.

Examples 3–5.

THE STUDENT HEARS
10. Listen again and tap the rhythm of each melodic permutation, not the pulse, as you listen. You will hear a rhythmic cue to help you know when to begin. Tap the rhythm of each permutation again after you have finished listening: Examples 3–5.

THE STUDENT HEARS AND TAPS, AND THEN TAPS AGAIN

11. With eyes closed, listen to the melodic permutation again and then sing it on "la"; repeat for each of the melodic permutations: Examples 3–5.

THE STUDENT HEARS AND SINGS

12. Listen and sing each melodic permutation again, this time using scale degree numbers: For Examples 3–5, the scale degree numbers of the starting pitches are as follows:
   Example 3: (second d above middle C)
   Example 4: (d above middle C)
   Example 5: (second d above middle C)

THE STUDENT HEARS AND THEN SINGS

13. Listen and then sing each permutation again, using letter names of pitches. The letter names of starting pitches are as follows:
   Example 3: (second d above middle C)
   Example 4: (d above middle C)
   Example 5: (second d above middle C)

THE STUDENT HEARS AND THEN SINGS

14. Listen again to each melodic permutation, singing on "la" Example 3–5.

THE STUDENT SINGS WHILE LISTENING

15. Listen and then play each melodic permutation by ear in the given key of G Major with the given starting note, using R.H. For Examples 3–5 the letter names of starting pitches are as follows:
   Example 3: (second d above middle C)
   Example 4: (d above middle C)
   Example 5: (second d above middle C)

THE STUDENT HEARS THEN PLAYS
16. Play each melodic permutation by ear again along with the recording of the Left Hand (L.H.). The letter name of the starting pitch is:
Example 3: d (second d above middle C)
Example 4: d (d above middle C)
Example 5: d (second d above middle C)

THE STUDENT PLAYS WHILE LISTENING

17. Explore various melodic ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key.

18. Mentally image ("think") a melodic permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

19. Sing your mentally-imaged melodic permutation on "la".

20. Sing your melodic permutation again, using letter names of pitches.

21. Play your melodic permutation on the piano with your R.H. Continue to play until you are quite certain of it — until it is "natural" for you.

22. Play your R.H. melodic permutation along with the L.H. part that is played by the computer. In your folder in the computer, open the Beethoven 1 folder. Now, open the file labeled Example 6.
   a) Click the Play control (the arrow to your right).
   b) To replay, click the arrow again.
   c) When finished, click and hold on the File menu at the top left of your display. Now, scroll down to Quit and release the mouse button. You are finished.

Example 6.

THE STUDENT PLAYS WHILE LISTENING

Left Hand Only: Accompaniment Permutation in the Left Hand (L.H.)


THE STUDENT HEARS
24. Listen to the L.H. accompaniment again and sing it on “la” in a comfortable range; sing the bottom notes of the broken chords (the bass notes that sound on the pulse).

THE STUDENT HEARS

25. Sing the bottom notes of the broken chords again using scale degree numbers; start on number 1, the first degree of the scale. Sing the bottom notes of the broken chords again using letter names of pitches; start on G.

THE STUDENT SINGS

26. As you listen a third time, mentally image the melody. Notice the harmony of the L.H. accompaniment as it blends with the melody you are mentally imaging. Typical of the style, melody pitches usually sound best with those pitches within the chords of the accompaniment.

THE STUDENT HEARS


27. Listen to each of the L.H. permutations. In your folder in the computer, open the Beethoven 1 folder. Now, open the file labeled Example 7.
   a) Click the Play control (the arrow to your right).
   b) To replay, click the arrow again.
   c) When finished, click and hold on the File menu at the top left of your display. Now, scroll down to Quit and release the mouse button. You are finished.

Repeat this process for Examples 8 and 9.

Exercises 7–9.

THE STUDENT HEARS

28. Listen to each accompaniment permutation again and tap the rhythm of each with your L.H. as you listen. Tap the rhythm of each exercise after you have finished listening.

THE STUDENT HEARS AND TAPS
29. Listen again to the L.H. accompaniment permutations, then sing the three pitches in the broken chords in a comfortable vocal range on “la”. Sing both pitches of the blocked chords, ascending from the bottom pitch upwards. The letter names of the starting pitches are:
Example 7: G (first G below middle C)
Example 8: G (first G below middle C)
Example 9: G (first G below middle C)

THE STUDENT SINGS WHILE LISTENING

30. Play each L.H. permutation by ear in the key of G. The letter names of the starting pitches are:
Example 7: G (first G below middle C)
Example 8: G (first G below middle C)
Example 9: G (first G below middle C)

31. Explore various accompaniment permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key. Remember that the goal is to create a permutation “in the style of” the master composer’s work.

32. Mentally image (“think”) an accompaniment permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

33. Try playing your own left hand improvised accompaniment permutation along with the computer playing the R.H. part. In your folder in the computer, open the Beethoven 1 folder. Now, open the file labeled 10.
   a) Click the Play control (the arrow to your right).
   b) To replay, click the arrow again.
   c) When finished, click and hold on the File menu at the top left of your display. Now, scroll down to Quit and release the mouse button. You are finished.

Example 10.

THE STUDENT LISTENS AND PLAYS

Hands Together Instructional Strategies

34. Recall your invented melodic permutation, and connect it with your new accompaniment permutation. Play your permutation, hands together, three times. Listen carefully and evaluate how well the melodic permutation and the accompaniment permutation fit together.
35. Listen to the following acceptable permutation. In your folder in the computer, open the Beethoven 1 folder. Now, open the file labeled Example 11.
   a) Click the Play control (the arrow to your right).
   b) To replay, click the arrow again.
   c) When finished, click and hold on the File menu at the top left of your display. Now, scroll down to Quit and release the mouse button. You are finished.

Example 11.

THE STUDENT HEARS

The permutation is acceptable because it uses rhythmic, melodic and textural components similar to those used in the model (e.g., it uses the same chordal harmony as the model, it is in the same meter and key as the model, it utilizes some of the rhythmic and melodic characteristics of the model, it uses a similar structural outline to that of the model, the articulations and dynamics are within the range used in the model, the overall style is similar to that of the model, it generates a new sound within the guidelines, and utilizes new musical ideas not found in the musical model).

36. Listen to the following unacceptable permutation. In your folder in the computer, open the Beethoven 1 folder. Now, open the file labeled Example 12.
   a) Click the Play control (the arrow to your right).
   b) To replay, click the arrow again.
   c) When finished, click and hold on the File menu at the top left of your display. Now, scroll down to Quit and release the mouse button. You are finished.

Example 12.

THE STUDENT HEARS

The permutation is unacceptable because it does not use rhythmic, melodic and textural components similar to those used in the model (e.g., it does not use the chordal harmony or textures of the model, it does not utilize rhythmic and melodic characteristics used in the model, it does not use articulations or dynamics used in the model, it generates a new sound, but not within the guidelines).
37. Now, recall and play your permutation hands together and record it in your file. Start by finding your folder (it will have your name on it) and proceed as follows:
   a) Open the folder with your name by double-clicking it.
   b) Look for folder labeled Improvisation and double-click it.
   c) Open the file labeled #1. When you are ready to record, look at the recording symbols at the bottom of the display.
   d) Click the recording control (circle) and start playing. (If, at any time you want to start over, click and hold on the Edit menu. Scroll down to Erase and release the button.
   e) When you are finished, click the stop control (square).
   f) For playback, click the single arrow to your right.
   g) To save your work, click and hold on the File menu at the top of your display. Now, scroll down to Save and release the mouse button.
   h) When you have saved your file, scroll down and release the button on Quit under the same menu. You are finished.

38. Listen to your permutation and evaluate it using the following questions:
   a) Does the permutation utilize similar textures and chordal harmony to those used in the model piece?
   b) Is the permutation in the meter of the original model?
   c) Is the permutation in the key of the original model?
   d) Does the permutation utilize rhythmic characteristics which are evident in the given piano piece? (e.g., tempo)
   e) Does the permutation utilize melodic characteristics present in the model?
   f) Does the permutation utilize a similar structural outline to that of the model?
   g) Are the articulations used within the range used in the model?
   h) Are the dynamics used within the range indicated in the model?
   i) Is the overall style of the permutation similar to that of the model?
   j) Does the permutation generate a new sound within the guidelines? Does it utilize new musical ideas not found in the musical model?

39. Use your evaluation (and your teacher's response to your efforts here) to help you with your next permutation assignment.
As you follow the printed instructions, listen carefully to the aural examples, and trial exercises and new musical inventions.

1. Listen to the entire piano work, *Evening at the Village* from Ten Easy Piano Pieces, by Béla Bartók. In your folder in the computer, open the Bartók 1 folder. Now, open the file labeled Evening at the Village.

**THE STUDENT HEARS**

**Right Hand Only: Melodic Permutation in the Right Hand (R.H.)**

2. Listen to the excerpt of the piano work, played hands together: In your folder in the computer, open the Bartók 1 folder. Now, open the file labeled Example 1.

   Example 1 (first ten measures).

**THE STUDENT HEARS**

3. Listen again a second time; focus on the melody in the right hand.

**THE STUDENT HEARS**

4. Listen to the R.H. melody played alone three times: In your folder in the computer, open the Bartók 1 folder. Now, open the file labeled Example 2.

   Example 2 (first ten measures).

**THE STUDENT HEARS**

5. With eyes closed, sing the melody in a comfortable vocal range on “la”; start on d, the seventh degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**

6. Sing the melody again using scale degree numbers; start on “7”, in the key of e minor, the seventh degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**
7. Listen to the melody of the piano work again; sing the letter names of pitches while listening.

THE STUDENT HEARS

8. Play the entire melody by ear on the piano in the key indicated, starting on d, the seventh degree of the e minor scale, above middle C.


9. Listen to each of the melodic permutations for the right hand three times; they are each given aurally on the sound track. They include scale, five-finger, and other permutations typically found in Bartók's piano music. In your folder in the computer, open the Bartók 1 folder. Now, open the file labeled Example 3. Repeat this process for Examples 4 and 5.

Examples 3–5.

THE STUDENT HEARS

10. Listen to each permutation again and tap the rhythm of each as you listen. Tap the rhythm of each permutation again after you have finished listening: Examples 3–5.

THE STUDENT HEARS AND TAPS, AND THEN TAPS AGAIN

11. With eyes closed, listen to the melodic permutation again and then sing it on "la"; repeat for each of the melodic permutations: Examples 3–5.

THE STUDENT HEARS AND SINGS

12. Listen and sing each melodic permutation again, this time using scale degree numbers: For Examples 3–5, the scale degree numbers of the starting pitches are as follows:
   Example 3: 1  (second e above middle C)
   Example 4: 3  (g above middle C)
   Example 5: 1  (second e above middle C)

THE STUDENT HEARS AND THEN SINGS

13. Listen and then sing each permutation again, using letter names of pitches. The letter names of starting pitches are as follows:
Example 3: (second e above middle C)
Example 4: (g above middle C)
Example 5: (second e above middle C)

**THE STUDENT HEARS AND THEN SINGS**

14. Listen again to each melodic permutation, singing on “la” as you listen:
Example 3–5.

**THE STUDENT SINGS WHILE LISTENING**

15. Listen and then play each melodic permutation by ear in the given key of e minor with the given starting note, using R.H. For Examples 3–5 the letter names of starting pitches are as follows:
Example 3: (second e above middle C)
Example 4: (g above middle C)
Example 5: (second e above middle C)

**THE STUDENT HEARS THEN PLAYS**

16. Play each melodic permutation by ear again along with the recording of the Left Hand (L.H.). The letter name of the starting pitch is:
Example 3: (second e above middle C)
Example 4: (g above middle C)
Example 5: (second e above middle C)

**THE STUDENT PLAYS WHILE LISTENING**

17. Explore various melodic permutation ideas, ten measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key.

18. Mentally image (“think”) a melodic permutation of your own, one that is ten measures in length, in the same meter and key as the musical model.

19. Sing your mentally–imaged melodic permutation on “la”.

20. Sing your melodic permutation again, using letter names of pitches.

21. Play your melodic permutation on the piano with your R.H. Continue to play until you are quite certain of it – until it is “natural” for you.
22. Play your R.H. melodic permutation along with the L.H. part that is played by the computer. In your folder in the computer, open the Bartók 1 folder. Now, open the file labeled Example 6.

Example 6.

**THE STUDENT PLAYS WHILE LISTENING**

*Left Hand Only: Accompaniment Permutation in the Left Hand (L.H.)*


**THE STUDENT HEARS**

24. Listen to the L.H. accompaniment again and sing it on “la” in a comfortable range; sing all the notes in the L.H. chords, beginning with the bottom note.

**THE STUDENT HEARS**

25. Sing the L.H. accompaniment again using scale degree numbers; start on number 1, the first degree of the scale. Sing all the notes in the L.H. chords beginning with the bottom note, again using letter names of pitches; start on e below middle C.

**THE STUDENT SINGS**

26. As you listen a third time, mentally image the melody. Notice the harmony of the L.H. accompaniment as it blends with the melody you are mentally imaging. Typical of the style, melody pitches usually sound best with those pitches within the chords of the accompaniment.

**THE STUDENT HEARS**


27. Listen to each of the L.H. permutations. In your folder in the computer, open the Bartók 1 folder. Now, open the file labeled Example 7. Repeat this process for Examples 8 and 9.

Exercises 7–9.

**THE STUDENT HEARS**
28. Listen to each accompaniment permutation again and tap the rhythm of each with your L.H. as you listen. Tap the rhythm of each permutation after you have finished listening.

THE STUDENT HEARS AND TAPS

29. Listen again to the accompaniment permutation, then sing it in a comfortable vocal range on “la”. Sing all pitches of the blocked chords, ascending from the bottom pitch upwards. The letter names of the starting pitches are:
   Example 7: E (first E below middle C)
   Example 8: E (first E below middle C)
   Example 9: E (first E below middle C)

THE STUDENT SINGS WHILE LISTENING

30. Play each L.H. permutation by ear in the key of e minor. The letter names of the starting pitches are:
   Example 7: E (first E below middle C)
   Example 8: E (first E below middle C)
   Example 9: E Chord (first E below middle C)

31. Explore various accompaniment permutation ideas, ten measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key. Remember that the goal is to create a permutation “in the style of” the master composer’s work.

32. Mentally image (“think”) an accompaniment permutation of your own, one that is ten measures in length, in the same meter and key as the musical model.

33. Try playing your own left hand accompaniment permutation along with the computer playing the R.H. part. In your folder in the computer, open the Bartók 1 folder. Now, open the file labeled Example 10.

   Example 10.

THE STUDENT LISTENS AND PLAYS

Hands Together Instructional Strategies

34. Recall your invented melodic permutation, and connect it with your new accompaniment permutation. Play your permutation, hands together, three times. Listen carefully and evaluate how well the melodic permutation and the accompaniment permutation fit together.
35. Listen to the following acceptable permutation. In your folder in the computer, open the Bartók 1 folder. Now, open the file labeled Example 11.

Example 11.

THE STUDENT HEARS

The permutation is acceptable because it uses the rhythmic, melodic and textural components similar to those used in the model. (e.g., it uses the same texture and chordal harmony as the model, it is the same meter and key as the model, it uses some of the rhythmic and melodic characteristics of the model, it uses a similar structural outline to that of the model, the articulations and dynamics are within the range used in the model, the overall style is similar to that of the model, it generates a new sound within the guidelines, and utilizes new musical ideas not found in the musical mode).

36. Listen to the following unacceptable permutation. In your folder in the computer, open the Bartók 1 folder. Now, open the file labeled Example 12.

Example 12.

THE STUDENT HEARS

The permutation is unacceptable because it does not use rhythmic, melodic and textural components similar to those used in the model (e.g., it does not use the chordal harmony or textures of the model, it does not utilize rhythmic and melodic characteristics used in the model, it does not use articulations or dynamics used in the model, it generates a new sound, but not within the guidelines).

37. Now, recall and play your permutation hands together and record it in your file. Start by finding your folder (it will have your name on it) and proceed as follows:
   a) Open the folder with your name by double-clicking it.
   b) Look for folder labeled Improvisation and double-click it.
   c) Open the file labeled #1. When you are ready to record, look at the recording symbols at the bottom of the display.
   d) Click the recording control (circle) and start playing. (If, at any time you want to start over, click and hold on the Edit menu. Scroll down to Erase and release the button.
   e) When you are finished, click the stop control (square).
   f) For playback, click the single arrow to your right.
g) To save your work, click and hold on the File menu at the top of your display. Now, scroll down to Save and release the mouse button.

h) When you have saved your file, scroll down and release the button on Quit under the same menu. You are finished.

38. Listen to your permutation and evaluate it using the following questions:
   a) Does the permutation utilize similar textures and chordal harmony to those used in the model piece?
   b) Is the permutation in the meter of the original model?
   c) Is the permutation in the key of the original model?
   d) Does the permutation utilize rhythmic characteristics which are evident in the given piano piece?
   e) Does the permutation utilize melodic characteristics present in the model?
   f) Does the permutation utilize a similar structural outline to that of the model?
   g) Are the articulations used within the range used in the model?
   h) Are the dynamics used within the range indicated in the model?
   i) Is the overall style of the permutation similar to that of the model?
   j) Does the permutation generate a new sound within the guidelines? Does it utilize new musical ideas not found in the musical model?

39. Use your evaluation (and your teacher's response to your efforts here) to inform your next permutation assignment.
Unit 3

As you follow the printed instructions, listen carefully to the aural examples, and trial exercises and new musical inventions.

1. Listen to the entire piano work, *Soldier's March*, by Robert Schumann. In your folder in the computer, open the Schumann 1 folder. Now, open the file labeled Soldier's March and listen to the example.

THE STUDENT HEARS

Right Hand Only: Melodic Permutation in the Right Hand (R.H.)

2. Listen to the excerpt of the piano work, played hands together: In your folder in the computer, open the Schumann 1 folder. Now, open the file labeled Example 1.

Example 1 (first eight measures).

THE STUDENT HEARS

3. Listen again a second time; focus on the melody in the right hand.

THE STUDENT HEARS

4. Listen to the R.H. melody (top note in chord) played alone three times: In your folder in the computer, open the Schumann 1 folder. Now, open the file labeled Example 2.

Example 2 (first eight measures).

THE STUDENT HEARS

5. With eyes closed, sing the melody in a comfortable vocal range on “la”; start on b, the third degree of the scale, and slowly continue through the melody.

THE STUDENT SINGS

6. Sing the melody again using scale degree numbers; start on 3, in the key of G Major, the third degree of the scale, and slowly continue through the melody.

THE STUDENT SINGS
7. Listen to the melody of the piano work again; sing the letter names of pitches while listening.

THE STUDENT HEARS

8. Play the entire melody by ear on the piano in the key indicated, starting on b, the third degree of the G Major scale, first b above middle C.


9. Listen to each of the melodic permutations for the right hand three times; they are each given aurally on the sound track. They include scale, five–finger, and other permutations typically found in Schumann's piano music: In your folder in the computer, open the Schumann 1 folder. Now, open the file labeled Example 3. Repeat this process for Examples 4 and 5.

Examples 3–5.

THE STUDENT HEARS

10. Listen to each permutation again and tap the rhythm of each as you listen. Tap the rhythm of each permutation again after you have finished listening: Examples 3–5.

THE STUDENT HEARS AND TAPS, AND THEN TAPS AGAIN

11. With eyes closed, listen to the melodic permutation again and then sing it on "la"; repeat for each of the melodic permutation: Examples 3–5.

THE STUDENT HEARS AND SINGS

12. Listen and sing each melodic permutation again, this time using scale degree numbers: For Examples 3–5, the scale degree numbers of the starting pitches are as follows:

Example 3: 3 (first b above middle C)
Example 4: d' (second d above middle C)
Example 5: g (first g above middle C)

THE STUDENT HEARS AND THEN SINGS

13. Listen and then sing each permutation again, using letter names of pitches. The letter names of starting pitches are as follows:
Example 3:  (b above middle C)
Example 4:  (second d above middle C)
Example 5:  (first g above middle C)

THE STUDENT HEARS AND THEN SINGS

14. Listen again to each melodic permutation, singing on “la” as you listen: Example 3–5.

THE STUDENT SINGS WHILE LISTENING

15. Listen and then play each melodic permutation by ear in the given key of G Major with the given starting note, using R.H. For Examples 3–5 the letter names of starting pitches are as follows:
Example 3:  (b above middle C)
Example 4:  (second d above middle C)
Example 5:  (first g above middle C)

THE STUDENT HEARS THEN PLAYS

16. Play each melodic permutation by ear again along with the recording of the Left Hand (L.H.). The letter name of the starting pitch is:
Example 3:  (first d above middle C)
Example 4:  (first B above middle C)
Example 5:  (first d above middle C)

THE STUDENT PLAYS WHILE LISTENING

17. Explore various melodic permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key.

18. Mentally image (“think”) a melodic permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

19. Sing your mentally-imaged melodic permutation on “la”.

20. Sing your melodic permutation again, using letter names of pitches.

21. Play your melodic permutation on the piano with your R.H. Continue to play until you are quite certain of it – until it is “natural” for you.
22. Play your R.H. melodic permutation along with the L.H. that is played by the computer. In your folder in the computer, open the Schumann 1 folder. Now, open the file labeled Example 6.

Example 6.

**THE STUDENT PLAYS WHILE LISTENING**

**Left Hand Only: Accompaniment Permutation in the Left Hand (L.H.)**


**THE STUDENT HEARS**

24. Listen to the L.H. accompaniment again and sing it on “la” in a comfortable range; sing all the notes in the L.H. chords beginning with the bottom note.

**THE STUDENT HEARS**

25. Sing the L.H. accompaniment again using scale degree numbers; start on number 1, the first degree of the scale. Sing all notes in the L.H. chord beginning with the bottom note using letter names of pitches; start on G below middle C.

**THE STUDENT SINGS**

26. As you listen a third time, mentally image the melody. Notice the harmony of the L.H. accompaniment as it blends with the melody you are mentally imaging. Typical of the style, melody pitches usually sound best with those pitches within the chords of the accompaniment.

**THE STUDENT HEARS**


27. Listen to each of the L.H. permutations. In your folder in the computer, open the Schumann 1 folder. Now, open the file labeled Example 7. Repeat this process for Examples 8 and 9.

Exercises 7–9.

**THE STUDENT HEARS**
28. Listen to each accompaniment permutation again and tap the rhythm of each with your L.H. as you listen. Tap the rhythm of each permutation after you have finished listening.

THE STUDENT HEARS AND TAPS

29. Listen again to the accompaniment permutation, then sing it in a comfortable vocal range on “la”. Sing all pitches of the blocked chords, ascending from the bottom pitch upwards. The letter names of the starting pitches are:
Example 7: d (first d above middle C)
Example 8: B (first B below middle C)
Example 9: d (first d above middle C)

THE STUDENT SINGS WHILE LISTENING

30. Play each L.H. permutation by ear in the key of G Major. The letter names of the starting pitches are:
Example 7: d (first d above middle C)
Example 8: B (first B below middle C)
Example 9: d (first d above middle C)

31. Explore various accompaniment permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key. Remember that the goal is to create a permutation “in the style of” the master composer’s work.

32. Mentally image (“think”) an accompaniment permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

33. Try playing your own left hand accompaniment permutation along with the computer playing the R.H. part. In your folder in the computer, open the Schumann 1 folder. Now, open the file labeled Example 10.

Example 10.

THE STUDENT LISTENS AND PLAYS

Hands Together Instructional Strategies

34. Recall your invented melodic permutation, and connect it with your new accompaniment permutation. Play your permutation, hands together, three times. Listen carefully and evaluate how well the melodic permutation and the accompaniment permutation fit together.
35. Listen to the following acceptable permutation. In your folder in the computer, open the Schumann 1 folder. Now, open the file labeled labeled Example 11.

Example 11.

THE STUDENT HEARS

The permutation is acceptable because it uses rhythmic, melodic and textural components similar to those used in the model (e.g., it uses the same texture and chordal harmony as the model, it is in the same meter and key as the model, it utilizes some of the rhythmic and melodic characteristics of the model, it uses a similar structural outline to that of the model, the articulations and dynamics are within the range used in the model, the overall style is similar to that of the model, it generates a new sound within the guidelines, and utilizes new musical ideas not found in the musical model).

36. Listen to the following unacceptable permutation. In your folder in the computer, open the Schumann 1 folder. Now, open the file labeled Example 12.

Example 12.

THE STUDENT HEARS

The permutation is unacceptable because it does not use rhythmic, melodic and textural components similar to those used in the model (e.g., it does not use the chordal harmony or textures of the model, it does not utilize rhythmic and melodic characteristics used in the model, it does not use articulations or dynamics used in the model, it generates a new sound, but not within the guidelines).

37. Now, recall and play your permutation hands together and record it in your file. Start by finding your folder (it will have your name on it) and proceed as follows:
   a) Open the folder with your name by double-clicking it.
   b) Look for file labeled Improvisation and double-click it.
   c) Think about what you are going to play. When you are ready, look at the standard recording controls at the bottom of the computer display.
   d) Click the recording control (circle) and start playing. (If, at any time you want to start over, click and hold on the Edit menu. Scroll down to Erase and release the button.
e) When you are finished, click the stop control (square).
f) For playback, click the single arrow to your right.
g) To save your work, click and hold on the File menu at the top of your display. Now, scroll down to Save and release the mouse button.
h) When you have saved your file, scroll down and release the button on Quit under the same menu. You are finished.

38. Listen to your permutation and evaluate it using the following questions:
   a) Does the permutation utilize similar textures and chords! harmony to those used in the model piece?
   b) Is the permutation in the meter of the original model?
   c) Is the permutation in the key of the original model?
   d) Does the permutation utilize rhythmic characteristics which are evident in the given piano piece?
   e) Does the permutation utilize melodic characteristics present in the model?
   f) Does the permutation utilize a similar structural outline to that of the model?
   g) Are the articulations used within the range used in the model?
   h) Are the dynamics used within the range indicated in the model?
   i) Is the overall style of the permutation similar to that of the model?
   j) Does the permutation generate a new sound within the guidelines? Does it utilize new musical ideas not found in the musical model?

39. Use your evaluation (and your teacher's response to your efforts here) to inform your next permutation assignment.
Unit 4

As you follow the printed instructions, listen carefully to the aural examples, and trial exercises and new musical inventions.

1. Listen to the entire piano work, *Rondo*, by Wolfgang Amadeus Mozart. In your folder in the computer, open the Mozart folder. Now, open the file labeled Rondo.

**THE STUDENT HEARS**

**Right Hand Only: Melodic Permutation in the Right Hand (R.H.)**

2. Listen to the excerpt of the piano work, played hands together: In your folder in the computer, open the Mozart folder. Now, open the file labeled Example 1.

Example 1 (first eight measures).

**THE STUDENT HEARS**

3. Listen again a second time; focus on the melody in the right hand.

**THE STUDENT HEARS**

4. Listen to the R.H. melody played alone three times: In your folder in the computer, open the Mozart folder. Now, open the file labeled Example 2.

Example 2 (first eight measures).

**THE STUDENT HEARS**

5. With eyes closed, sing the melody in a comfortable vocal range on “la”; start on g’, the fifth degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**

6. Sing the melody again using scale degree numbers; start on 5, in the key of C Major, the fifth degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**
7. Listen to the melody of the piano work again; sing the letter names of pitches while listening.

THE STUDENT HEARS

8. Play the entire melody by ear on the piano in the key indicated, starting on g¹, the fifth degree of the C Major scale, second g above middle C.


9. Listen to each of the melodic permutations for the right hand three times; they are each given aurally on the sound track. They include scale, five–finger, and other permutations typically found in Mozart's piano music: In your folder in the computer, open the Mozart folder. Now, open the file labeled Example 3. Repeat this process for Examples 4 and 5.

Examples 3–5.

THE STUDENT HEARS

10. Listen to each permutation again and tap the rhythm of each as you listen. Tap the rhythm of each permutation again after you have finished listening: Examples 3–5.

THE STUDENT HEARS AND TAPS, AND THEN TAPS AGAIN

11. With eyes closed, listen to the melodic permutation again and then sing on "la"; repeat for each of the melodic permutations: Examples 3–5.

THE STUDENT HEARS AND SINGS

12. Listen and sing each melodic permutation again, this time using scale degree numbers: For Examples 3–5, the scale degree numbers of the starting pitches are as follows:
Example 3: e¹ (second e above middle C)
Example 4: c (C above middle C)
Example 5: g¹ (second g above middle C)

THE STUDENT HEARS AND THEN SINGS
13. Listen and then sing each permutation again, using letter names of pitches. The letter names of starting pitches are as follows:
Example 3: (second e above middle C)
Example 4: (C above middle C)
Example 5: (second g above middle C)

THE STUDENT HEARS AND THEN SINGS

14. Listen again to each melodic permutation, singing on “la” as you listen: Example 3–5.

THE STUDENT SINGS WHILE LISTENING

15. Listen and then play each melodic permutation by ear in the given key of G Major with the given starting note, using R.H. For Examples 3–5 the letter names of starting pitches are as follows:
Example 3: (second e above middle C)
Example 4: (C above middle C)
Example 5: (second g above middle C)

THE STUDENT HEARS THEN PLAYS

16. Play each melodic permutation by ear again along with the recording of the Left Hand (L.H.). The letter name of the starting pitch is:
Example 3: (second e above middle C)
Example 4: (C above middle C)
Example 5: (second g above middle C)

THE STUDENT PLAYS WHILE LISTENING

17. Explore various melodic permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key.

18. Mentally image (“think”) a melodic permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

19. Sing your mentally–imaged melodic permutation on “la”.

20. Sing your melodic permutation again, using letter names of pitches.

21. Play your melodic permutation on the piano with your R.H. Continue to play until you are quite certain of it – until it is “natural” for you.
22. Play your R.H. melodic permutation along with the L.H. part that is played by the computer. In your folder in the computer, open the Mozart folder. Now, open the file labeled Example 6.

Example 6.

THE STUDENT PLAYS WHILE LISTENING

Left Hand Only: Accompaniment Permutation in the Left Hand (L.H.)


THE STUDENT HEARS

24. Listen to the L.H. accompaniment again and sing it on “la” in a comfortable range.

THE STUDENT HEARS

25. Sing the L.H. part again using scale degree numbers; start on number 1, the first degree of the scale. Sing the L.H. part again using letter names of pitches; start on middle C.

THE STUDENT SINGS

26. As you listen a third time, mentally image the melody. Notice the harmony of the L.H. accompaniment as it blends with the melody you are mentally imaging. Typical of the style, melody pitches usually sound best with those pitches within the chords of the accompaniment.

THE STUDENT HEARS


27. Listen to each of the L.H. permutations. In your folder in the computer, open the Mozart folder. Now, open the file labeled Example 7. Repeat this process for Examples 8 and 9.

Exercises 7–9.

THE STUDENT HEARS
28. Listen to each accompaniment permutation again and tap the rhythm of each with your L.H. as you listen. Tap the rhythm of each exercise after you have finished listening.

THE STUDENT HEARS AND TAPS

29. Listen again to the accompaniment permutation, then sing it in a comfortable vocal range on “la”. Sing all pitches of the blocked chords, ascending from the bottom pitch upwards. The letter names of the starting pitches are:

Example 7: C  (middle C)
Example 8: C  (middle C)
Example 9: C  (middle C)

THE STUDENT SINGS WHILE LISTENING

30. Play each L.H. permutation by ear in the key of G. The letter names of the starting pitches are:

Example 7: C  (middle C)
Example 8: C  (middle C)
Example 9: C  (middle C)

31. Explore various accompaniment permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key. Remember that the goal is to create a permutation “in the style of” the master composer’s work.

32. Mentally image (“think”) an accompaniment permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

33. Try playing your own left hand accompaniment permutation along with the computer playing the R.H. part. In your folder in the computer, open the Mozart folder. Now, open the file labeled Example 10.

Example 10.

THE STUDENT LISTENS AND PLAYS

Hands Together Instructional Strategies

34. Recall your invented melodic permutation, and connect it with your new accompaniment permutation. Play your permutation, hands together, three times. Listen carefully and evaluate how well the melodic permutation and the accompaniment permutation fit together.
35. Listen to the following acceptable permutation. In your folder in the computer, open the Mozart folder. Now, open the file labeled Example 11.

Example 11.

THE STUDENT HEARS

The permutation is acceptable because it uses rhythmic, melodic and textural components similar to those used in the model (e.g., it uses the same chordal harmony as the model, it is in the same meter and key as the model, it utilizes some of the rhythmic and melodic characteristics of the model, it uses a similar structural outline to that of the model, the articulations and dynamics are within the range used in the model, the overall style is similar to that of the model, it generates a new sound within the guidelines, and utilizes new musical ideas not found in the musical model).

36. Listen to the following unacceptable permutation. In your folder in the computer, open the Mozart folder. Now, open the file labeled Example 12.

Example 12.

THE STUDENT HEARS

The permutation is unacceptable because it does not use rhythmic, melodic and textural components similar to those used in the model (e.g., it does not use the chordal harmony or textures of the model, it does not utilize rhythmic and melodic characteristics used in the model, it does not use articulations or dynamics used in the model, it generates a new sound, but not within the guidelines).

37. Now, recall and play your permutation hands together and record it in your file. Start by finding your folder (it will have your name on it) and proceed as follows:

a) Open the folder with your name by double-clicking it.
b) Look for file labeled Improvisation and double-click it.
c) Think about what you are going to play. When you are ready, look at the standard recording controls at the bottom of the computer display.
d) Click the recording control (circle) and start playing. (If, at any time you want to start over, click and hold on the Edit menu. Scroll down to Erase and release the button.
e) When you are finished, click the stop control (square).
f) For playback, click the single arrow to your right.
g) To save your work, click and hold on the File menu at the top of your display. Now, scroll down to Save and release the mouse button.
h) When you have saved your file, scroll down and release the button on Quit under the same menu. You are finished.

38. Listen to your permutation and evaluate it using the following questions:
   a) Does the permutation utilize similar textures and chordal harmony to those used in the model piece?
   b) Is the permutation in the meter of the original model?
   c) Is the permutation in the key of the original model?
   d) Does the permutation utilize rhythmic characteristics which are evident in the given piano piece?
   e) Does the permutation utilize melodic characteristics present in the model?
   f) Does the permutation utilize a similar structural outline to that of the model?
   g) Are the articulations used within the range used in the model?
   h) Are the dynamics used within the range indicated in the model?
   i) Is the overall style of the permutation similar to that of the model?
   j) Does the permutation generate a new sound within the guidelines?
      Does it utilize new musical ideas not found in the musical model?

39. Use your evaluation (and your teacher's response to your efforts here) to inform your next permutation assignment.
As you follow the printed instructions, listen carefully to the aural examples, and trial exercises and new musical inventions.


THE STUDENT HEARS

Right Hand Only: Melodic Permutation in the Right Hand (R.H.)

2. Listen to the excerpt of the piano work, played hands together: In your folder in the computer, open the Bartók 2 folder. Now, open the file labeled Example 1.

Example 1 (first eight measures).

THE STUDENT HEARS

3. Listen again a second time; focus on the melody in the right hand.

THE STUDENT HEARS

4. Listen to the R.H. melody played alone three times: In your folder in the computer, open the Bartók 2 folder. Now, open the file labeled Example 2.

Example 2 (first eight measures).

THE STUDENT HEARS

5. With eyes closed, sing the melody (top note in chord) in a comfortable vocal range on “la”; start on g, the fifth degree of the scale, and slowly continue through the melody.

THE STUDENT SINGS

6. Sing the melody again using scale degree numbers; start on g, in the key of C Major, the fifth degree of the scale, and slowly continue through the melody.

THE STUDENT SINGS
7. Listen to the melody of the piano work again; sing the letter names of pitches while listening.

THE STUDENT HEARS

8. Play the entire melody by ear on the piano in the key indicated, starting on g, the fifth degree of the C Major scale, second g above middle C.


9. Listen to each of the melodic permutations for the right hand three times; they are each given aurally on the sound track. They include scale, five-finger, and other permutations typically found in Bartok’s piano music: In your folder in the computer, open the Bartók 2 folder. Now, open the file labeled Example 3. Repeat this process for Examples 4 and 5.

Examples 3–5.

THE STUDENT HEARS

10. Listen to each permutation again and tap the rhythm of each as you listen. Tap the rhythm of each permutation again after you have finished listening: Examples 3–5.

THE STUDENT HEARS AND TAPS, AND THEN TAPS AGAIN

11. With eyes closed, listen to the melodic permutation again and then sing it on “la”; repeat for each of the melodic permutations: Examples 3–5.

THE STUDENT HEARS AND SINGS

12. Listen and sing each melodic permutation again, this time using scale degree numbers: For Examples 3–5, the scale degree numbers of the starting pitches are as follows:

Example 3: 3 (C above middle C)
Example 4: 3 (C above middle C)
Example 5: 3 (C above middle C)

THE STUDENT HEARS AND THEN SINGS
13. Listen and then sing each permutation again, using letter names of pitches. The letter names of starting pitches are as follows:
   Example 3:  c  (c above middle C)
   Example 4:  c  (c above middle C)
   Example 5:  c  (c above middle C)

**THE STUDENT HEARS AND THEN SINGS**

14. Listen again to each melodic permutation, singing on “la” as you listen:
   Example 3–5.

**THE STUDENT SINGS WHILE LISTENING**

15. Listen and then play each melodic permutation by ear in the given key of e minor with the given starting note, using R.H. For Examples 3–5 the letter names of starting pitches are as follows:
   Example 3:  c  (c above middle C)
   Example 4:  c  (c above middle C)
   Example 5:  c  (c above middle C)

**THE STUDENT HEARS THEN PLAYS**

16. Play each melodic permutation by ear again along with the recording of the Left Hand (L.H.). The letter name of the starting pitch is:
   Example 3:  c  (c above middle C)
   Example 4:  c  (c above middle C)
   Example 5:  c  (c above middle C)

**THE STUDENT PLAYS WHILE LISTENING**

17. Explore various melodic permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key.

18. Mentally image (“think”) a melodic permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

19. Sing your mentally-imaged melodic permutation on “la”.

20. Sing your melodic permutation again, using letter names of pitches.

21. Play your melodic permutation on the piano with your R.H. Continue to play until you are quite certain of it – until it is “natural” for you.
22. Play your R.H. melodic permutation along with the L.H. part that is played by the computer. In your folder in the computer, open the Bartók 2 folder. Now, open the file labeled Example 6.

Example 6.

THE STUDENT PLAYS WHILE LISTENING

Left Hand Only: Accompaniment Permutation in the Left Hand (L.H.)


THE STUDENT HEARS

24. Listen to the L.H. accompaniment again and sing it on “la” in a comfortable range; sing all the notes in the L.H. chords starting on the bottom note.

THE STUDENT HEARS

25. Sing the L.H. part again using scale degree numbers; start on number 1, the first degree of the scale. Sing the L.H. part again using letter names of pitches; start on A below middle C.

THE STUDENT SINGS

26. As you listen a third time, mentally image the melody. Notice the harmony of the L.H. accompaniment as it blends with the melody you are mentally imaging. Typical of the style, melody pitches usually sound best with those pitches within the chords of the accompaniment.

THE STUDENT HEARS


27. Listen to each of the L.H. permutations. In your folder in the computer, open the Bartók 2 folder. Now, open the file labeled Example 7. Repeat this process for Examples 8 and 9.

Exercises 7–9.
28. Listen to each accompaniment permutation again and tap the rhythm of each with your L.H. as you listen. Tap the rhythm of each permutation after you have finished listening.

**THE STUDENT HEARS AND TAPS**

29. Listen again to the accompaniment permutation, then sing it in a comfortable vocal range on "la". The letter names of the starting pitches are:

Example 7:  A  (A below middle C)
Example 8:  A  (A below middle C)
Example 9:  A  (A below middle C)

**THE STUDENT SINGS WHILE LISTENING**

30. Play each L.H. permutation by ear in the key of e minor. The letter names of the starting pitches are:

Example 7:  A  (A below middle C)
Example 8:  A  (A below middle C)
Example 9:  A  (A above middle C)

31. Explore various accompaniment permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key. Remember that the goal is to create a permutation "in the style of" the master composer's work.

32. Mentally image ("think") an accompaniment permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

33. Try playing your own left hand permutation accompaniment along with the computer playing the R.H. part. In your folder in the computer, open the Bartók 2 folder. Now, open the file labeled Example 10.

Example 10.

**THE STUDENT LISTENS AND PLAYS**

**Hands Together Instructional Strategies**

34. Recall your invented melodic permutation, and connect it with your new accompaniment permutation. Play your permutation, hands together, three times. Listen carefully and evaluate how well the melodic permutation and the accompaniment permutation fit together.
35. Listen to the following acceptable permutation. In your folder in the computer, open the Bartok folder. Now, open the file labeled Example 11.

Example 11.

THE STUDENT HEARS

The permutation is acceptable because it uses the rhythmic, melodic and textural components similar to those used in the model. (e.g., it uses the same chordal harmony as the model, it is in the same meter and key, it utilizes some of the rhythmic and melodic characteristics of the model, it uses a similar structural outline, the articulations and dynamics are within the range used in the model, the overall style is similar to that of the model, it generates a new sound within the guidelines, and utilizes new musical ideas not found in the musical mode).

36. Listen to the following unacceptable permutation. In your folder in the computer, open the Bartok 2 folder. Now, open the file labeled Example 12.

Example 12.

THE STUDENT HEARS

The permutation is unacceptable because it does not use rhythmic, melodic and textural components similar to those used in the model (e.g., it does not use the chordal harmony or textures of the model, it does not utilize rhythmic and melodic characteristics used in the model, it does not use articulations or dynamics used in the model, it generates a new sound, but not within the guidelines).

37. Now, recall and play your permutation hands together and record it in your file. Start by finding your folder (it will have your name on it) and proceed as follows:
   a) Open the folder with your name by double-clicking it.
   b) Look for folder labeled Improvisation and double-click it.
   c) Open the file labeled #1. When you are ready to record, look at the recording symbols at the bottom of the display.
   d) Click the recording control (circle) and start playing. (If, at any time you want to start over, click and hold on the Edit menu. Scroll down to Erase and release the button.
   e) When you are finished, click the stop control (square).
f) For playback, click the single arrow to your right.
g) To save your work, click and hold on the File menu at the top of your display. Now, scroll down to Save and release the mouse button.
h) When you have saved your file, scroll down and release the button on Quit under the same menu. You are finished.

38. Listen to your permutation and evaluate it using the following questions:
   a) Does the permutation utilize similar textures and chordal harmony to those used in the model piece?
   b) Is the permutation in the meter of the original model?
   c) Is the permutation in the key of the original model?
   d) Does the permutation utilize rhythmic characteristics which are evident in the given piano piece?
   e) Does the permutation utilize melodic characteristics present in the model?
   f) Does the permutation utilize a similar structural outline to that of the model?
   g) Are the articulations used within the range used in the model?
   h) Are the dynamics used within the range indicated in the model?
   i) Is the overall style of the permutation similar to that of the model?
   j) Does the permutation generate a new sound within the guidelines? Does it utilize new musical ideas not found in the musical model?

39. Use your evaluation (and your teacher’s response to your efforts here) to inform your next permutation assignment.
As you follow the printed instructions, listen carefully to the aural examples, and trial exercises and new musical inventions.

1. Listen to the entire piano work, *Menuet*, by Johann Sebastian Bach. In your folder in the computer, open the Bach 1 folder. Now, open the file labeled Minuet and listen to the example.

THE STUDENT HEARS

Right Hand Only: Melodic Permutation in the Right Hand (R.H.)

2. Listen to the excerpt of the piano work, played hands together: In your folder in the computer, open the Bach 1 folder. Now, open the file labeled Example 1.

Example 1 (first eight measures).

THE STUDENT HEARS

3. Listen again a second time; focus on the melody in the right hand.

THE STUDENT HEARS

4. Listen to the R.H. melody played alone three times: In your folder in the computer, open the Bach 1 folder. Now, open the file labeled Example 2.

Example 2 (first eight measures).

THE STUDENT HEARS

5. With eyes closed, sing the melody in a comfortable vocal range on “la”; start on d', the fifth degree of the scale, and slowly continue through the melody.

THE STUDENT SINGS

6. Sing the melody again using scale degree numbers; start on d', in the key of G Major, the fifth degree of the scale, and slowly continue through the melody.

THE STUDENT SINGS
7. Listen to the melody of the piano work again; sing the letter names of pitches while listening.

THE STUDENT HEARS

8. Play the entire melody by ear on the piano in the key indicated, starting on \( d^4 \), the fifth degree of the G Major scale, second \( d \) above middle C.


9. Listen to each of the melodic permutations for the right hand three times; they are each given aurally on the sound track. They include scale, five-finger, and other permutations typically found in Bach's piano music: In your folder in the computer, open the Bach 1 folder. Now, open the file labeled Example 3. Repeat this process for Examples 4 and 5.

Examples 3–5.

THE STUDENT HEARS

10. Listen to each permutation again and tap the rhythm of each as you listen. Tap the rhythm of each permutation again after you have finished listening: Examples 3–5.

THE STUDENT HEARS AND TAPS, AND THEN TAPS AGAIN

11. With eyes closed, listen to each melodic permutation again and then sing it on “la”; repeat for each of the melodic permutations: Examples 3–5.

THE STUDENT HEARS AND SINGS

12. Listen and sing each melodic permutation again, this time using scale degree numbers: For Examples 3–5, the scale degree numbers of the starting pitches are as follows:
   Example 3: 5  (second \( d \) above middle C)
   Example 4: 5  (second \( d \) above middle C)
   Example 5: 5  (second \( d \) above middle C)

THE STUDENT HEARS AND THEN SINGS
13. Listen and then sing each permutation again, using letter names of pitches. The letter names of starting pitches are as follows:
Example 3: (second d above middle C)
Example 4: (second d above middle C)
Example 5: (second d above middle C)

THE STUDENT HEARS AND THEN SINGS

14. Listen again to each melodic permutation, singing on “la” as you listen:
Example 3–5.

THE STUDENT SINGS WHILE LISTENING

15. Listen and then play each melodic permutation by ear in the given key of G Major with the given starting note, using R.H. For Examples 3–5 the letter names of starting pitches are as follows:
Example 3: (second d above middle C)
Example 4: (second d above middle C)
Example 5: (second d above middle C)

THE STUDENT HEARS THEN PLAYS

16. Play each melodic permutation by ear again along with the recording of the Left Hand (L.H.). The letter name of the starting pitch is:
Example 3: (second d above middle C)
Example 4: (second d above middle C)
Example 5: (second d above middle C)

THE STUDENT PLAYS WHILE LISTENING

17. Explore various melodic permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key.

18. Mentally image (“think”) a melodic permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

19. Sing your mentally-imaged melodic permutation on “la”.

20. Sing your melodic permutation again, using letter names of pitches.

21. Play your melodic permutation on the piano with your R.H. Continue to play until you are quite certain of it – until it is “natural” for you.
22. Play your R.H. melodic permutation along with the L.H. part that is played by the computer. In your folder in the computer, open the Bach 1 folder. Now, open the file labeled Example 6.

Example 6.

THE STUDENT PLAYS WHILE LISTENING

Left Hand Only: Accompaniment Permutation in the Left Hand (L.H.)


THE STUDENT HEARS

24. Listen to the L.H. accompaniment again and sing it on “la” in a comfortable range.

THE STUDENT HEARS

25. Sing the L.H. part again using scale degree numbers; start on number 1, the first degree of the scale. Sing the L.H. part again using letter names of pitches; start on G below middle C.

THE STUDENT SINGS

26. As you listen a third time, mentally image the melody. Notice the harmony of the L.H. accompaniment as it blends with the melody you are mentally imaging. Typical of the style, melody pitches usually sound best with those pitches within the chords of the accompaniment.

THE STUDENT HEARS


27. Listen to each of the L.H. permutations. In your folder in the computer, open the Bach 1 folder. Now, open the file labeled Example 7. Repeat this process for Examples 8 and 9.

Exercises 7–9.

THE STUDENT HEARS
28. Listen to each accompaniment permutation again and tap the rhythm of each with your L.H. as you listen. Tap the rhythm of each permutation after you have finished listening.

THE STUDENT HEARS AND TAPS

29. Listen again to the accompaniment permutation then sing it in a comfortable vocal range on “la”. Sing all pitches of the blocked chords, ascending from the bottom pitch upwards. The letter names of the starting pitches are:
Example 7: G  (first G below middle C)
Example 8: G  (first G below middle C)
Example 9: G  (second G below middle C)

THE STUDENT SINGS WHILE LISTENING

30. Play each L.H. permutation by ear in the key of G. The letter names of the starting pitches are:
Example 7: G  (first G below middle C)
Example 8: G  (first G below middle C)
Example 9: G  (second G below middle C)

31. Explore various accompaniment permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key. Remember that the goal is to create a permutation “in the style of” the master composer’s work.

32. Mentally image (“think”) an accompaniment permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

33. Try playing your own left hand accompaniment permutation along with the computer playing the R.H. part. In your folder in the computer, open the Bach 1 folder. Now, open the file labeled Example 10.

Example 10.

THE STUDENT LISTENS AND PLAYS

Hands Together Instructional Strategies

34. Recall your invented melodic permutation and connect it with your new accompaniment permutation. Play your permutation, hands together, three times. Listen carefully and evaluate how well the melodic permutation and the accompaniment permutation fit together.
35. Listen to the following acceptable permutation. In your folder in the computer, open the Bach 1 folder. Now, open the file labeled labeled Example 11.

Example 11.

THE STUDENT HEARS

The permutation is acceptable because it uses rhythmic, melodic and textural components similar to those used in the model (e.g., it uses the same chordal harmony as the model, it is in the same meter and key as the model, it utilizes some of the rhythmic and melodic characteristics of the model, it uses a similar structural outline to that of the model, the articulations and dynamics are within the range used in the model, the overall style is similar to that of the model, it generates a new sound within the guidelines, and utilizes new musical ideas not found in the musical model).

36. Listen to the following unacceptable permutation. In your folder in the computer, open the Bach 1 folder. Now, open the file labeled Example 12.

Example 12.

THE STUDENT HEARS

The permutation is unacceptable because it does not use rhythmic, melodic and textural components similar to those used in the model (e.g., it does not use the chordal harmony or textures of the model, it does not utilize rhythmic and melodic characteristics used in the model, it does not use articulations or dynamics used in the model, it generates a new sound, but not within the guidelines).

37. Now, recall and play your permutation hands together and record it in your file. Start by finding your folder (it will have your name on it) and proceed as follows:

a) Open the folder with your name by double-clicking it.

b) Look for file labeled Improvisation and double-click it.

c) Think about what you are going to play. When you are ready, look at the standard recording controls at the bottom of the computer display.

d) Click the recording control (circle) and start playing. (If, at any time you want to start over, click and hold on the Edit menu, Scroll down to Erase and release the button.

e) When you are finished, click the stop control (square).
f) For playback, click the single arrow to your right.

g) To save your work, click and hold on the File menu at the top of your display. Now, scroll down to Save and release the mouse button.

h) When you have saved your file, scroll down and release the button on Quit under the same menu. You are finished.

38. Listen to your permutation and evaluate it using the following questions:
   
a) Does the permutation utilize similar textures and chordal harmony to those used in the model piece?
   
b) Is the permutation in the meter of the original model?
   
c) Is the permutation in the key of the original model?
   
d) Does the permutation utilize rhythmic characteristics which are evident in the given piano piece?
   
e) Does the permutation utilize melodic characteristics present in the model?
   
f) Does the permutation utilize a similar structural outline to that of the model?
   
g) Are the articulations used within the range used in the model?
   
h) Are the dynamics used within the range indicated in the model?
   
i) Is the overall style of the permutation similar to that of the model?
   
j) Does the permutation generate a new sound within the guidelines? Does it utilize new musical ideas not found in the musical model?

39. Use your evaluation (and your teacher’s response to your efforts here) to inform your next permutation assignment.
Unit 7

As you follow the printed instructions, listen carefully to the aural examples, and trial exercises and new musical inventions.

1. Listen to the entire piano work, *Melody*, by Robert Schumann. In your folder in the computer, open the Schumann 2 folder. Now, open the file labeled Melody and listen to the example.

**THE STUDENT HEARS**

*Right Hand Only: Melodic Permutation in the Right Hand (R.H.)*

2. Listen to the excerpt of the piano work, played hands together: In your folder in the computer, open the Schumann 2 folder. Now, open the file labeled Example 1.

Example 1 (first eight measures).

**THE STUDENT HEARS**

3. Listen again a second time; focus on the melody in the right hand.

**THE STUDENT HEARS**

4. Listen to the R.H. melody played alone three times: In your folder in the computer, open the Schumann 2 folder. Now, open the file labeled Example 2.

Example 2 (first eight measures).

**THE STUDENT HEARS**

5. With eyes closed, sing the melody in a comfortable vocal range on “la”; start on e¹, the third degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**

6. Sing the melody again using scale degree numbers; start on 3, in the key of C Major, the third degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**

7. Listen to the melody of the piano work again; sing the letter names of pitches while listening.

**THE STUDENT HEARS**
8. Play the entire melody by ear on the piano in the key indicated, starting on \( \text{e}^\text{\flat} \), the third degree of the C Major scale, second e above middle C.


9. Listen to each of the melodic permutations for the right hand three times; they are each given aurally on the sound track. They include scale, five-finger, and other permutations typically found in Schumann’s piano music. In your folder in the computer, open the Schumann 2 folder. Now, open the file labeled Example 3. Repeat this process for Examples 4 and 5.

Examples 3–5.

**THE STUDENT HEARS**

10. Listen to each permutation again and tap the rhythm of each as you listen. Tap the rhythm of each permutation again after you have finished listening: Examples 3–5.

**THE STUDENT HEARS AND TAPS, AND THEN TAPS AGAIN**

11. With eyes closed, listen to each melodic permutation again and then sing it on “la”; repeat for each of the melodic patterns: Examples 3–5.

**THE STUDENT HEARS AND SINGS**

12. Listen and sing each melodic permutation again, this time using scale degree numbers: For Examples 3–5, the scale degree numbers of the starting pitches are as follows:
   
   Example 3: 3 \( (\text{second e above middle C}) \)
   Example 4: 3 \( (\text{second e above middle C}) \)
   Example 5: 1 \( (\text{C above middle C}) \)

**THE STUDENT HEARS AND THEN SINGS**

13. Listen and then sing each permutation again, using letter names of pitches. The letter names of starting pitches are as follows:
   
   Example 3: \( (\text{second e above middle C}) \)
   Example 4: \( (\text{second e above middle C}) \)
   Example 5: \( (\text{C above middle C}) \)

**THE STUDENT HEARS AND THEN SINGS**
14. Listen again to each melodic permutation, singing on “la” as you listen: Example 3–5.

THE STUDENT SINGS WHILE LISTENING

15. Listen and then play each melodic permutation by ear in the given key of G Major with the given starting note, using R.H. For Examples 3–5 the letter names of starting pitches are as follows:
Example 3:  (second e above middle C)
Example 4:  (second e above middle C)
Example 5:  (C above middle C)

THE STUDENT HEARS THEN PLAYS

16. Play each melodic permutation by ear again along with the recording of the Left Hand (L.H.). The letter name of the starting pitch is:
Example 3:  (second e above middle C)
Example 4:  (second e above middle C)
Example 5:  (C above middle C)

THE STUDENT PLAYS WHILE LISTENING

17. Explore various melodic permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key.

18. Mentally image (“think”) a melodic permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

19. Sing your mentally-imaged melodic permutation on “la”.

20. Sing your melodic permutation again, using letter names of pitches.

21. Play your melodic permutation on the piano with your R.H. Continue to play until you are quite certain of it – until it is “natural” for you.

22. Play your R.H. melodic permutation along with the L.H. part that is played by the computer. In your folder in the computer, open the Schumann 2 folder. Now, open the file labeled labeled Example 6.

Example 6.

THE STUDENT PLAYS WHILE LISTENING
Left Hand Only: Accompaniment Permutation in the Left Hand (L.H.)


THE STUDENT HEARS

24. Listen to the L.H. accompaniment again and sing it on “la” in a comfortable range.

THE STUDENT HEARS

25. Sing the notes of the chords again using scale degree numbers; start on number 1, the first degree of the scale. Sing the L.H. accompaniment permutation again using letter names of pitches; start on middle C.

THE STUDENT SINGS

26. As you listen a third time, mentally image the melody. Notice the harmony of the L.H. accompaniment as it blends with the melodic permutation you are mentally imaging. Typical of the style, melody pitches usually sound best with those pitches within the chords of the accompaniment.

THE STUDENT HEARS


27. Listen to each of the L.H. permutations. In your folder in the computer, open the Schumann 2 folder. Now, open the file labeled Example 7. Repeat this process for Examples 8 and 9.

Exercises 7–9.

THE STUDENT HEARS

28. Listen to each L.H. accompaniment permutation again and tap the rhythm of each with your L.H. as you listen. Tap the rhythm of each permutation after you have finished listening.

THE STUDENT HEARS AND TAPS
29. Listen again to the accompaniment permutation, then sing it in a comfortable vocal range on “la” (all pitches of the blocked chords, ascending from the bottom pitch upwards). The letter names of the starting pitches are:
Example 7: C  (middle C)
Example 8: g  (g above middle C)
Example 9: C  (middle C)

THE STUDENT SINGS WHILE LISTENING

30. Play each L.H. permutation by ear in the key of G Major. The letter names of the starting pitches are:
Example 7: C  (middle C)
Example 8: g  (g above middle C)
Example 9: C  (middle C)

31. Explore various accompaniment permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key. Remember that the goal is to create a permutation “in the style of” the master composer’s work.

32. Mentally image (“think”) an accompaniment permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

33. Try playing your own left hand improvised accompaniment permutation along with the computer playing the R.H. part. In your folder in the computer, open the Schumann 2 folder. Now, open the file labeled Example 10.

Example 10.

THE STUDENT LISTENS AND PLAYS

Hands Together Instructional Strategies

34. Recall your invented melodic permutation, and connect it with your new accompaniment permutation. Play your permutation, hands together, three times. Listen carefully and evaluate how well the melodic permutation and the accompaniment permutation fit together.

35. Listen to the following acceptable permutation. In your folder in the computer, open the Schumann 2 folder. Now, open the file labeled Example 11.

Example 11.

THE STUDENT HEARS
The permutation is acceptable because it uses rhythmic, melodic and textural components similar to those used in the model (e.g., it uses the same chordal harmony as the model, it is in the same meter and key, it utilizes some of the rhythmic and melodic characteristics of the model, it uses a similar structural outline, the articulations and dynamics are within the range used in the model, the overall style is similar to that of the model, it generates a new sound within the guidelines, and utilizes new musical ideas not found in the musical model).

36. Listen to the following unacceptable permutation. In your folder in the computer, open the Schumann 2 folder. Now, open the file labeled Example 12.

Example 12.

THE STUDENT HEARS

The permutation is unacceptable because it does not use rhythmic, melodic and textural components similar to those used in the model (e.g., it does not use the chordal harmony or textures of the model, it does not utilize enough of the rhythmic and melodic characteristics used in the model, it does not use articulations or dynamics used in the model, it generates a new sound, but not within the guidelines).

37. Now, recall and play your permutation hands together and record it in your file. Start by finding your folder (it will have your name on it) and proceed as follows:
   a) Open the folder with your name by double-clicking it.
   b) Look for file labeled Improvisation and double-click it.
   c) Think about what you are going to play. When you are ready, look at the standard recording controls at the bottom of the computer display.
   d) Click the recording control (circle) and start playing. (If, at any time you want to start over, click and hold on the Edit menu. Scroll down to Erase and release the button.
   e) When you are finished, click the stop control (square).
   f) For playback, click the single arrow to your right.
   g) To save your work, click and hold on the File menu at the top of your display. Now, scroll down to Save and release the mouse button.
   h) When you have saved your file, scroll down and release the button on Quit under the same menu. You are finished.
38. Listen to your permutation and evaluate it using the following questions:
   a) Does the permutation utilize similar textures and chordal
      harmony to those used in the model piece?
   b) Is the permutation in the meter of the original model?
   c) Is the permutation in the key of the original model?
   d) Does the permutation utilize rhythmic characteristics which
      are evident in the given piano piece?
   e) Does the permutation utilize melodic characteristics present
      in the model?
   f) Does the permutation utilize a similar structural outline to that
      of the model?
   g) Are the articulations used within the range used in the model?
   h) Are the dynamics used within the range indicated in the model?
   i) Is the overall style of the permutation similar to that of the model?
   j) Does the permutation generate a new sound within the guidelines?
      Does it utilize new musical ideas not found in the musical model?

39. Use your evaluation (and your teacher’s response to your efforts here) to
    inform your next permutation assignment.
As you follow the printed instructions, listen carefully to the aural examples, and trial exercises and new musical inventions.

1. Listen to the entire piano work, *Quadrille*, by Joseph Haydn. In your folder in the computer, open the Haydn folder. Now, open the file labeled Quadrille and listen to the example.

**THE STUDENT HEARS**

Right Hand Only: Melodic Permutation in the Right Hand (R.H.)

2. Listen to the excerpt of the piano work, played hands together: In your folder in the computer, open the Haydn folder. Now, open the file labeled Example 1.

Example 1 (first eight measures).

**THE STUDENT HEARS**

3. Listen again a second time; focus on the melody in the right hand.

**THE STUDENT HEARS**

4. Listen to the R.H. melody played alone three times: In your folder in the computer, open the Haydn folder. Now, open the file labeled Example 2.

Example 2 (first eight measures).

**THE STUDENT HEARS**

5. With eyes closed, sing the melody in a comfortable vocal range on “*La*”; start on g, the fifth degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**

6. Sing the melody again using scale degree numbers; start on g, in the key of C Major, the fifth degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**

7. Listen to the melody of the piano work again; sing the letter names of pitches while listening.

**THE STUDENT HEARS**
8. Play the entire melody by ear on the piano in the key indicated, starting on g, the fifth degree of the C Major scale below middle C.


9. Listen to each of the melodic permutations for the right hand three times; they are each given aurally on the sound track. They include scale, five-finger, and other permutations typically found in Haydn’s piano music. In your folder in the computer, open the Haydn folder. Now, open the file labeled Example 3. Repeat this process for Examples 4 and 5.

Examples 3–5.

**THE STUDENT HEARS**

10. Listen to each permutation again and tap the rhythm of each as you listen. Tap the rhythm of each permutation again after you have finished listening: Examples 3–5.

**THE STUDENT HEARS AND TAPS, AND THEN TAPS AGAIN**

11. With eyes closed, listen to each melodic permutation again and then sing it on “la”; repeat for each of the melodic permutations: Examples 3–5.

**THE STUDENT HEARS AND SINGS**

12. Listen and sing each melodic permutation again, this time using scale degree numbers: For Examples 3–5, the scale degree numbers of the starting pitches are as follows:

   - Example 3: 5 (g above middle C)
   - Example 4: g (g above middle C)
   - Example 5: g (g above middle C)

**THE STUDENT HEARS AND THEN SINGS**

13. Listen and then sing each permutation again, using letter names of pitches. The letter names of starting pitches are as follows:

   - Example 3: (g above middle C)
   - Example 4: (g above middle C)
   - Example 5: (g above middle C)

**THE STUDENT HEARS AND THEN SINGS**
14. Listen again to each melodic permutation, singing on “la” as you listen: Example 3–5.

THE STUDENT SINGS WHILE LISTENING

15. Listen and then play each melodic permutation by ear in the given key of G Major with the given starting note, using R.H. For Examples 3–5 the letter names of starting pitches are as follows:
   Example 3: (g above middle C)
   Example 4: (g above middle C)
   Example 5: (g above middle C)

THE STUDENT HEARS THEN PLAYS

16. Play each melodic permutation by ear again along with the recording of the Left Hand (L.H.). The letter name of the starting pitch is:
   Example 3: (g above middle C)
   Example 4: (g above middle C)
   Example 5: (g above middle C)

THE STUDENT PLAYS WHILE LISTENING

17. Explore various melodic permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key

18. Mentally image (“think”) a melodic permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

19. Sing your mentally-imaged melodic permutation on “la”.

20. Sing your melodic permutation again, using letter names of pitches.

21. Play your melodic permutation on the piano with your R.H. Continue to play until you are quite certain of it – until it is “natural” for you.

22. Play your R.H. melodic permutation along with the L.H. part that is played by the computer. In your folder in the computer, open the Haydn folder. Now, open the file labeled Example 6.

Example 6.

THE STUDENT PLAYS WHILE LISTENING
Left Hand Only: Accompaniment Permutation in the Left Hand (L.H.)


THE STUDENT HEARS

24. Listen to the L.H. accompaniment again and sing it on “la” in a comfortable range; sing all the notes in the L.H. chords, beginning with the bottom note.

THE STUDENT HEARS

25. Sing the L.H. again using scale degree numbers; start on number 1, the first degree of the scale. Sing the L.H. again using letter names of pitches; start on C below middle C.

THE STUDENT SINGS

26. As you listen a third time, mentally image the melody. Notice the harmony of the L.H. accompaniment as it blends with the melody you are mentally imaging. Typical of the style, melody pitches usually sound best with those pitches within the chords of the accompaniment.

THE STUDENT HEARS


27. Listen to each of the L.H. permutations. In your folder in the computer, open the Haydn folder. Now, open the file labeled Example 7. Repeat this process for Examples 8 and 9.

Exercises 7–9.

THE STUDENT HEARS

28. Listen to each accompaniment permutation again and tap the rhythm of each with your L.H. as you listen. Tap the rhythm of each permutation after you have finished listening.

THE STUDENT HEARS AND TAPS
29. Listen again to the accompaniment permutation, sing it in a comfortable vocal range on "la". Sing all pitches of the blocked chords, ascending from the bottom pitch upwards. The letter names of the starting pitches are:
Example 7: G (G below middle C)
Example 8: C (C below middle C)
Example 9: C (C below middle C)

THE STUDENT SINGS WHILE LISTENING

30. Play each L.H. permutation by ear in the key of G. The letter names of the starting pitches are:
Example 7: G (G below middle C)
Example 8: C (C below middle C)
Example 9: C (C below middle C)

31. Explore various accompaniment permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key. Remember that the goal is to create a permutation “in the style of” the master composer’s work.

32. Mentally image (“think”) an accompaniment permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

33. Try playing your own left hand permutation accompaniment along with the computer playing the R.H. part. In your folder in the computer, open the Haydn folder. Now, open the file labeled Example 10.

Example 10.

THE STUDENT LISTENS AND PLAYS

Hands Together Instructional Strategies

34. Recall your invented melodic permutation, and connect it with your new accompaniment permutation. Play your permutation, hands together, three times. Listen carefully and evaluate how well the melodic permutation and the accompaniment permutation fit together.

35. Listen to the following acceptable permutation. In your folder in the computer, open the Haydn folder. Now, open the file labeled labeled Example 11.

Example 11.

THE STUDENT HEARS
The permutation is acceptable because it uses rhythmic, melodic and textural components similar to those used in the model (e.g., it uses the same chordal harmony as the model, it is in the same meter and key, it utilizes some of the rhythmic and melodic characteristics of the model, it uses a similar structural outline, the articulations and dynamics are within the range used in the model, the overall style is similar to that of the model, it generates a new sound within the guidelines, and utilizes new musical ideas not found in the musical model).

36. Listen to the following unacceptable permutation. In your folder in the computer, open the Haydn folder. Now, open the file labeled Example 12.

Example 12.

THE STUDENT HEARS

The permutation is unacceptable because it does not use rhythmic, melodic and textural components similar to those used in the model (e.g., it does not use the chordal harmony or textures of the model, it does not utilize enough of the rhythmic and melodic characteristics used in the model, it does not use articulations or dynamics used in the model, it generates a new sound, but not within the guidelines).

37. Now, recall and play your permutation hands together and record it in your file. Start by finding your folder (it will have your name on it) and proceed as follows:

a) Open the folder with your name by double-clicking it.
b) Look for file labeled Improvisation and double-click it.
c) Think about what you are going to play. When you are ready, look at the standard recording controls at the bottom of the computer display.
d) Click the recording control (circle) and start playing. (If, at any time you want to start over, click and hold on the Edit menu. Scroll down to Erase and release the button.
e) When you are finished, click the stop control (square).
f) For playback, click the single arrow to your right.
g) To save your work, click and hold on the File menu at the top of your display. Now, scroll down to Save and release the mouse button.
h) When you have saved your file, scroll down and release the button on Quit under the same menu. You are finished.
38. Listen to your permutation and evaluate it using the following questions:
   a) Does the permutation utilize similar textures and chordal harmony to those used in the model piece?
   b) Is the permutation in the meter of the original model?
   c) Is the permutation in the key of the original model?
   d) Does the permutation utilize rhythmic characteristics which are evident in the given piano piece?
   e) Does the permutation utilize melodic characteristics present in the model?
   f) Does the permutation utilize a similar structural outline to that of the model?
   g) Are the articulations used within the range used in the model?
   h) Are the dynamics used within the range indicated in the model?
   i) Is the overall style of the permutation similar to that of the model?
   j) Does the permutation generate a new sound within the guidelines? Does it utilize new musical ideas not found in the musical model?

39. Use your evaluation (and your teacher’s response to your efforts here) to inform your next permutation assignment.
Unit 9

As you follow the printed instructions, listen carefully to the aural examples, and trial exercises and new musical inventions.
1. Listen to the entire piano work, *Bourrée*, by Johann Sebastian Bach. In your folder in the computer, open the Bach 2 folder. Now, open the file labeled Bourrée and listen to the example.

**THE STUDENT HEARS**

Right Hand Only: Melodic Permutation in the Right Hand (R.H.)

2. Listen to the excerpt of the piano work, played hands together: In your folder in the computer, open the Bach 2 folder. Now, open the file labeled Example 1.

Example 1 (first eight measures).

**THE STUDENT HEARS**

3. Listen again a second time; focus on the melody in the right hand.

**THE STUDENT HEARS**

4. Listen to the R.H. melody played alone three times: In your folder in the computer, open the Bach 2 folder. Now, open the file labeled Example 2.

Example 2 (first eight measures).

**THE STUDENT HEARS**

5. With eyes closed, sing the melody in a comfortable vocal range on “la”; start on a, the fifth degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**

6. Sing the melody again using scale degree numbers; start on 5, in the key of d Minor, the fifth degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**

7. Listen to the melody of the piano work again; sing the letter names of pitches while listening.

**THE STUDENT HEARS**

8. Play the entire melody by ear on the piano in the key indicated, starting on a, the fifth degree of the d Minor scale, first a above middle C.

9. Listen to each of the melodic permutations for the right hand three times; they are each given aurally on the sound track. They include scale, five-finger, and other permutations typically found in Bach’s piano music: In your folder in the computer, open the Bach 2 folder. Now, open the file labeled Example 3. Repeat this process for Examples 4 and 5.

Examples 3–5.

THE STUDENT HEARS

10. Listen to each permutation again and tap the rhythm of each as you listen. Tap the rhythm of each permutation again after you have finished listening: Examples 3–5.

THE STUDENT HEARS AND TAPS, AND THEN TAPS AGAIN

11. With eyes closed, listen to each melodic permutation again and then sing it on “la”; repeat for each of the melodic permutations: Examples 3–5.

THE STUDENT HEARS AND SINGS

12. Listen and sing each melodic permutation again, this time using scale degree numbers: For Examples 3–5, the scale degree numbers of the starting pitches are as follows:
   Example 3: 5 (a fifth above middle C)
   Example 4: 5 (a fifth above middle C)
   Example 5: 5 (a fifth above middle C)

THE STUDENT HEARS AND THEN SINGS

13. Listen and then sing each permutation again, using letter names of pitches. The letter names of starting pitches are as follows:
   Example 3: (first a above middle C)
   Example 4: (first a above middle C)
   Example 5: (first a above middle C)

THE STUDENT SINGS WHILE LISTENING

14. Listen again to each melodic permutation, singing on “la” as you listen: Example 3–5.
15. Listen and then play each melodic permutation by ear in the given key of G Major with the given starting note, using R.H. For Examples 3–5 the letter names of starting pitches are as follows:
Example 3: (first a above middle C)
Example 4: (first a above middle C)
Example 5: (first a above middle C)

THE STUDENT HEARS THEN PLAYS
16. Play each melodic permutation by ear again along with the recording of the Left Hand (L.H.). The letter name of the starting pitch is:
Example 3: (first a above middle C)
Example 4: (first a above middle C)
Example 5: (first a above middle C)

THE STUDENT PLAYS WHILE LISTENING
17. Explore various melodic permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key.
18. Mentally image ("think") a melodic permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.
19. Sing your mentally-imaged melodic permutation on "la".
20. Sing your melodic permutation again, using letter names of pitches.
21. Play your melodic permutation on the piano with your R.H. Continue to play until you are quite certain of it – until it is "natural" for you.
22. Play your R.H. melodic permutation along with the L.H. part that is played by the computer. In your folder in the computer, open the Bach 2 folder. Now, open the file labeled labeled Example 6.

Example 6.

THE STUDENT PLAYS WHILE LISTENING
Left Hand Only: Accompaniment Permutation in the Left Hand (L.H.)


THE STUDENT HEARS
24. Listen to the L.H. accompaniment again and sing it on "la" in a comfortable range.

THE STUDENT HEARS
25. Sing the L.H. accompaniment again using scale degree numbers; start on number 1, the first degree of the scale. Use letter names of pitches; start on d above middle C.

THE STUDENT SINGS
26. As you listen a third time, mentally image the melody. Notice the harmony of the L.H. accompaniment as it blends with the melody you are mentally imaging. Typical of the style, melody pitches usually sound best with those pitches within the chords of the accompaniment.

THE STUDENT HEARS
27. Listen to each of the L.H. permutations. In your folder in the computer, open the Bach 2 folder. Now, open the file labeled Example 7. Repeat this process for Examples 8 and 9.

Exercises 7–9.

THE STUDENT HEARS
28. Listen to each accompaniment permutation again and tap the rhythm of each with your L.H. as you listen. Tap the rhythm of each permutation after you have finished listening.

THE STUDENT HEARS AND TAPS
29. Listen again to the accompaniment permutation, then sing in a comfortable vocal range on “la”. The letter names of the starting pitches are:
Example 7: f (first f above middle C)
Example 8: D (first D below middle C)
Example 9: A (first A below middle C)

THE STUDENT SINGS WHILE LISTENING
30. Play each L.H. permutation by ear in the key of G. The letter names of the starting pitches are:
Example 7: f (first f above middle C)
Example 8: D (first D below middle C)
Example 9: A (first A below middle C)

31. Explore various accompaniment permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key. Remember that the goal is to create a permutation “in the style of” the master composer’s work.
32. Mentally image ("think") an accompaniment permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

33. Try playing your own left hand accompaniment permutation along with the computer playing the R.H. part. In your folder in the computer, open the Bach 2 folder. Now, open the file labeled Example 10.

Example 10.

THE STUDENT Listens AND PLAYS
Hands Together Instructional Strategies

34. Recall your invented melodic permutation, and connect it with your new accompaniment permutation. Play your permutation, hands together, three times. Listen carefully and evaluate how well the melodic permutation and the accompaniment permutation fit together.

35. Listen to the following acceptable permutation. In your folder in the computer, open the Bach 2 folder. Now, open the file labeled Example 11.

Example 11.

THE STUDENT HEARS
The permutation is acceptable because it uses rhythmic, melodic and textural components similar to those used in the model (e.g., it uses the same chordal harmony as the model, it is in the same meter and key, it utilizes some of the rhythmic and melodic characteristics of the model, it uses a similar structural outline, the articulations and dynamics are within the range used in the model, the overall style is similar to that of the model, it generates a new sound within the guidelines, and utilizes new musical ideas not found in the musical model).

36. Listen to the following unacceptable permutation. In your folder in the computer, open the Bach 2 folder. Now, open the file labeled Example 12.

Example 12.

THE STUDENT HEARS
The permutation is unacceptable because it does not use rhythmic, melodic and textural components similar to those used in the model (e.g., it does not use the chordal harmony or textures of the model, it does not utilize enough of the rhythmic and melodic characteristics used in the model, it does not use articulations or dynamics used in the model, it generates a new sound, but not within the guidelines).
37. Now, recall and play your permutation hands together and record it in your file. Start by finding your folder (it will have your name on it) and proceed as follows:
   a) Open the folder with your name by double-clicking it.
   b) Look for file labeled Improvisation and double-click it.
   c) Think about what you are going to play. When you are ready, look at the standard recording controls at the bottom of the computer display.
   d) Click the recording control (circle) and start playing. (If, at any time you want to start over, click and hold on the Edit menu. Scroll down to Erase and release the button.
   e) When you are finished, click the stop control (square).
   f) For playback, click the single arrow to your right.
   g) To save your work, click and hold on the File menu at the top of your display. Now, scroll down to Save and release the mouse button.
   h) When you have saved your file, scroll down and release the button on Quit under the same menu. You are finished.

38. Listen to your permutation and evaluate it using the following questions:
   a) Does the permutation utilize similar textures and chordal harmony to those used in the model piece?
   b) Is the permutation in the meter of the original model?
   c) Is the permutation in the key of the original model?
   d) Does the permutation utilize rhythmic characteristics which are evident in the given piano piece?
   e) Does the permutation utilize melodic characteristics present in the model?
   f) Does the permutation utilize a similar structural outline to that of the model?
   g) Are the articulations used within the range used in the model?
   h) Are the dynamics used within the range indicated in the model?
   i) Is the overall style of the permutation similar to that of the model?
   j) Does the permutation generate a new sound within the guidelines? Does it utilize new musical ideas not found in the musical model?

39. Use your evaluation (and your teacher’s response to your efforts here) to inform your next permutation assignment.
Unit 10

As you follow the printed instructions, listen carefully to the aural examples, and trial exercises and new musical inventions.

1. Listen to the entire piano work, *German Dance*, by Ludwig van Beethoven. In your folder in the computer, open the Beethoven 2 folder. Now, open the file labeled German Dance and listen to the example.

**THE STUDENT HEARS**

**Right Hand Only: Melodic Permutation in the Right Hand (R.H.)**

2. Listen to the excerpt of the piano work, played hands together: In your folder in the computer, open the Beethoven 2 folder. Now, open the file labeled Example 1.

Example 1 (first eight measures).

**THE STUDENT HEARS**

3. Listen again a second time; focus on the melody in the right hand.

**THE STUDENT HEARS**

4. Listen to the R.H. melody played alone three times: In your folder in the computer, open the Beethoven 2 folder. Now, open the file labeled Example 2.

Example 2 (first eight measures).

**THE STUDENT HEARS**

5. With eyes closed, sing the melody in a comfortable vocal range on “la”; start on e¹, the fifth degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**

6. Sing the melody again using scale degree numbers; start on 5, in the key of A Major, the fifth degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**

7. Listen to the melody of the piano work again; sing the letter name of pitches while listening.

**THE STUDENT HEARS**
8. Play the entire melody by ear on the piano in the key indicated, starting on e, the fifth degree of the A Major scale, the first e above middle C.

9. Listen to each of the melodic permutations for the right hand three times; they are each given aurally on the sound track. They include scale, five-finger, and other permutations typically found in Beethoven's piano music: In your folder in the computer, open the Beethoven 2 folder. Now, open the file labeled Example 3. Repeat this process for Examples 4 and 5.

Examples 3–5.

**THE STUDENT HEARS**

10. Listen to each permutation again and tap the rhythm of each as you listen. Tap the rhythm of each permutation again after you have finished listening: Examples 3–5.

**THE STUDENT HEARS AND TAPS, AND THEN TAPS AGAIN**

11. With eyes closed, listen to each melodic permutation again and then sing it on "la"; repeat for each of the melodic permutations: Examples 3–5.

**THE STUDENT HEARS AND SINGS**

12. Listen and sing each melodic permutation again, this time using scale degree numbers: For Examples 3–5, the scale degree numbers of the starting pitches are as follows:
   Example 3: 5 (above middle C)
   Example 4: e (a fifth above middle C)
   Example 5: e (a fifth above middle C)

**THE STUDENT HEARS AND THEN SINGS**

13. Listen and then sing each permutation again, using letter names of pitches. The letter names of starting pitches are as follows:
   Example 3: (first e above middle C)
   Example 4: (first e above middle C)
   Example 5: (first e above middle C)

**THE STUDENT HEARS AND THEN SINGS**
14. Listen again to each melodic permutation, singing on “la” as you listen:
Example 3-5.

**THE STUDENT SINGS WHILE LISTENING**
15. Listen and then play each melodic permutation by ear in the given key of A
Major with the given starting note, using R.H. For Examples 3-5 the letter names
of starting pitches are as follows:
Example 3: (first e above middle C)
Example 4: (first e above middle C)
Example 5: (first e above middle C)

**THE STUDENT HEARS THEN PLAYS**
16. Play each melodic permutation by ear again along with the recording of the
Left Hand (L.H.). The letter name of the starting pitch is:
Example 3: (first e above middle C)
Example 4: (first e above middle C)
Example 5: (first e above middle C)

**THE STUDENT PLAYS WHILE LISTENING**
17. Explore various melodic permutation ideas, eight measures in length, on the
piano until you are satisfied with the results. Stay within the given meter and key.
18. Mentally image (“think”) a melodic permutation of your own, one that is eight
measures in length, in the same meter and key as the musical model.
19. Sing your mentally–imaged melodic permutation on “la”.
20. Sing your melodic permutation again, using letter names of pitches.
21. Play your melodic permutation on the piano with your R.H. Continue to play
until you are quite certain of it – until it is “natural” for you.
22. Play your R.H. melodic permutation along with the L.H. part that is played by
the computer. In your folder in the computer, open the Beethoven 2 folder. Now,
open the file labeled Example 6.

Example 6.

**THE STUDENT PLAYS WHILE LISTENING**
Left Hand Only: Accompaniment Permutation in the Left Hand (L.H.)


**THE STUDENT HEARS**
24. Listen to the L.H. accompaniment again and sing it on “la” in a comfortable range; sing all the notes in the L.H. chords, beginning with the bottom notes.

THE STUDENT HEARS
25. Sing the L.H. accompaniment again using scale degree numbers; start on number 1, the first degree of the scale. Sing the bottom notes of the broken chords again using letter names of pitches; start on A below middle C.

THE STUDENT SINGS
26. As you listen a third time, mentally image the melody. Notice the harmony of the L.H. accompaniment as it blends with the melody you are mentally imaging. Typical of the style, melody pitches usually sound best with those pitches within the chords of the accompaniment.

THE STUDENT HEARS
27. Listen to each of the L.H. permutations. In your folder in the computer, open the Beethoven 2 folder. Now, open the file labeled Example 7. Repeat this process for Examples 8 and 9.

Exercises 7–9.

THE STUDENT HEARS
28. Listen to each accompaniment permutation again and tap the rhythm of each with your L.H. as you listen. Tap the rhythm of each permutation after you have finished listening.

THE STUDENT HEARS AND TAPS
29. Listen again to the accompaniment permutation, then sing it in a comfortable vocal range on “la”. Sing all pitches of the blocked chords, ascending from the bottom pitch upwards. The letter names of the starting pitches are:
Example 7: A (A below middle C)
Example 8: e (e above middle C)
Example 9: A (A below middle C)

THE STUDENT SINGS WHILE LISTENING
30. Play each L.H. permutation by ear in the key of A. The letter names of the starting pitches are:
Example 7: A (A below middle C)
Example 8: e (e above middle C)
Example 9: A (A below middle C)

31. Explore various accompaniment permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key. Remember that the goal is to create a permutation "in the style of" the master composer's work.

32. Mentally image ("think") an accompaniment permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

33. Try playing your own left hand permutation accompaniment along with the computer playing the R.H. part. In your folder in the computer, open the Beethoven 2 folder. Now, open the file labeled Example 10.

Example 10.

**THE STUDENT LISTENS AND PLAYS**

**Hands Together Instructional Strategies**

34. Recall your invented melodic permutation, and connect it with your new accompaniment permutation. Play your permutation hands together three times. Listen carefully and evaluate how well the melodic permutation and the accompaniment permutation fit together.

35. Listen to the following acceptable permutation. In your folder in the computer, open the Beethoven 2 folder. Now, open the file labeled labeled Example 11.

Example 11.

**THE STUDENT HEARS**
The permutation is acceptable because it uses rhythmic, melodic and textural components similar to those used in the model (e.g., it uses the same chordal harmony as the model, it is in the same meter and key, it utilizes some of the rhythmic and melodic characteristics of the model, it uses a similar structural outline, the articulations and dynamics are within the range used in the model, the overall style is similar to that of the model, it generates a new sound within the guidelines, and utilizes new musical ideas not found in the musical model).
36. Listen to the following unacceptable permutation. In your folder in the computer, open the Beethoven 2 folder. Now, open the file labeled Example 12.

Example 12.

THE STUDENT HEARS
The permutation is unacceptable because it does not use rhythmic, melodic and textural components similar to those used in the model (e.g., it does not use the chordal harmony or textures of the model, it does not utilize enough of the rhythmic and melodic characteristics used in the model, it does not use articulations or dynamics used in the model, it generates a new sound, but not within the guidelines).

37. Now, recall and play your permutation hands together and record it in your file. Start by finding your folder (it will have your name on it) and proceed as follows:

(a) Open the folder with your name by double-clicking it.
(b) Look for file labeled Improvisation and double-click it.
(c) Think about what you are going to play. When you are ready, look at the standard recording controls at the bottom of the computer display.
(d) Click the recording control (circle) and start playing. (If, at any time you want to start over, click and hold on the Edit menu. Scroll down to Erase and release the button.
(e) When you are finished, click the stop control (square).
(f) For playback, click the single arrow to your right.
(g) To save your work, click and hold on the File menu at the top of your display. Now, scroll down to Save and release the mouse button.
(h) When you have saved your file, scroll down and release the button on Quit under the same menu. You are finished.

38. Listen to your permutation and evaluate it using the following questions:

(a) Does the permutation utilize similar textures and chordal harmony to those used in the model piece?
(b) Is the permutation in the meter of the original model?
(c) Is the permutation in the key of the original model?
(d) Does the permutation utilize rhythmic characteristics which are evident in the given piano piece?
(e) Does the permutation utilize melodic characteristics present in the model?
f) Does the permutation utilize a similar structural outline to that of the model?
g) Are the articulations used within the range used in the model?
h) Are the dynamics used within the range indicated in the model?
i) Is the overall style of the permutation similar to that of the model?
j) Does the permutation generate a new sound within the guidelines? Does it utilize new musical ideas not found in the musical model?

39. Use your evaluation (and your teacher's response to your efforts here) to inform your next permutation assignment.
Unit 11

As you follow the printed instructions, listen carefully to the aural examples, and trial exercises and new musical inventions.
1. Listen to the entire piano work, Mazurka in F Major, by Frédéric Chopin. In your folder in the computer, open the Chopin folder. Now, open the file labeled Mazurka and listen to the example.

THE STUDENT HEARS
Right Hand Only: Melodic Permutation in the Right Hand (R.H.)

2. Listen to the excerpt of the piano work, played hands together: In your folder in the computer, open the Chopin folder. Now, open the file labeled Example 1.

Example 1 (first eight measures).

THE STUDENT HEARS
3. Listen again a second time; focus on the melody in the right hand.

THE STUDENT HEARS
4. Listen to the R.H. melody played alone three times: In your folder in the computer, open the Chopin folder. Now, open the file labeled Example 2.

Example 2 (first eight measures).

THE STUDENT HEARS
5. With eyes closed, sing the melody (top note in the chord) in a comfortable vocal range on “la”; start on C, the fifth degree of the scale, and slowly continue through the melody.

THE STUDENT SINGS
6. Sing the melody (top note in the chord) again using scale degree numbers; start on C, in the key of F Major, the fifth degree of the scale, and slowly continue through the melody.

THE STUDENT SINGS
7. Listen to the melody of the piano work again; sing the letter names of pitches while listening.

THE STUDENT HEARS
8. Play the entire melody (top note in the chords) by ear on the piano in the key indicated, starting on C, the fifth degree of the F Major scale, C above middle C.


9. Listen to each of the melodic permutations for the right hand three times; they are each given aurally on the sound track. They include scale, five–finger, and other permutations typically found in Chopin’s piano music: In your folder in the computer, open the Chopin folder. Now, open the file labeled Example 3. Repeat this process for Examples 4 and 5.

Examples 3–5.

**THE STUDENT HEARS**

10. Listen to each permutation again and tap the rhythm of each as you listen. Tap the rhythm of each permutation again after you have finished listening: Examples 3–5.

**THE STUDENT HEARS AND TAPS, AND THEN TAPS AGAIN**

11. With eyes closed, listen to each melodic permutation again and then sing it on “la”; repeat for each of the melodic permutations (top note in the chords): Examples 3–5.

**THE STUDENT HEARS AND SINGS**

12. Listen and sing each melodic permutation again, this time using scale degree numbers: For Examples 3–5, the scale degree numbers of the starting pitches are as follows:

   Example 3: 1  (fourth above middle C)
   Example 4: 3  (third above middle C)
   Example 5: 5  (octave above middle C)

**THE STUDENT HEARS AND THEN SINGS**

13. Listen and then sing each permutation again (top note in the chords), using letter names of pitches.

   The letter names of starting pitches are as follows:
   Example 3:  f  (above middle C)
   Example 4:  a  (above middle C)
   Example 5:  c  (above middle C)
14. Listen again to each melodic permutation (top note in the chords), singing on
“la” as you listen: Example 3–5.

THE STUDENT SINGS WHILE LISTENING
15. Listen and then play each melodic permutation by ear in the given key of F
Major with the given starting note, using R.H. For Examples 3–5 the letter names
of starting pitches are as follows:
Example 3: (f above middle C)
Example 4: (a above middle C)
Example 5: (c above middle C)

THE STUDENT HEARS THEN PLAYS
16. Play each melodic permutation by ear again along with the recording of the
Left Hand (L.H.). The letter name of the starting pitch is:
Example 3: (f above middle C)
Example 4: (a above middle C)
Example 5: (c above middle C)

THE STUDENT PLAYS WHILE LISTENING
17. Explore various melodic permutation ideas, eight measures in length, on the
piano until you are satisfied with the results. Stay within the given meter and key.
18. Mentally image (“think”) a melodic permutation of your own, one that is eight
measures in length, in the same meter and key as the musical model.
19. Sing your mentally--imaged melodic permutation on “la”.
20. Sing your melodic permutation again, using letter names of pitches.
21. Play your melodic permutation on the piano with your R.H. Continue to play
until you are quite certain of it – until it is “natural” for you.
22. Play your R.H. melodic permutation along with the L.H. part that is played by
the computer. In your folder in the computer, open the Chopin folder. Now, open
the file labeled Example 6.

Example 6.

THE STUDENT PLAYS WHILE LISTENING
Left Hand Only: Accompaniment Permutation in the Left Hand (L.H.)


THE STUDENT HEARS
24. Listen to the L.H. accompaniment again and sing it on “la” in a comfortable range; sing all the notes in the L.H. chords beginning with the bottom note.

THE STUDENT HEARS

25. Sing the L.H. accompaniment again using scale degree numbers; start on number 1, the first degree of the scale. Sing the L.H. accompaniment again using letter names of pitches; start on F below middle C.

THE STUDENT SINGS

26. As you listen a third time, mentally image the melody. Notice the harmony of the L.H. accompaniment as it blends with the melody you are mentally imaging. Typical of the style, melody pitches usually sound best with those pitches within the chords of the accompaniment.

THE STUDENT HEARS


27. Listen to each of the L.H. permutations. In your folder in the computer, open the Chopin folder. Now, open the file labeled Example 7. Repeat this process for Examples 8 and 9.

Exercises 7–9.

THE STUDENT HEARS

28. Listen to each accompaniment permutation again and tap the rhythm of each with your L.H. as you listen. Tap the rhythm of each exercise after you have finished listening.

THE STUDENT HEARS AND TAPS

29. Listen again to the accompaniment permutation, then sing it in a comfortable vocal range on “la”; sing all pitches of the chords, ascending from the bottom pitch upwards. The letter names of the starting pitches are:

Example 7: F (F below middle C)
Example 8: F (F below middle C)
Example 9: F (F below middle C)

THE STUDENT SINGS WHILE LISTENING
30. Play each L.H. exercise by ear in the key of F Major. The letter names of the starting pitches are:
Example 7: F (F below middle C)
Example 8: F (F below middle C)
Example 9: F (F below middle C)

31. Explore various accompaniment permutation ideas, eight measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key. Remember that the goal is to create a permutation “in the style of” the master composer’s work.

32. Mentally image (“think”) an accompaniment permutation of your own, one that is eight measures in length, in the same meter and key as the musical model.

33. Try playing your own left hand accompaniment permutation along with the computer playing the R.H. part. In your folder in the computer, open the Chopin folder. Now, open the file labeled Example 10.

Example 10.

THE STUDENT LISTENS AND PLAYS
Hands Together Instructional Strategies

34. Recall your invented melodic permutation, and connect it with your new accompaniment permutation. Play your permutation, hands together, three times. Listen carefully and evaluate how well the melodic permutation and the accompaniment permutation fit together.

35. Listen to the following acceptable permutation. In your folder in the computer, open the Chopin folder. Now, open the file labeled Example 11.

Example 11.

THE STUDENT HEARS
The permutation is acceptable because it uses rhythmic, melodic and textural components similar to those used in the model (e.g., it uses the same chordal harmony as the model, it is in the same meter and key, it utilizes many of the rhythmic and melodic characteristics of the model, it uses a similar structural outline, the articulations and dynamics are within the range used in the model, the overall style is similar to that of the model, it generates a new sound within the guidelines, and utilizes new musical ideas not found in the musical model).
36. Listen to the following unacceptable permutation. In your folder in the computer, open the Chopin folder. Now, open the file labeled Example 12.

Example 12.

THE STUDENT HEARS

The permutation is unacceptable because it does not use rhythmic, melodic and textural components similar to those used in the model (e.g., it does not use the chordal harmony or textures of the model, it does not utilize enough of the rhythmic and melodic characteristics used in the model, it does not use articulations or dynamics used in the model, it generates a new sound, but not within the guidelines).

37. Now, recall and play your permutation hands together and record it in your file. Start by finding your folder (it will have your name on it) and proceed as follows:
   a) Open the folder with your name by double-clicking it.
   b) Look for file labeled Improvisation and double-click it.
   c) Think about what you are going to play. When you are ready, look at the standard recording controls at the bottom of the computer display.
   d) Click the recording control (circle) and start playing. (If, at any time you want to start over, click and hold on the Edit menu. Scroll down to Erase and release the button.
   e) When you are finished, click the stop control (square).
   f) For playback, click the single arrow to your right.
   g) To save your work, click and hold on the File menu at the top of your display. Now, scroll down to Save and release the mouse button.
   h) When you have saved your file, scroll down and release the button on Quit under the same menu. You are finished.

38. Listen to your permutation and evaluate it using the following questions:
   a) Does the permutation utilize similar textures and chordal harmony to those used in the model piece?
   b) Is the permutation in the meter of the original model?
   c) Is the permutation in the key of the original model?
   d) Does the permutation utilize rhythmic characteristics which are evident in the given piano piece?
   e) Does the permutation utilize melodic characteristics present in the model?
f) Does the permutation utilize a similar structural outline to that of the model?
g) Are the articulations used within the range used in the model?
h) Are the dynamics used within the range indicated in the model?
i) Is the overall style of the permutation similar to that of the model?
j) Does the permutation generate a new sound within the guidelines?
   Does it utilize new musical ideas not found in the musical model?

39. Use your evaluation (and your teacher’s response to your efforts here) to inform your next permutation assignment.
Unit 12

As you follow the printed instructions, listen carefully to the aural examples, and trial exercises and new musical inventions.

1. Listen to the entire piano work, *Toccata*, by Dmitri Kabalevsky. In your folder in the computer, open the Kabalevsky folder. Now, open the file labeled Toccatina and listen to the example.

**THE STUDENT HEARS**

**Right Hand Only: Melodic Permutation in the Left Hand (L.H.)**

2. Listen to the excerpt of the piano work, played hands together: In your folder in the computer, open the Kabalevsky folder. Now, open the file labeled Example 1.

Example 1 (first twelve measures).

**THE STUDENT HEARS**

3. Listen again a second time; focus on the melody in the left hand.

**THE STUDENT HEARS**

4. Listen to the L.H. melody played alone three times: In your folder in the computer, open the Kabalevsky folder. Now, open the file labeled Example 2.

Example 2 (first twelve measures).

**THE STUDENT HEARS**

5. With eyes closed, sing the melody in a comfortable vocal range on “la”; start on E, the fifth degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**

6. Sing the melody again using scale degree numbers; start on E, in the key of a minor, the fifth degree of the scale, and slowly continue through the melody.

**THE STUDENT SINGS**

7. Listen to the melody of the piano work again; sing the letter names of pitches while listening.

**THE STUDENT HEARS**
8. Play the entire melody by ear on the piano in the key indicated, starting on E, the fifth degree of the A minor scale, a sixth below middle C. L.H. Permutation Exercises: Example 3–5.

9. Listen to each of the melodic permutations for the left hand three times; they are each given aurally on the sound track. They include scale, five-finger, and other permutations typically found in Kabalevsky's piano music. In your folder in the computer, open the Kabalevsky folder. Now, open the file labeled Example 3. Repeat this process for Examples 4 and 5.

Examples 3–5.

THE STUDENT HEARS

10. Listen to each permutation again and tap the rhythm of each as you listen. Tap the rhythm of each permutation again after you have finished listening: Examples 3–5.

THE STUDENT HEARS AND TAPS, AND THEN TAPS AGAIN

11. With eyes closed, listen to each melodic permutation again and then sing it on “la”; repeat for each of the melodic permutations: Examples 3–5.

THE STUDENT HEARS AND SINGS

12. Listen and sing each melodic permutation again, this time using scale degree numbers: For Examples 3–5, the scale degree numbers of the starting pitches are as follows:
   Example 3: 5 (sixth below middle C)
   Example 4: 5 (sixth below middle C)
   Example 5: 5 (sixth below middle C)

THE STUDENT HEARS AND THEN SINGS

13. Listen and then sing each permutation again, using letter names of pitches. The letter names of starting pitches are as follows:
   Example 3:  (e below middle C)
   Example 4:  (e below middle C)
   Example 5:  (e below middle C)

THE STUDENT HEARS AND THEN SINGS
14. Listen again to each melodic permutation, singing on "la" as you listen:
   Example 3–5.

THE STUDENT SINGS WHILE LISTENING
15. Listen and then play each melodic permutation by ear in the given key of a
   Minor with the given starting note, using L.H. For Examples 3–5 the letter names
   of starting pitches are as follows:
   Example 3:  (e below middle C)
   Example 4:  (e below middle C)
   Example 5:  (e below middle C)

THE STUDENT HEARS THEN PLAYS
16. Play each melodic permutation by ear again along with the recording of the
   Right Hand (R.H.). The letter name of the starting pitch is:
   Example 3:  (e below middle C)
   Example 4:  (e below middle C)
   Example 5:  (e below middle C)

THE STUDENT PLAYS WHILE LISTENING
17. Explore various melodic permutation ideas, twelve measures in length, on the
   piano until you are satisfied with the results. Stay within the given meter and key.

18. Mentally image ("think") a melodic permutation of your own, one that is
   twelve measures in length, in the same meter and key as the musical model.

19. Sing your mentally-imaged melodic permutation on "la".

20. Sing your melodic permutation again, using letter names of pitches.

21. Play your melodic permutation on the piano with your L.H. Continue to play
   until you are quite certain of it – until it is "natural" for you.

22. Play your L.H. melodic permutation along with the R.H. part that is played by
   the computer. In your folder in the computer, open the Kabalevsky folder. Now,
   open the file labeled Example 6.

Example 6.

THE STUDENT PLAYS WHILE LISTENING
Left Hand Only: Accompaniment Permutation in the Right Hand (R.H.)


THE STUDENT HEARS
24. Listen to the R.H. accompaniment again and sing it on “la” in a comfortable range; sing all the notes in the R.H. chords beginning with the bottom note.

**THE STUDENT HEARS**

25. Sing the R.H. accompaniment again using scale degree numbers; start on number 3, the third degree of the scale. Sing the R.H. accompaniment again using the letter names of pitches; start on middle C; sing all the notes in the R.H. chords beginning with the bottom note.

**THE STUDENT SINGS**

26. As you listen a third time, mentally image the melody. Notice the harmony of the R.H. accompaniment as it blends with the melody you are mentally imaging. Typical of the style, melody pitches usually sound best with those pitches within the chords of the accompaniment.

**THE STUDENT HEARS**


27. Listen to each of the R.H. permutations. In your folder in the computer, open the Kabalevsky folder. Now, open the file labeled Example 7. Repeat this process for Examples 8 and 9.

Exercises 7–9.

**THE STUDENT HEARS**

28. Listen to each accompaniment permutation again and tap the rhythm of each with your l.i.H. as you listen. Tap the rhythm of each permutation after you have finished listening.

**THE STUDENT HEARS AND TAPS**

29. Listen again to the accompaniment permutation, then sing it in a comfortable vocal range on “la”; sing top notes of chords only. The letter names of the starting pitches are:

Example 7: E above middle C
Example 8: A above middle C
Example 9: A above middle C

**THE STUDENT SINGS WHILE LISTENING**
30. Play each L.H. permutation by ear in the key of F Major. The letter names of the starting pitches are:
Example 7: E above middle C
Example 8: A above middle C
Example 9: A above middle C
31. Explore various accompaniment permutation ideas, twelve measures in length, on the piano until you are satisfied with the results. Stay within the given meter and key. Remember that the goal is to create a permutation “in the style of” the master composer’s work.
32. Mentally image (“think”) an accompaniment permutation of your own, one that is twelve measures in length, in the same meter and key as the musical model.
33. Try playing your own R.H. accompaniment permutation along with the computer playing the L.H. part. In your folder in the computer, open the Kabalevsky folder. Now, open the file labeled Example 10.

Example 10.

THE STUDENT LISTENS AND PLAYS

Hands Together Instructional Strategies
34. Recall your invented melodic permutation, and connect it with your new accompaniment permutation. Play your permutation, hands together, three times. Listen carefully and evaluate how well the melodic permutation and the accompaniment permutation fit together.
35. Listen to the following acceptable permutation. In your folder in the computer, open the Kabalevsky folder. Now, open the file labeled Example 11.

Example 11.

THE STUDENT HEARS
The permutation is acceptable because it uses rhythmic, melodic and textural components similar to those used in the model (e.g., it uses the same chordal harmony as the model, it is in the same meter and key, it utilizes many of the rhythmic and melodic characteristics of the model, it uses a similar structural outline, the articulations and dynamics are within the range used in the model, the overall style is similar to that of the model, it generates a new sound within the guidelines, and utilizes new musical ideas not found in the musical model).
36. Listen to the following unacceptable permutation. In your folder in the computer, open the Kabalevsky folder. Now, open the file labeled Example 12.

Example 12.

THE STUDENT HEARS
The permutation is unacceptable because it does not use rhythmic, melodic and textural components similar to those used in the model (e.g., it does not use the chordal harmony or textures of the model, it does not utilize a L.H. melody as does the model. Although it uses 2/4 meter, it does not use the rhythmic characteristics used in the model, it does not use articulations or dynamics used in the model, it generates a new sound, but not within the guidelines).

37. Now, recall and play your permutation hands together and record it in your file. Start by finding your folder (it will have your name on it) and proceed as follows:
   a) Open the folder with your name by double-clicking it.
   b) Look for file labeled Improvisation and double-click it.
   c) Think about what you are going to play. When you are ready, look at the standard recording controls at the bottom of the computer display.
   d) Click the recording control (circle) and start playing. (If, at any time you want to start over, click and hold on the Edit menu. Scroll down to Erase and release the button.
   e) When you are finished, click the stop control (square).
   f) For playback, click the single arrow to your right.
   g) To save your work, click and hold on the File menu at the top of your display. Now, scroll down to Save and release the mouse button.
   h) When you have saved your file, scroll down and release the button on Quit under the same menu. You are finished.

38. Listen to your permutation and evaluate it using the following questions:
   a) Does the permutation utilize similar textures and chordal harmony to those used in the model piece?
   b) Is the permutation in the meter of the original model?
   c) Is the permutation in the key of the original model?
   d) Does the permutation utilize rhythmic characteristics which are evident in the given piano piece?
   e) Does the permutation utilize melodic characteristics present in the model?
f) Does the permutation utilize a similar structural outline to that of the model?
g) Are the articulations used within the range used in the model?
h) Are the dynamics used within the range indicated in the model?
i) Is the overall style of the permutation similar to that of the model?
j) Does the permutation generate a new sound within the guidelines?
   Does it utilize new musical ideas not found in the musical model?

39. Use your evaluation (and your teacher's response to your efforts here) to inform your next permutation assignment.
VITA

MYRNA CAPP

ADVANCED DEGREES

Doctor of Musical Arts in Music Education.
University of Washington, School of Music, 1995.

Master of Arts in Teaching.
University of Washington, School of Music, 1977.

Bachelor of Arts in Music Education (cum laude).
Seattle Pacific University, 1959.

PERFORMANCES

Faculty Recitals, Seattle Pacific University

(1995) Flute and Piano, (Muczynski); Rae Terpenning; Music Faculty Recital; (and Seattle Flute Society Founder's Recital)

(1992) Voice and Piano, (Bach, Mozart, Rossini, Benedict, Wood, Head, Gershwin); Ruthanna Metzgar, soprano

(1992) Piano solo, (Suite de Danzas Criollas, Ginastera; Keyboard Faculty Recital)

(1991) Trombone and Piano, (Ross, Shostakovitch, Beethoven, Jorgensen, Pryor); Stephen Fissel, trombone

(1986) Piano, cello, trombone, clarinet, flute, (Brahms - Four Serious Songs, trombone and piano; Brahms Trio in A Minor, Op. 114, cello, clarinet, piano; Messiaen, flute and piano); Ray Davis, cello; Stephen Fissel, trombone; Eric Hanson, clarinet; Rae Terpenning, flute

(1985) Flute and Piano (Prokofieff Sonata for Flute and Piano, Op. 94); Rae Terpenning, flute

(1985) Trumpet and Piano (Stevens, Handel, Suderburg, Bennett); Lauren Anderson, trumpet